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1 Introduction
1.1 The StreamWare Basic Software

StreamWare Basic is an application software designed for use primarily with the Dantec
Dynamics MiniCTA Boxes and MultiChannel CTA Frames (Anemometers). It can also be used
together with any other non-computer-controlled Anemometer.

With StreamWare Basic System you can perform measurements of instantaneous fluid velo-
city and its statistic derivatives: Mean Velocity, Turbulence Intensity, Higher order Moments
and Spectra etc., in one or more points in space.

It supports probe calibration with curve fitting and provides a Setup platform, where you can
define probe setup and execute automatic measurement sequences with probe traversing,
data acquisition and data reduction. A built-in Project Manager gives full documentation of all
measurement procedures and results.

The StreamWare Basic System can be used with hot-wire and hot-film probes, Dantec Dynam-
ics standard- as well as custom designed probes. It accepts any combination of 1-, 2- and 3-D
probes. The software can also be used in combination with other transducers or instruments
for parameters other than fluid velocity, e.g. temperature or pressure.

1.1.1 Documentation

l StreamWare Basic Installation and Users Guide - This manual.

l How to Measure Turbulence with Hot-Wire Anemometers - A Practical Guide - 9040U6154
This guide describes the fundamental of measuring turbulence with the hot-wire tech-
nique. Including measurement equipment, planning of the experiment, setup and
configuration, calibration and data acquisition and conversion using the software.

l OEM Documentation - A number of OEM supplied manuals and guides are delivered
together with the devices delivered for your system. This includes A/D devices, etc.

l MiniCTA 54T30 Installation and User's Guide This is the hardware installation and users
guide of the 54T30 MiniCTA Box.

l MiniCTA 54T42 Installation and User's Guide This is the hardware installation and users
guide of the 54T42 MiniCTA Box.

l MiniCTA 54T30 Overheat Calculation Spreadsheet for calculating the overheat and dip
switch settings of the 54T30 MiniCTA Box.

l MiniCTA 54T42 Overheat Calculation Spreadsheet for calculating the overheat and dip
switch settings of the 54T42 MiniCTA Box.

l MultiChannel CTA 54N80/81/82 Installation & User's Guide Manual for the MultiChannel
CTA Frame using 54T42.

l User's Guide for 54T29 Reference Velocity Probe Manual for the 54T29 Reference Probe.

Contents of this Manual

This manual consists of sections presenting the system and software and how to use it.

l "Hardware Installation" (on page 13)
Describes how to install the CTA hardware in connection with the StreamWare Basic



software.

l "Software Installation" (on page 35)
Describes what you need to run the StreamWare Basic software, and how it is
unpacked and installed.

l "Operating the System" (on page 63)
A Step-by-step description of three Sample Projects.

l "StreamWare Basic Guide" (on page 85)
User's Guide that gives you an overview of the software and describes how to use it
and interpret the results.

l "Software Reference" (on page 185)
A Software Reference with definitions of terms, formulas and messages.

On-line Help

The On-line Help is a context sensitive Help system built into in StreamWare Basic. It provides
you with a quick reference for procedures, keystroke sequences and commands that you will
need in order to run the StreamWare Basic System. The Help can be used within the Applic-
ation Software.

1.1.2 Assumptions
It is assumed that you have a basic knowledge about measurement techniques in Fluid Mech-
anics and that you are familiar with the concept of Constant Temperature Anemometry.

It is also assumed that you are familiar with Windows Terminology.

1.2 Software License Agreement
This software end user license agreement ("License Agreement") is concluded between you
(either an individual or a corporate entity) and Dantec Dynamics A/S ("Dantec Dynamics").
Please read all terms and conditions of this License Agreement before installing the Software.
When you install the Software, you agree to be bound by the terms of this License Agree-
ment. If you cannot agree to the terms of this License Agreement you may not install or use
the software in any manner.

Grant of License

This License Agreement together with the Software package including eventual media, user's
guide and documentation and the invoice constitutes your proof of license and the right to
exercise the rights herein and must be retained by you.

One license permits you to use one installation at a time of the Dantec Dynamics software
product supplied to you (the "Software") including documentation in written or electronic
form and solely for your own internal business purposes.

You may not rent, lease, sublicense or otherwise distribute, assign, transfer or make the Soft-
ware available to any third party without the express consent of Dantec Dynamics except to
the extent specifically permitted by mandatory applicable law.

Updates

Updates, new releases, bug fixes, etc. of the Software which are supplied to you (if any), may
be used only in conjunction with versions of the Software legally acquired and licensed by you
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that you have already installed, unless such update etc. replaces that former version in its
entirety and such former version is destroyed.

Copyright

The Software (including text, illustrations and images incorporated into the Software) and all
proprietary rights therein are owned by Dantec Dynamics or Dantec Dynamics' suppliers, and
are protected by the Danish Copyright Act and applicable international law. You may not
reverse assemble, decompile, or otherwise modify the Software except to the extent spe-
cifically permitted by mandatory applicable law. You are not entitled to copy the Software or
any part thereof except as otherwise expressly set out above. However you may make a copy
of the Software solely for backup or archival purposes. You may not copy the user's guide
accompanying the Software, nor distribute copies of any user documentation provided in “on-
line” or electronic form, without Dantec Dynamics' prior written permission.

License and Maintenance Fees

You must pay any and all licensee and maintenance fees in accordance with the then-current
payment terms established by Dantec Dynamics.

Limited Warranty

You are obliged to examine and test the Software immediately upon your receipt thereof.
Until 30 days after delivery of the Software, Dantec Dynamics will deliver a new copy of the
Software if the medium on which the Software was supplied is not legible.

A defect in the Software shall be regarded as material only if it has a material effect on the
proper functioning of the Software as a whole, or if it prevents operation of the Software in
its entirety. If until 90 days after the delivery of the Software, it is established that there is a
material defect in the Software, Dantec Dynamics shall, at Dantec Dynamics' discretion, either
deliver a new version of the Software without the material defect, or remedy the defect free
of charge or terminate this License Agreement and repay the license fee received against the
return of the Software. In any of these events the parties shall have no further claims against
each other. Dantec Dynamics shall be entitled to remedy any defect by indicating procedures,
methods or uses ("work-arounds") which result in the defect not having a significant effect on
the use of the Software.

Software is inherently complex and the possibility remains that the Software contains bugs,
defects and inexpediencies which are not covered by the warranty set out immediately
above. Such bugs, defects and inexpediencies etc. shall not constitute due ground for ter-
mination and shall not entitle you to any remedial action including refund of fees or payment
of damages or costs. Dantec Dynamics will endeavour to correct bugs, defects etc. in sub-
sequent releases of the Software.

The Software is licensed "as is" and without any warranty, obligation to take remedial action or
the like thereof in the event of breach other than as stipulated above. It is therefore not war-
ranted that the operation of the Software will be without interruptions, free of bugs or
defects, or that bugs or defects can or will be remedied.

Indemnification

Dantec Dynamics will indemnify you against any claim by an unaffiliated third party that the
Software infringes such unaffiliated third party's intellectual property rights and shall pay to
you the amount awarded to such unaffiliated third party in a final judgment (or settlement to
which Dantec Dynamics has consented) always subject however to the limitations and exclu-
sions set out in this paragraph.



You must notify Dantec Dynamics promptly in writing of any such claim and allow Dantec
Dynamics to take sole control over its defense. You must provide Dantec Dynamics with all
reasonable assistance in defending the claim.

Dantec Dynamics' obligation to indemnify you shall not apply to the extent that any claim com-
prised by this paragraph is based in whole or in part on (i) any materials provided directly or
indirectly by you; (ii) your exploitation of the Software for other purposes than those
expressly contemplated in this License Agreement; and/or (iii) combining of the Software with
third party products. You shall reimburse Dantec Dynamics for any costs or damages that res-
ult from such actions.

If Dantec Dynamics receives information of an alleged infringement of third party intellectual
property rights or a final adverse judgment is passed by a competent court or a final set-
tlement consented to by Dantec Dynamics is reached regarding an intellectual property right
infringement claim related to the Software, Dantec Dynamics may (but shall not under any
obligation to do so), either (i) procure for you the right to continue to use the Software as con-
templated in this License Agreement; or (ii) modify the Software to make the Software non
infringing; (iii) replace the relevant portion of the Software with a non infringing functional
equivalent; or (iv) terminate with immediate effect your right to install and use the Software
against a refund of the license fees paid by you prior to termination. You acknowledge and
agree that Dantec Dynamics is entitled to exercise either of the aforesaid options in Dantec
Dynamics' sole discretion and that this constitutes your sole and exclusive remedy in the
event of any infringement of third party intellectual property rights.

Limitation of Liability

Neither Dantec Dynamics nor its distributors shall be liable for any indirect damages including
without limitation loss of profits and loss of data or restoration hereof, or any other incidental,
special or other consequential damages, and even if Dantec Dynamics has been informed of
their possibility. Further, Dantec Dynamics disclaims and excludes any and all liability based on
Dantec Dynamics' simple or gross negligent acts or omissions. In addition to any other lim-
itations and exclusions of liability, Dantec Dynamics' total aggregate liability to pay any dam-
ages and costs to you shall in all events be limited to a total aggregated amount equal to the
license fee paid by you for the Software.

Product Liability

Dantec Dynamics shall be liable for injury to persons or damage to tangible items caused by
the Software in accordance with those rules of the Danish Product Liability Act, which cannot
be contractually waived. Dantec Dynamics disclaims and excludes any liability in excess
thereof.

Assignment

Neither party shall be entitled to assign this License Agreement or any of its rights or oblig-
ations pursuant this Agreement to any third party without the prior written consent of the
other party. Notwithstanding the aforesaid, Dantec Dynamics shall be entitled to assign this
License Agreement in whole or in part without your consent to (i) a company affiliated with
Dantec Dynamics or (ii) an unaffiliated third party to the extent that such assignment takes
place in connection with a restructuring, divestiture, merger, acquisition or the like.

Term and Termination

Subject to and conditional upon your compliance with the terms and conditions of this License
Agreement may install and use the Software as contemplated herein.
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We may terminate this License Agreement for breach at any time with immediate effect by
serving notice in writing to you, if you commit any material breach of any terms and conditions
set out in this License Agreement. Without limiting the generality of the aforesaid, any failure
to pay fees and amounts due to Dantec Dynamics and/or any infringement of Dantec Dynam-
ics' intellectual property rights shall be regarded a material breach that entitles Dantec
Dynamics to terminate this License Agreement for breach.

Governing Law and Proper Forum

This License Agreement shall be governed by and construed in accordance with Danish law.
The sole and proper forum for the settlement of disputes hereunder shall be that of the
venue of Dantec Dynamics. Notwithstanding the aforesaid, Dantec Dynamics shall forthwith
be entitled to file any action to enforce Dantec Dynamics' rights including intellectual property
rights, in any applicable jurisdiction using any applicable legal remedies.

Questions

Should you have any questions concerning this License Agreement, or should you have any
questions relating to the installation or operation of the Software, please contact the author-
ized Dantec Dynamics distributor serving your country. You can find a list of current Dantec
Dynamics distributors on our web site: www.dantecdynamics.com.

Dantec Dynamics A/S

Tonsbakken 16-18 - DK-2740 Skovlunde, Denmark

Tel: +45 4457 8000 - Fax: + 45 4457 8001

www.dantecdynamics.com

1.3 Hardware Liability
Dantec Dynamics is responsible for the safety, reliability and performance of the supplied
hardware equipment only if:

l The specific environmental conditions correspond to the requirements in the Tech-
nical Specifications.

l Assembly, operations, re-adjustments, modifications or repairs are carried out by per-
sons authorized by Dantec Dynamics.

l The equipment is used in accordance with the appropriate User's Reference Manual.

http://www.dantecdynamics.com/
http://www.dantecdynamics.com/
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2 Hardware Installation
This section describes how to connect an anemometer to the StreamWare Basic software via
an A/D device.

2.1 Anemometer Systems

2.1.1 MiniCTA
The 54T42 or 54T30 MiniCTA Box is a single-channel anemometer for velocity measurements.
All hardware settings are done by means of dip-switches and jumpers on the CTA board,
accessible by removing the cover of the MiniCTA Box. The overheat ratio, gain and offset are
adjusted in accordance with the MiniCTA manual. The anemometer is powered from a sep-
arate power adaptor. The probe is connected to the MiniCTA box and the output bushing is
connected to the input channel of the A/D device normally via a connector box delivered
together with the A/D device.

For information see: MiniCTA 54T30 Installation and User's Guide and MiniCTA 54T42 Installation
and User's Guide.

2.1.2 MultiChannel CTA
The MultiChannel CTA is a multiple-channel anemometer available in 3 versions:

l 4-channel 54N82 with 4 velocity channels,

l 6-channel 54N81 with 6 velocity and one temperature channel

l 8-channel 54N80 with 8 velocity channels.

Hardware set-up of the individual velocity channels in a MultiChannel CTA are done exactly as
in the single -channel MiniCTA. The output signals are routed from a multi-pin connector via a
flat cable to the A/D device input.

The 6-channel version is delivered with a temperature probe where the output is from chan-
nel 6. As an option, a velocity reference probe can be ordered for in situ probe calibration in
e.g. a wind-tunnel. (The output is from channel 7). For further information see the MultiChan-
nel CTA 54N80/81/82 Installation & User's Guide.

2.1.3 Other CTA Systems
In principle, StreamWare Basic may be used with any third party CTA anemometer, which has
an analog output, with potential limitations depending on the anemometer. The connection to
the A/D input is done as in the case of the MiniCTA.

2.1.4 Temperature Probe
If you want to utilize the automatic temperature correction feature in the software, an input
from a temperature probe measuring the ambient temperature is needed. The 54T40 Min-
iCTA Temperature Box including the 90P10 temperature transducer is recommended for this
purpose.



2.1.5 Velocity Reference Probe
The velocity reference probe type 54T29 can be connected to the 54N81 MultiChannel CTA
via 54B16 cable and used for multichannel calibration of hot-wire probes at velocities up to 30
m/s.

2.2 Connecting Probes and making Grounding Pre-
cautions
Grounding the Probe(s)

Probes for measurement in air or other gases should not be grounded. If you have installed a
film probe in liquid then connect the shield of the probe input BNC connector at the CTA to a
grounding electrode placed in the liquid as close to the probe as possible. This is described in
more detailed in"Grounding Considerations" (on page 55).

Warning
The BNC connectors on the Probe Cables are electrically part of the cable shield. Therefore
avoid contact between the transducer/cable BNC connector assembly  and electrically con-
ducting structures of the experimental equipment (wind-tunnel or the like).

2.3 Connecting Anemometer Output to A/D Input
The output voltage(s) from the anemometer(s) and outputs from possible temperature and
pressure transducers can be connected to the A/D input in different ways.

As a rule of thumb you can follow the following rules:

l If the power supplies of the Anemometers and additional transducers are insulated
from each other use Single-ended Referenced input.

l If the power supplies are not insulated from each other use Differential input.

In all cases it is recommended to check the actual A/D device manual.

If you are using a Notebook computer, it is advised to connect the reference ground to a suit-
able ground. This is due to the fact that a Notebook computers often do not have a ground
chassis.

2.4 Manual Calibration System

2.4.1 Unpacking
The Manual Calibrator arrives in one box containing:

Calibrator with Nozzle I mounted.

Probe Holder.

Note
After you have unpacked all items, save the box and packing materials for future use. Verify
that all items are present and in good condition. If anything is damaged or missing contact
your local dealer immediately.

14



15

Note
The Nozzles are machined with high-precision and must be handled with care. Remove dust
before mounting - only use lens-cleaning tissue! Store the nozzles in the accessory box when
not in use.

2.4.2 Installation of the Calibrator

Operating Environment

The unit is designed for placement free on e.g. a table. It can be placed in a horizontal or a ver-
tical position.

Note
For calibration at low velocities (Nozzle 0) the calibrator must be placed so that the air jet is dir-
ected upwards. Ambient air motions must also be kept at a minimum!

Connecting the Air Supply

Insert the Quick Connector on the hose with the supply air into the Air Supply connector on
the Calibrator front panel.

Warning
Do not use your finger/hand to block the calibrator jet (or air from the air supply) - the air pres-
sure can be potentially dangerous.

Requirements to the Supply Air

Air must be available in a sufficient amount at a proper pressure level:

Amount:> 400 Standard Liter/min.

Pressure: > 0.7 MPa <0.9 MPa (7 - 9 bar)

Air Composition: Standard Atmospheric air.

Note
The air supplied to the Calibrator must be oil/moisture and particle free complying  with ISO
8573.1, Class 1,1,1:

Particle size: < 0.1 µm

Particle concentration: max. 0.1 mg/m3

(Water / humidity) Pressure dew point: max -70°C ( -94°F)

Oil concentration: max. 0.01 mg/m3

If required, an Air Filtering Unit is available separately, which assures that the particle size and
concentration, and the oil content is in accordance with the requirements for use with the Cal-
ibrator , see "Air Filtering Unit" (on page 31).

Note
The requirements concerning the water content in the supply air is not directly fulfilled by
using the Air filter unit! The water content of the supply air must be verified before con-
necting the Calibrator. An additional inline water vapor filter can be required.



Replacing a Nozzle

The Calibrator is delivered with Nozzle I mounted. You can purchase and mount another
Nozzle, if it does fit your calibration velocity range. The Nozzle Selection Guide below or in the
accessory box shows the ranges covered by the individual Nozzles.

To exchange a Nozzle perform the following:

Make sure that the air is switched off, or the velocity is set to zero from the StreamWare Basic
software.

Unscrew the Nozzle to be replaced.

Screw the new Nozzle into the threaded opening of the Settling Chamber. Take care that the
Nozzle is screwed fully down. It may be necessary to add a little grease to the O-ring and dis-
tribute it evenly. This will make it much easier to loosen the Nozzle next time you exchange it.

Note
Do not introduce any tools or drop anything down into the Settling Chamber when it is open,
as this may damage the Settling Chamber Temperature Transducer or the  Net Section.

Mounting the Probe Holder

The Calibrator is delivered without a Probe Holder.

Screw the Probe Holder directly into the mounting hole on the top plate. For use with straight
probes place the clamp with vertical faces and for use with straight angle probes with its faces
horizontally.
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X, Y, Z

Coordinates:

Shows the orientation of the calibrator coordinate system.

Note
During calibration the probes should be placed with the probe coordinate system coinciding
with the calibrator coordinate system.

Air Supply

1/4" Quick Connector, male

The air from the Pressurized Air Supply is applied here.



Note
The air must be properly filtered as described under "Installation of the Calibrator" on
page 15.

Nozzle Mount

Threaded opening in the Settling Chamber for mounting of calibration Nozzles.

Manipulator Mounting Holes

Threaded holes for mounting of the Yaw/Pitch Manipulator.

Probe Holder Mounting Holes

Threaded holes for mounting of the Probe holder assembly.

Nozzle Units

Nozzle Number

Identification of approximate Nozzle size and appropriate velocity range for respective
nozzle.

0:1400 mm2 ( 42 mm) for 0.02 - 0.5 m/s

I:120 mm2 ( 12 mm) for 0.5 - 60 m/s

II:60 mm2 ( 8.7 mm) for 5 - 120 m/s

III:20 mm2 ( 5 mm) for 5 m/s - >300m/s
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Nozzle Exit

The edge of the nozzle exit (opening) is placed 0.6 nozzle-diameters below the top surface of
the Nozzle Unit. The elevated top surface protects the nozzle edge and is used for probe align-
ment. It is recommended to place the probe with its sensor flush with the upper surface dur-
ing calibration.

Mounting Thread

For mounting into the Settling Chamber of the Calibrator.

Probe Holder

Mounting Rod

Mounts into the top plate of the Calibrator.

Probe Clamp

Holds Probes or Probe Supports. Can be turned 90 facilitating mounting of both straight and
right-angle bend probes.

2.5 StreamLine Pro Automatic Calibration System

2.5.1 Unpacking
The StreamLine Pro Automatic Calibrator arrives in one box containing:



Calibrator with Nozzle II mounted.

Probe Holder.

Grease for O-rings on Nozzles.

USB Cable (3 m)

Power supply ( 24V)

4 Nozzles: (approximate orifice size and velocity range)

0: 1400 mm2 ( 42 mm) for 0.02 - 0.5 m/s

I: 120 mm2 ( 12 mm) for 0.5 - 60 m/s

II: 60 mm2 ( 8.7 mm) for 5 - 120 m/s (mounted at delivery)

III: 20 mm2 ( 5 mm) for 5 m/s - >300m/s

Note
After you have unpacked all items, save the box and packing materials for future use. Verify
that all items are present and in good condition. If anything is damaged or missing contact
your local dealer immediately.

Note
The Nozzles are machined with high-precision and must be handled with care. Remove dust
before mounting - only use lens-cleaning tissue! Store the nozzles in the accessory box when
not in use.

2.5.2 Installation of the Calibrator

Operating Environment

The unit is designed for placement free on e.g. a table. It can be placed in a horizontal or a ver-
tical position.

Note
For calibration at low velocities (Nozzle 0) the calibrator must be placed so that the air jet is dir-
ected upwards. Ambient air motions must also be kept at a minimum!

It is recommended that the calibrator is let to warm up for > 10 minutes before a calibration is
performed.

Connecting the Air Supply

Insert the Quick Connector on the hose with the supply air into the Air Supply connector on
the Calibrator front panel.

Warning
Do not use your finger/hand to block the calibrator jet (or air from the air supply) - the air pres-
sure can be potentially dangerous as air can be introduced into the bloodstream.

Requirements to the Supply Air

Air must be available in a sufficient amount at a proper pressure level:
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Amount:> 400 Standard Liter/min.

Pressure: > 0.7 MPa <0.9 MPa (7 - 9 bar)

Air Composition: Standard Atmospheric air.

Note
The air supplied to the Calibrator must be oil/moisture and particle free complying  with ISO
8573.1, Class 1,1,1:

Particle size: < 0.1 µm

Particle concentration: max. 0.1 mg/m3

(Water / humidity) Pressure dew point: max -70°C ( -94°F)

Oil concentration: max. 0.01 mg/m3

The Calibrator is delivered with an Air Filtering Unit that assures that the particle size and con-
centration, and the oil content is in accordance with the requirements for use with the Cal-
ibrator, see "Air Filtering Unit" (on page 31).

Note
The requirements concerning the water content in the supply air is not directly fulfilled by
using the Air filter unit! The water content of the supply air must be verified before con-
necting the Calibrator. An additional inline water vapor filter can be required.

Replacing a Nozzle

The Calibrator is delivered with Nozzle II mounted. You can select and mount another Nozzle,
if it does fit your calibration velocity range. The Nozzle Selection Guide below or in the access-
ory box shows the ranges covered by the individual Nozzles.

Nozzles: (approximate orifice size and velocity range)

0: for 0.02 - 0.5 m/s1*

I: for 0.5 - 60 m/s

II: for 5 - 120 m/s

III: for 5 m/s - >300m/s

1For calibration at low velocities (Nozzle 0) the calibrator must be placed so that the air jet is directed
upwards. Ambient air motions must also be kept at a minimum!



To exchange a Nozzle do the following:

Make sure that the air is switched off, or the velocity is set to zero from the StreamWare
Application software.

Unscrew the Nozzle to be replaced.

Screw the new Nozzle into the threaded opening of the Settling Chamber. Take care that the
Nozzle is screwed fully down. It may be necessary to add a little grease to the O-ring and dis-
tribute it evenly. This will make it much easier to loosen the Nozzle next time you exchange it.

Note
Do not introduce any tools or drop anything down into the Settling Chamber when it is open,
as this may damage the Settling Chamber Temperature Transducer or the  Net Section.

Mounting the Probe Holder

The Calibrator is delivered without the Probe Holder mounted.

Screw the Probe Holder directly into the mounting hole on the top plate. For use with straight
probes place the clamp with vertical faces and for use with straight angle probes with its faces
horizontally.
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2.5.3 Calibrator Connections
The function of all connectors, are briefly described below.

The Calibrator is operated from the StreamWare Basic software via USB or Ethernet inter-
faces.

USB

Connecting the Calibrator to a PC by means of a USB cable (included). In the Automatic Cal-
ibrator, the USB interface is of the HID device type. A generic USB driver is used and no



installations are required to establish communication. When the Calibrator is connected to a
PC with supporting HID drivers present (Windows XP or newer), the Green LED next to the
USB connector, will be turned ON when  the device is recognized/acknowledge by the PC. The
USB protocol is standard - if required the settings can be found in the Device dialog.

Ethernet

A standard Ethernet cable, shielded RJ45 type, can be attached to the Automatic Calibrator for
remote control via LAN.LED's incorporated in the connector indicates connection status.

The Ethernet interface can obtain its IP address from a DHCP server if present; otherwise a
static IP address is used. In all cases the Automatic Calibrator uses Port 1001 for com-
munication.

Static IP address:

When delivered the IP address is set to factory default: 192.168.0.10, netmask
255.255.255.0 and DHCP is disabled.The static IP address is saved i memory as four para-
meters (87 to 90). The user can change the static IP address, as well as the Netmask and
Default Gateway address, to adapt to the LAN configuration.

Note
When the static IP address is used, the red ‘STOP’ LED will blink 5 times after the self-test has
completed.
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Logging

All communication with the Automatic Calibrator is logged to the output Window.

2.5.4 Calibrator Indicators and Button
The location and function of controls and lamps are briefly described below.

Ready

Green LED

Indicates that the Calibrator is ready to operate.

STOP

Push button

Pressing the button causes the air flow to stop immediately and the calibration sequence is hal-
ted.

LED lamp in Stop button

Indicates that STOP has been activated and that air is switched off the system.

When STOP has been activated the system can only be restarted from the StreamWare Applic-
ation Software.

Power

LED lamp

Indicates that the power is on.

Busy

LED lamp

Indicates that the Calibrator is busy e.g with setting a velocity for calibration.



X, Y, Z

Coordinates:

Shows the orientation of the calibrator coordinate system.

Note
During calibration the probes should be placed with the probe coordinate system coinciding
with the calibrator coordinate system.

Air Supply

1/4" Quick Connector, male

The air from the Pressurized Air Supply is connected here.

Note
The air must be properly filtered as described under "Installation of the Calibrator" on
page 20.

Nozzle Mount

Threaded opening in the Settling Chamber for mounting of calibration Nozzles.

Manipulator Mounting Holes

Threaded holes for mounting of the Yaw/Pitch Manipulator.

Probe Holder Mounting Holes

Threaded holes for mounting of the Probe holder assembly.
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2.5.5 Nozzle Units

Nozzle Number

Identification of approximate Nozzle size and appropriate velocity range for respective
nozzle.

0:1400 mm2 ( 42 mm) for 0.02 - 0.5 m/s

I:120 mm2 ( 12 mm) for 0.5 - 60 m/s

II:60 mm2 ( 8.7 mm) for 5 - 120 m/s

III:20 mm2 ( 5 mm) for 5 m/s - >300m/s

Nozzle Exit

The edge of the nozzle exit (opening) is placed 0.6 nozzle-diameters below the top surface of
the Nozzle Unit. The elevated top surface protects the nozzle edge and is used for probe align-
ment. It is recommended to place the probe with its sensor flush with the upper surface dur-
ing calibration.

Mounting Thread

For mounting into the Settling Chamber of the Calibrator.



2.5.6 Probe Holder

Mounting Rod

Mounts into the top plate of the Calibrator.

Probe Clamp

Holds Probes or Probe Supports. Can be turned 90° facilitating mounting of both straight and
right-angle bend probes.

2.6 Pitch/Yaw Manipulator
The Pitch/Yaw Manipulator is optional and must be ordered separately.

2.6.1 Unpacking
The Pitch/Yaw Manipulator arrives in one box containing:

Pitch/Yaw Manipulator.

Spacers, 2.5 mm (2 PCs.)

Screws, M5x14  (2 PCs).

Washers (2 PCs.)
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Hexagonal Wrench, 4 mm.

Alignment tool for Dantec Triple-sensor probe.

Note
After you have unpacked all items, save the box and packing materials for future use.

Verify that all items are present and in good condition. If anything is damaged or missing con-
tact your local dealer immediately.

2.6.2 Installation of the Pitch/Yaw Manipulator
It is assumed that the system is unpacked and all items present. For the installation you will
need the following:

2 Screws, M4.

Hexagonal wrench.

Remove the Probe Holder, if mounted, by turning it anti-clockwise. Use a pin (e.g. the
Hexagonal wrench) inserted in the hole near its base to loosen it from the top plate.

Place the Pitch/Yaw Manipulator with the Console over the two mounting holes on the top
plate of the Calibrator and fasten it with the two screws enclosed.

Note
When placed directly on the top plate the rotation axis is aligned with the rim of the Nozzle cor-
responding to the recommended position of the sensor during calibration. This reduces the
movement of the Swinging arm to ±60°.

If you want to turn the Swinging arm through the full ±90°, you must insert the two Spacers
under the Console in order to lift  its rotation axis above the rim of the Nozzle. In this way the
probes can be rotated perpendicular to their sensor/prong plane without damaging the
sensor or prongs. In order to use the full 90 angle the Locking Nut on the Swinging arm must
be loosened appropriately.



2.6.3 Mounting the Pitch Yaw Manipulator

Pitch/Yaw Manipulator, Interface with the Surroundings

The Pitch/Yaw Manipulator allows you to position the probe under any desired  angle of attack
between its sensor and the flow. The positioning is done manually.

Probe Clamp

Holds Probes and Probe Supports during calibration. Allows exact positioning of the sensor(s)
in the turning point of the manipulator.

Rotating Ring

Base for the Probe Clamp with positioning marks for each 5. Can be turned through 360°. 
Establishes Roll angles.

Swinging Arm

Base for the Rotating ring. Can be turned through ±60° or ±90°. Establishes Yaw and Pitch
angles.
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Console

Mount for the Swinging arm with 5 Pitch/Yaw-angle scaling. Is fastened to the top plate with
the two M4 screws.

Pitch Yaw Manipulator.

2.7 Air Filtering Unit
The Air Filtering Unit is delivered with the StreamLine Pro Automatic Calibrator and the filter
must always be installed when operating the calibrator.

2.7.1 Unpacking
The Air Filtering Unit arrives in one box and consists of:



Filter with Quick Connectors.

One 1/4" Pressure Hose with Quick Connectors, 10 m long.

Note
After you have unpacked all items, save the box and packing materials for future use.

Verify that all items are present and in good condition. If anything is damaged or missing con-
tact your local dealer immediately.

2.7.2 Installation
The Air Filtering Unit is inserted between your Compressed Air Supply and the Calibrator. It is
recommended to mount the Filter proper on a wall or the like by means of its Mounting
Flanges.

l Connect Pressure Hose to the Air Supply Quick Connector on the Calibrator.

l Connect the Pressure Hose to the Filter Outlet Quick Connector.

l Connect the Inlet Quick Connector of the Filter to your Compressed Air Supply.

The Compressed Air must fulfill the requirements in accordance with the PNEUROP 6611
standard before it enters into the Air Filtering Unit:

l Particle size: Class 4, < 50 µm

l Particle concentration: Class 4, not specified

l Water content:Class 1, < 25 ppm

l Oil content: Class 4, < 4200 ppm

Note
The air supplied to the Calibrator must be oil/moisture and particle free complying  with ISO
8573.1, Class 1,1,1:

Particle size: < 0.1 µm

Particle concentration: max. 0.1 mg/m3

(Water / humidity) Pressure dew point: max -70°C ( -94°F)

Oil concentration: max. 0.01 mg/m3

The Air Filtering Unit assures that the particle size and concentration, and the oil content is in
accordance with the requirements for use with the Calibrator.

Note
The requirements concerning the water content in the supply air is not directly fulfilled by
using the Air Filtering unit! The water content of the supply air must be verified before con-
necting the Calibrator. An additional inline water vapor filter can be required.
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2.7.3 Air Filtering Unit Connections

Air Filter Unit.

Filter

Air Inlet

1/4" Quick Connector, Male

Apply Compressed Air here.

Air Outlet

1/4" Quick Connector, Male

Connect Pressure Hose to the Calibrator here.

Mounting Flanges

4 holes, 10 mm diameter

For mounting of the Filter on a wall or a plate by means of 4 screws, e.g. 8 MG.

Pressure Hose

Air Inlet/Outlet

1/4" Quick Connectors

Connect on Filter and Calibrator, respectively.
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3 Software Installation
This section defines the hardware and software environment that you need in order to install
the StreamWare Basic software and it describes the installation procedure. The StreamWare
Basic user interface and their related Icons are explained.

Installation and setup of A/D devices supported by StreamWare Basic is described in "A/D
Devices" on page 202.

Note
Some of the functions described in this User's Guide are only accessible, when the proper
add-on to the basic software package has been installed. These functions are clearly marked in
the text.

3.1 Installation of StreamWare Basic

3.1.1 Unpacking
StreamWare Basic is delivered in a box containing a DVD together with one dongle and a
license agreement.

3.1.2 System Requirements

l PC with a modern multi-core processor.

l Installation must be performed by an account with admin privileges.

l Microsoft® Windows© 10 x86/x64 with latest updates.
- or -
Microsoft® Windows© 8 x86/x64 with latest updates.
- or -
Microsoft® Windows© 7 x86/x64 with latest updates.
- or -
Microsoft® Windows© Vista x86/x64 with latest updates.

l Microsoft® Windows© Installer v3.0 or later.

l Microsoft® Internet Explorer 6 or later with latest security updates.

l 512 MB of RAM minimum.

l 200 MB of available hard-disk space minimum; 1 GB for running acquisitions.

l DVD drive.

l Super VGA (800x600) or higher-resolution monitor with 65.000 colors or more.

l USB or Parallel port for dongle.

l Mouse or compatible pointing device.

Microsoft® Windows© 95, 98, 98SE, Me, NT, 2000, and XP operating systems are not sup-
ported.

3.1.3 Installation
To install StreamWare Basic, insert the DVD into the drive of the PC and execute the
SETUP.EXE file. This will start the installation program. If your PC supports the autostart



feature, the setup program will start automatically.

It is recommended that you follow the guidelines in the installation routine. Select the path
where you wish to install the files. The default directory path is:

C:\ Program Files\Dantec Dynamics\StreamWare Basic\

When you have finished the installation, you can start the program by double clicking on the
StreamWare Basic icon on the Windows Desktop or in the Start Menu.

3.2 StreamWare Basic Workplace
When you start up StreamWare Basic, only the start-page, including the Users Guide, the File
tab and the Get started tab open. You can now open a previously stored databases or create a
new. In the Get started tab you easily can access the online help (Get started and Help com-
mand) and read about new features in the version of StreamWare Basic installed.

The StreamWare Basic workplace at start-up.

In the Start page recently used Databases and Databases that are "Pinned" are displayed. On
the bottom of the page the user Guide is displayed.

You can arrange the working place freely. Make a left-mouse click e.g. on the Database frame
and you can move the database window to another location or disconnect the window from
the fixed locations. StreamWare Basic remembers your settings when you close the program.

Once you have opened an existing database ( or created a new database and project with a sys-
tem configuration) additional Tabs are displayed in the Ribbon bar.

3.3 Ribbon Bar
The Ribbon bar contains tool buttons for all major actions when creating and running a pro-
ject, which are:

Create new database, open database, system configuration, hardware setup, default setup,
experiment setup, data acquisition, data reduction, active probe, online, velocity calibration,
directional calibration and graph.
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StreamWare Basic Application window with an opened Project Manager, Data sheet, and the Rib-
bon bar with several Tabs with command Buttons displayed.

The Ribbon bar has different Tabs and under each Tab command Buttons belonging together
are collected in Groups to allow for easy access to all commands.

l File for handling databases, projects, libraries and for data exchange.

l Homefor clipboard tools, load and display Events in the project manager, information
on the projects and create new projects and tools for arranging windows,

l Configuration for defining system configuration, A/D devices, local variables and tem-
perature probe for temperature correction purposes.

l Setup for defining hardware setup(s), calibrations, and for running data acquisition
and data conversion/reductions.

l Run for starting data acquisitions, experiments and reduction of data.

When a data sheet is opened Datasheet Tools with additional Tabs are displayed in the Ribbon
bar. If a Graph is displayed Graph Tools appears with extra Tabs with useful commands to cus-
tomize the graph.

At the bottom of the window a Status bar shows which project is open.

In the top right corner you can Close the selected window, Display Help (F1) and Minimize the
Ribbon bar so that only the Tab names are shown.

Top right corner information: Close opened window, Display Help and Minimize the Ribbon.



3.3.1 Definitions
Buttons that are shaded are not enabled and can not be used with the present configuration
or requires that you opens an event in the program manager.By moving the mouse pointer
over selectable Buttons additional information appears:

3.4 The Ribbon Bar: Tabs, Groups and Command Buttons

3.4.1 File Tab

Databases

Use the dialogs and buttons to open or delete an existing database or to create a new Data-
base.
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Libraries

The Libraries list and the Device library selected.

Device Library:

A/D Devices, Traverse Systems, Calibrators.

Probe Library:

Contains default data for most Dantec Dynamics probes and transducers.

Analysis Library:

Contains drivers for e.g. basic statistics, power spectrum and auto-correlation routines.

Two-Point Calibration Library:

Contains data to be used in combination with a Two-point calibration of standard probes.

3.4.2 Home Tab

You can arrange the workplace using the commands in the Windows group.



3.4.3 Configuration Tab

Configure the system.

3.4.4 Setup Tab

Setup the Hardware and perform calibrations.

3.4.5 Run Tab

Perform a data acquisition, edit calibration events and operate the traverse or calibrator.

3.4.6 Datasheet Tools
When a Event data sheet is opened/loaded the Datasheet Tools appears to the right in the Rib-
bon bar. Two new Tabs appears (under DataSheet Tools) the Options tab and the Formatting
tab.

Options

Here you can Import and Export data and generate a Graph of data from the data sheet. The
Graph can then be customized in the Graph Tools, see below. There are also buttons to per-
form Analysis on data in the data sheet.

Formatting

Here you can optimize the appearance of the data sheet and insert or delete rows.

3.4.7 Graph Tools
When a Graph is opened the Graph Tools appears to the right in the Ribbon bar. Two new
Tabs appears (under Graph Tools) the Options tab and the Formatting tab.
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Options

Here you can open the Graph properties dialog by click on the Data Series button. In the
Export group you can export the Graph to the most common image types or direct open the
graph as Bitmap.

Formatting

Here you can optimize the appearance of the Graph.

3.5 StreamWare Basic Icons
StreamWare Basic icons are command Buttons placed in the Groups under the different Tabs
in the Ribbon bar. By moving the mouse pointer over the button additional information
appears below the button. To activate the command click once with the mouse on the button.

Other symbols/icons are used inside the dialog boxes or configuration dialogs.

3.5.1 Dialog Box Icons

Configuration Symbols

Assign 1D wire/fiber probe

Assign 2D wire/fiber probe

Assign 3D wire/fiber probe

Assign 1D film probe

Assign 2D film probe

Assign Misc. probe (temperature, pressure etc.)

Assign Reference probe (velocity reference)

1D Support (automatically assigned)

2D Support (automatically assigned)



3D Support (automatically assigned)

Cable (automatically assigned)

Assign StreamLine Frame Temperature Probe

Assign MultiChannel CTA Frame

MiniCTA Box (automatically assigned)

MiniCTA Temperature Box (automatically assigned)

Assign StreamLine Frame Modules

Assign A/D Channels

Default Setup

Select Hardware Setup (reference temperature, over-
heat ratio etc.)

Select Group Schedule

Select Traverse Setup

Select Data Acquisition Setup

Select Data Reduction Setup

Run Default Setup

Data Reduction

Define Data Reduction (moments, mean, RMS etc.)

Define Linearization of Velocities from Calibration

Define Temperature Compensation of Probe
Voltages

Define Decomposition of Velocity Components in
Probe Coordinates

Define Coordinate Transformation of Velocity Com-
ponents

Define Probe Array
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3.6 Software Options

3.6.1 Programmer's Toolkit for CTA
The software structure allows interfacing with external devices and software code. If  you
want to use OEM A/D Devices or Traverse Systems that are not supported by Dantec Dynam-
ics or you want to create your own Extended Processing code, the Programmer's Toolkit for
CTA provides you with a set of templates for writing customized translation drivers. The writ-
ing of drivers requires experience in programming MS Windows drivers. The Programmer's
Toolkit has to be ordered separately.

3.6.2 MultiChannel CTA Add-On
The MultiChannel CTA Add-on extends the StreamWare Basic software with MultiChannel CTA
features. This includes multichannel calibration, probe arrays and multichannel data reduc-
tion.

3.6.3 Tecplot Data Loader for CTA
The Tecplot Data Loader for CTA allows for direct import of StreamWare Basic data into
Tecplot. The Tecplot data Loader is added to the Tecplot installation and allows Tecplot to
browser and load StreamWare Basic databases.

Tecplot is a registered trademark of Tecplot, Inc.

3.6.4 LabVIEW Toolbox for CTA
Dantec Dynamics provides a comprehensive toolbox for LabVIEW for controlling the Min-
iCTA/MultiChannel CTA systems. Please contact you local Dantec Dynamics sales rep-
resentative for more information.

3.6.5 Ordering Information

9046S026 Programmers Toolkit for CTA

MultiChannel CTA Add-On

9080S049 Tecplot Data Loader for CTA

9054S055 LabVIEW Toolbox for CTA
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4 Configuring the System
This section describes how to configure your MiniCTA/MultiChannel CTA system once installed
and ready for operation. Configuration is the physical set up and interconnection of trans-
ducers, modules and devices and consists of the following:

l Selecting and installing A/D Device

l Selecting and installing Traverse System (optional)

l Selecting Probes

l Configuring CTA Bridges

l Selecting Cables and mounting Probes

4.1 Selecting A/D Device
Selection of A/D device (board) depends on the specific application and how you want to treat
the data:

l PC requirements (build-in PCI or external USB)

l Number of quantities to be measured (number of A/D Channels)

l Maximum frequency component in the flow ( sampling rate)

l Required data reduction, e.g. correlation between sensor signals

l Consecutive or simultaneous sampling (sample/hold option)

4.1.1 Number of Channels
You will need one A/D Channel per sensor connected to the MiniCTA Boxes, i.e. one channel
per MiniCTA Box. If you want to measure reference conditions like temperature and pressure
from sensors with analog output, additional A/D Channels are required. The StreamWare
Basic software can handle up to 16 A/D Channels in total. A maximum of 2 MultiChannel CTA
Frames can be assigned at the same time.

4.1.2 Required Sampling Rate
The sampling rate is determined by the maximum frequency component in the flow. The
sampling theorem states that the sampling rate must be at least twice the highest frequency
component in the input signal. This ensures resolution of all frequency components in the fre-
quency domain without errors from aliasing. If only statistical averaging is performed (e.g.
mean, RMS.) lower sampling rates are adequate. The most efficient sampling rate is then half
of the integral scale of the process. The A/D device should be able to sample with the
optimum sample rate times the number of A/D Channels used, unless a parallel A/D device is
used.

4.1.3 Sampling Mode
If correlation between different channels has to be made, it may be necessary to select an
A/D device with simultaneous sampling on all channels in order to avoid time delay problems
(phase errors). The size of the on-board memory should be sufficient to store the number of
samples that is needed to provide the wanted confidence levels.



4.2 Selecting Traversing System
Traversing Systems are used to move the probe around in the flow under investigation. It is
selected on basis of the  following parameters:

l Number of dimensions to be traversed

l Probe rotation

l Size of the traverse grid

l Positioning accuracy

l Forces from the flow

Dantec delivers a Lightweight Traverse system that interfaces to  StreamWare Basic via a
Serial COM port. In this case it may be necessary to install an additional Serial COM port or a
USB to Serial connector in the PC.

If you select a Traverse System that is not supported by Dantec, it must have a Driver running
under Windows and a specific Translation Driver loaded into the Device Library of the
StreamWare application software. An optional Tool kit is available that allows you to write
drivers for non-Dantec traverse systems.

4.3 Selecting Calibrator Unit
For easy calibration of the CTA probes, the StreamWare Basic software supports dedicated
Dantec calibrator units. The calibrator unit can be either manual or automatic fully controlled
by the software. Select between:

l StreamLine Pro Automatic Calibrator (standalone unit)

l Two-Point Hot Wire Calibrator (manual calibrator)

4.4 Selecting Probes
The probes are selected on basis of fluid medium, dimension of the flow (1-, 2- or 3D) (Single-,
X- or Triple-sensor), expected velocity range, quantity to be measured, ambient temperature,
turbulence level, required bandwidth, possible temperature variations in the flow, con-
taminants in the flow, requirements to robustness, space considerations around measuring
point (free flow, confined flow, boundary layers etc.) and ambient pressure.
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Probe, Probe Support and Probe Cable.



4.4.1 Quick Guide to Probe Selection
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Free and Confined Flows

Type of flow Medium Recommended Probes

1-Dimensional

Uni-directional Gas Single sensor Wire

Single sensor Fiber, thin coat.

Wedge-shaped Film, thin coat.

Conical Film, thin coat.

Liquid Single sensor Fiber, heavy coat.

Wedge-shaped Film, heavy coat.

Conical Film, heavy coat.

Bi-directional Gas Split-fibers, thin coat.

Liquid Split-fibers, heavy coat.

2-Dimensional

One Quadrant Gas X-sensor Wires

X-sensor Fibers, thin coat.

V-wedge Film, thin coat.

Liquids X-sensor Fibers, heavy coat.

V-wedge Film, heavy coat.

Half Plane Gas Split-fibers, thin coat.

Liquids Split-fibers, heavy coat.

Full Plane Gas Triple-split Fibers, thin coat.

X-sensor Wire, flying hot-wire

Liquids Triple-split Fibers, special

3-Dimensional

One Octant(70 Cone) Gas Triple-sensor Wire

Triple-sensor Fiber, thin coat.

Liquids Triple-sensor Fiber, Special



90 Cone Gas Slanted Wire, rotated probe

Liquids Slanted Fiber, heavy coat.

Full Space Gas Omnidirectional Film

Wall Flows (Shear Stress)

Type of flow Medium Recommended Probes

1-Dimensional

Unidirectional Gas Flush-mounting Film, thin coat.

Glue-on Film, thin coat.

Liquids Flush-mounting Film, heavy coat.

Glue-on Film, special

4.5 Probe Selection Considerations

Fluid Medium

In thermal Anemometry we distinguish between two main fluid groups of fluid mediums:
gases and liquids. Liquids again may be divided into electrically conductive and non-conductive
liquids.

Gases (and Non-conducting Liquids)

For these fluids, where atmospheric air is far the most commonly used, Wire probes are the
obvious choice. Fiber-film probes, Split-fibers and Film-probes with thin quartz coating (0.5
mm) can be used too.

Conducting Liquids (and Non-conducting)

For these fluids, where water is the most commonly used, Fiber-film probes, Split-fibers and
Film-probes with heavy quartz coating (2 mm) are the obvious choice.

Note
A proper grounding of the anemometer system and the liquid is essential to prevent break-
through of the quartz coating and erosion of the sensor.

Dimension of the Flow-field

One-dimensional Flows (Uni-directional)

For this type of flow, where the flow vector stays on one axis without changing direction,
Single-sensor probes are used. It is recommended to use probes with straight configuration,
as they have smallest disturbing influence from the probe body on the sensor.

One-dimensional Flows (Bi-directional)

For this type of flow, where the flow vector stays on one axis but changes sign, Split-fiber
probes with two sensors placed opposite each other on a quartz fiber can be used. Meas-
urement of wall shear stress in separated or reversing boundary layers requires special flush-
mounting or glue-on probes with parallel sensors.
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Two-dimensional Flows (Flow Vector within one Quadrant)

For plane flows, where the resulting flow vector stays within the same quadrant, X-sensor
probes are recommended. They have two sensors placed perpendicular to each other (form-
ing an X) and provide two simultaneous signals. Slanted sensor probes can be used in sta-
tionary two-dimensional flows, where they are rotated to give signals, separated in time, from
different wire orientations.

Two-dimensional Flows (Flow Vector within one Half-plane)

For plane flows, where the resulting flow vector stays within the same half-plane, Split-fiber
probes with two sensors are recommended.

Two-dimensional Flows (Flow Vector within the Entire Plane)

For plane flows, where the resulting flow vector moves within the entire plane, e.g. reversing
flows in eddies and separated boundary layers, Triple-split sensors, with three sensors on the
same fiber, can be used. If high temporal resolution is required, flying hot-wire systems with
X-sensor probes are recommended.

Three-dimensional Flows (Flow Vector within one Octant)

For three-dimensional flows, where the main flow direction is known, as is the case with high
turbulence flows, Triple-sensor probes with wire -or fiber-film sensors are used. They have 3
sensors placed in an orthogonal system and provide three simultaneous signals.

Three-dimensional Flows (Flow Vector over the Entire Space)

For real three-dimensional flows, where the direction of the flow vector is unknown, an Omni-
directional film-probe can be used. The Dantec Omnidirectional probe is designed for low velo-
cities only (max. 2 m/s) and low fluctuation frequencies with no or insignificant temperature
variations. The probe signal represents the speed without any directional information.

Velocity Range

The CTA-anemometer can be used over a very wide velocity range, 2 to 3 decades or more.
The lower limit is set by the onset of natural convection, while the upper limit is determined by
the physical strength of the sensor and probe body, disturbing effects like eddy-shedding
from the sensor, vibrations of the prongs, detached chocks from the probe body and espe-
cially in liquid flows by the available probe current in the CTA bridge.

Very Low Velocities

Most probes can be used at low velocities (down to a few cm/s in air) provided they are cal-
ibrated with the same orientation with respect to the gravitation field as during measurement
in order to minimize the influence from natural convection. At normal working conditions in
air, the influence from natural convection disappears at velocities above 20 - 25 cm/s. If the
flow direction changes the Omnidirectional probe may be the proper choice.

Low to Medium Velocities

All probe types can be used in flows of low to medium velocities. If Fiber-film probes are used,
eddy-shedding from the sensors should be looked for at higher velocities and if possible
filtered away before data reduction is carried out.

High (Subsonic) Velocities

Wire probes and Film-probes with non-cylindrical sensors should be used. The probes should ,
if at all possible, be placed with the prongs or probe bodies parallel to the flow direction in



order to avoid flow-induced vibrations.

Very High (Supersonic) Velocities

Straight Wedge-shaped film probes or special designed wire probes can be used. The probe
design should be so that the detached chock from the probe body stays behind the sensor.

4.5.1 Quantity to be Measured
Any quantity that relates to the heat transfer from the sensor can in principle be measured by
the CTA-anemometer, provided that all other influence parameters remain constant during
the measurement. The main quantity is the instantaneous velocity with the ambient tem-
perature as most important second influence parameter.

Instantaneous Velocity

Can be measured with all probe types, except wall mounted film-probes. The probe signal rep-
resents the effective cooling velocity in accordance with the probe calibration. Cooling velo-
cities from probes with more sensors (or rotated probes) can be decomposed into velocity
components (one for each sensor) in probe-related or laboratory coordinate systems.

Turbulence Components and other Derivatives

Can be obtained with all probe types on basis of the instantaneous probe signal.

Wall Shear Stress (Intermittency)

Can be measured with Flush-mounting film probes or Glue-on probes.  Probes with cylindrical
sensors mounted in the wall, e.g. in a small cavity, can be used too. Requires calibration in a
known shear flow. For heated walls special flush-mounting probes with an additional buried
sensor as heat guard is recommended.

If only the Intermittency factor (ratio between periods with turbulent and laminar boundary
layer) is wanted, the glue-on probe is the obvious choice.

Temperature

Slowly varying ambient temperatures can be measured with the Temperature Probe.

Fast varying temperatures can be measured together with velocity by two wire probes oper-
ated simultaneously close to each other at different overheat ratios.

Fast temperature fluctuations (temperature turbulence) can be measured with cold wires, i.e.
wire probes operated in Constant Current mode (54T40 MiniCTA Temperature Box).

Concentration

Concentration in binary gas mixtures can be measured with wire probes built into aspirating
probes, where the wire sensor is placed immediately behind a choked nozzle and exposed to
sound velocity. Such probes are available as special probes from Dantec.

Two-Phase Flows

Fiber-film probes, wedge-shaped probes and wire probes (in non-conducting liquids) are the
most often used probes for measurement of two-phase flows. The void-fraction is calculated
on basis of the probe signal level that is markedly different in the gas and liquid phase.
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4.5.2 Flow Conditions

Ambient Temperature Range

Very Low Temperatures (Cryogenic)

Most wire probes can be used at cryogenic temperatures without problems. Film probes may
deteriorate due to thermal stresses in the substrates.

Normal Temperatures

All Dantec standard probes can be used a temperatures ranging from minus 20 to 30 up to
plus 125 °C. Special versions of Glue-on probes may be used up to 200 - 250 C.

High Temperatures

Temperatures up to 750 C requires the High Temperature wire probe.

Turbulence Level

Very Low Turbulence Levels

Background turbulence less than fractions of a percent can be measured with the Parallel-
array probe, where a correlation of the two identical signals will remove the electronic white
noise from the turbulence signal.

Low to Medium Turbulence Levels

In low to medium turbulence in gases probes with miniature wire sensors are recommended.
In these cases the tangential cooling component is so small that the influence from the prong
ends on the sensor are of minor significance. In liquids any film probe can be used.

Medium to High Turbulence Levels

Gold-plated wire probes are used in this case in gases. The gold-plating keeps the sensing
area of the wire away from the prong ends resulting in less prong interference. These probes
have the smallest yaw-factor. In liquids V-wedge or Triaxial fiber-film probes are recom-
mended.

Bandwidth

The bandwidth of the CTA anemometer is a combination of the probe time constant, which is
velocity and overheat dependent, and the gain of the servo amplifier in the CTA. All probes
are designed with sensors having as small a time constant as possible with a view to a reas-
onable robustness.

DC to Very Low Bandwidth

All wire and fiber probes can be used down to DC. Other film probes have peculiar frequency
characteristics at low frequencies, below 50 to 100 Hz, where heat fluctuations are trans-
ferred indirectly to the fluid through the backing substrates. The Steel-clad probe is designed
especially for DC measurements.

Low to Very High Bandwidth

Wire probes have the smallest time constants and should be used in all high bandwidth applic-
ations, where possible. If standard 5 micron wires cannot meet the requirements, special
probes with 2.5 micron wires or less are available. Fiber -and film probes can theoretically be



used up to the very limit of the servo amplifier. In practice their bandwidth is limited, how-
ever, by the damping effect of the boundary layer.

Flow with Temperature Variations

In flows with varying temperature, different precautions can be taken in order to avoid sys-
tematic conversion errors, when probe voltages are converted into velocities. The Tem-
perature-compensated Wire probe automatic temperature compensates for slowly varying
temperatures. Other probes can be equipped with separate temperature-compensation ele-
ments on special order. Another solution will be to use a standard non-compensated probe
and measure the flow temperature simultaneously with the probe signal and perform the
temperature correction during data reduction in the StreamWare software. A third solution
for fast temperature fluctuations is to operate two identical probes with different overheat
ratios.

Contaminated Flows

It is normally anticipated that the CTA probes are used in clean flows. In practice there will
always be a certain amount of particles in the flow, if it is not carefully filtered. The influence of
particle contamination increases with decreasing sensor surface. Wire probes with 5 mm
sensors can be used without problems in normal laboratory air, if they are cleaned and recal-
ibrated at regular intervals. Fiber-film probes are less susceptible and can be used, e.g. in out-
door applications without problems. Film probes, especially conical probes are the obvious
choice in more contaminated flows. The Steel-clad probe with its 1.2 mm diameter sensor is
recommended for mean flow measurements in heavily contaminated flows.

Contamination is a much bigger problem in liquid flows than in gas flows. This means that film
probes with non-cylindrical sensors should always be preferred for fiber-film probes
whenever possible, unless a careful filtering is carried out.

Sensor Robustness

Normally all probes will survive almost any experiment, when safely placed in the test rig. Far
the most probe damages happen during handling. It is, however, wise to take the robustness
of the probe into consideration before it is selected for a particular application. In general the
robustness increases with the size of the sensor. 70 mm fiber-film probes are more robust
than wire probes with 5 mm wires, and wedge-shaped film probes are again more robust than
fiber-film probes.

Space Considerations

The selection of sensor type and probe configuration depends on the space available the
measuring point. It is recommended to select a probe that can be placed with the prongs or
the sensor substrate (quartz rod) in the main flow direction in order to avoid measuring
errors or maybe even sensor breakage due to vibrations in prongs or substrates. Straight ver-
sions are designed for free flow fields, right-angle versions for confined flows (e.g. in tubes)
and probes with cranked prongs are intended for boundary layer flows. In very limited space,
e.g. in small tubes, the subminiature wire probes could be the choice.

Ambient Pressure

Measurements with the CTA anemometer are in principle independent of pressure, as the
probe in fact senses the mass flux. When probes are calibrated against velocity, pressure vari-
ations, however, enters linearly into the conversion.
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Very Low Pressures

The lower limit for pressures, at which a probe can be used, are determined by the slip-flow
conditions defined by the Knudsen number (ratio between molecular mean free path and
sensor diameter should be smaller than 0.01). At low pressures probes with sufficient sensor
diameter, fiber-film probes or even Steel-clad probes, should be used.

Normal to High Pressures

All standard probes can be used up to 70 bar at room temperature, if Dantec Standard Sup-
ports and Mounting Systems are used. 

4.6 Configuring the CTA Bridge

4.6.1 Selecting Cables and mounting Probes

Selecting Cable Length

Normal Distance, 5 m

Most applications can be covered by the standard 5 m probe cable (combination of 1 m Probe
Support and 4 m Probe Cable). No specific requirements to the bridge configuration are
required.

Long Distance between Probe and Bridge

Distances up to 20 m can be established with the 1:20 bridge configuration. It should be
noted that the bandwidth is reduced, when the distance between probe and bridge is
increased.

4.7 Grounding Considerations
Due to the measurement principles in a CTA System it is most important that there is a well
established common signal ground connection in the whole system – as any differences in sig-
nal ground potentials (DC or AC noise) may have a significant impact on the quality/accuracy of
the CTA measurements. Basically the signal/reference ground terminals of different parts of
a CTA system (CTA electronics, A/D converter and PC etc.) must be directly connected in order
to minimize/eliminate any differences in voltage potentials between the different parts.

To avoid disturbing ground loop currents in the ground connections of a CTA System ideally
only one connection to power ground (protective earth) should be established for a CTA sys-
tem.

Note
The chassis of a portable PC (Laptop) may or may not have a direct connection to protective
earth through an attached mains power supply – see also below.

Protecting the Probes in Liquid Applications

For CTA measurements in water/liquids the proper grounding of the entire measurement
line must be carefully considered, specially in order to avoid CTA probe damage (strike-
through of the insulating quartz layer).

Except for the special precautions needed when measuring in water/liquids CTA probes and
probe cables should normally be electrically insulated from any conductive parts.



Connecting the Probe

The probes are connected to the Anemometer Bridge via Probe Supports and Probe Cables
(film probes are normally equipped with 1 m cable and need no Probe Supports).

Both probes and supports are designed so that their outer surfaces, ceramic tubing, metal
tubes and cables are insulated from the electrically circuitry of the bridge. This means that
they can normally be mounted in holders and/or clamped to the test rigs without any con-
siderations concerning possible ground loops.

Special care should, however, be taken to avoid that the BNC-connectors between Probe Sup-
ports and Probe Cables are in electrical contact with the test rig, as this may cause disturbing
ground loops. It is also important that the BNC-connectors on X-sensor or Triple-sensor Probe
supports are placed so that they do not touch each other, as this will influence the stability of
the servo-amplifiers in the CTA Modules.

Reference Ground Connections to an A/D Device

The 54T42 MiniCTA and newer MultiChannel CTA Systems have dedicated ground screw ter-
minals for signal/reference ground connections.

Older versions of the MiniCTA (54T30) and MultiChannel CTA’s do not have a dedicated ground
terminal. In this case the metal shield of one of the output BNC connectors can be used as
ground reference using a suitable clamp. With older versions of the MultiChannel CTA’s one of
the screws holding the metal frame may also be used for a reference ground connection.

Connecting a MiniCTA to an A/D device

The power adapter that comes with the MiniCTA is double insulated and the MiniCTA acts as a
floating signal source. It is therefore important to use differential input (DI), when the Min-
iCTA output voltage is acquired via an A/D device.

In order to avoid problems with different common-mode potentials/noise the anemometer
reference ground/signal ground must then be connected to the A/D converter reference
ground – or the PC chassis.

If more than one 54T42 MiniCTA’s are connected to the same power supply the common neg-
ative supply connection should be used as reference/system ground.

Note
Specially with older MiniCTA/MultiChannel CTA’s the negative power supply connection must
never be used as ground reference! – and it is not recommended that more than one 54T30
MiniCTA is connected to a common power supply because the special protection circuit in the
DC power inlet of each unit will cause problems with both extra electrical noise and also prob-
lems with the DC reference in the CTA Systems.

Connecting a MultiChannel CTA to A/D device

The dedicated A/D converter output of the MultiChannel CTA should always be connected to
an A/D device with single-ended referenced (SE) input.

Using an original National Instruments A/D converter cable also establishes the sig-
nal/reference ground connection between the MultiChannel CTA and the A/D converter.

Liquid Grounding

For all CTA applications in water (only fresh water should be used!) a grounding electrode
should be placed in the water close to the CTA probe. The electrode should be connected via a
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thick wire to the common signal/reference ground of the CTA System – see above.

The example in the figure below shows the grounding using a StreamLine/StreamLine Pro
Frame – but the principle is exactly the same for MiniCTA or MultiChannel CTA:

The complete measurement system/chain should be connected to the same ground con-
nection. The objective is to eliminate any potential differences to avoid electrical strike-
through of the probe insulation.

When probes are mounted in liquids it is important to ground the fluid as close to the probe as
possible by means of an electrode and connect it to the signal ground in order to avoid noise
problems. This will also protect the quartz coating against break down by large voltage dif-
ferences between the sensor film and the liquid built up by electrical charges in the flowing
medium.

Specific Grounding Problems when using Portable PC’s (Laptops)

When a portable PC is operated on the built-in batteries without any mains power supply (or
battery charger) connected there are normally no problems with ground loops etc.

This is also the case if the mains power supply/battery charger is a double-insulated type with
no separate protective ground pin/terminal.

However, most mains power supplies for portable PC’s are not double-insulated and must be
connected to protective earth for electrical safety reasons! Here the protective earth con-
nection will be connected to the PC chassis and thus also to the A/D converter and CTA Sys-
tem.

This is of course also the case with a stationary PC that also must be connected to protective
earth – like the StreamLine frame – see above.

CTA Systems and Noisy Mains Power Supply

If possible the signal ground connection of a CTA System should never be connected directly
to a mains power ground (protective earth) where e.g. inverters, switch-mode power supplies
and motors etc. are also connected - as such ground connection may contribute with sig-
nificant amounts of electrical noise.



In this case the signal ground (protective earth) of the CTA System should be connected to a
separate mains power distribution line where no electrical equipment generating significant
amounts of electrical noise is connected.

4.8 Temperature Correction Considerations

4.8.1 Background

The sensor resistance is temperature dependent

As the sensor resistance is temperature dependent, the sensor temperature should be meas-
ured simultaneously with the sensor resistance during the overheat adjustment (setting the
decade resistance) and logged during calibration and data acquisition in order to know the ref-
erence conditions. Thus, a reference temperature is required - preferably measured with the
same sensor in all steps of the measurement setup.

If a high absolute accuracy on mean velocity is required it is always recommended to include
temperature correction in order to avoid systematic errors from even small fluid tem-
perature variations. If not compensated for a temperature change of 1°C gives approx-
imately 2% error in velocity for a wire probe operated at the default overheat ratio 0.8.

During a short data acquisition the ambient temperature can be close to constant (in some
applications) and temperature correction of each data point may not be necessary. However,
a correction due to a temperature change between the calibration and the measurements
can still be required.

If a temperature sensor is connected to the system it is important to know the time constant
of the sensor - i.e. how fast the sensor reacts to ambient temperature fluctuations. If the tem-
perature correction of acquired data should make sense the temperature sensor (and the
data acquisition) must be fast enough to follow the real fluctuations in the flow.

Warning
Correct temperature correction requires proportionality between the acquired voltage and
the heat transfer from the probe. This is only the case when the Offset in the signal con-
ditioner is 0. Please make sure the Offset jumper is the MiniCTA / MultiChannel CTA channel is
set to OFF if you would like to perform temperature correction.

4.8.2 Methods in StreamWare Basic to handle the Temperature Dependence
of the Sensor Resistance

As noted above the temperature dependence must be considered in the hardware con-
figuration, hardware setup, and in the calibration and data conversion/reduction procedures.

Temperature correction based on a Reference Temperature and a Fixed decade set-
ting:

The Fixed decade setting is the default method to handle the temperature dependence of
the sensor resistance in StreamWare Basic. Normally the system temperature probe
(delivered with the system) is used to log the Reference temperature necessary for the tem-
perature correction.

The overheat adjustment is made at a specific temperature - the Reference temperature
(logged in connection with the overheat adjustment, see below). The decade is adjusted - and
then kept fixed - according to the selected overheat ratio and the sensor temperature will be
calculated based on the Reference temperature. The Reference temperature is used as the
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reference in the calibration procedure and conversion of acquired data if temperature cor-
rection is selected.

The 6-channel MultiChannel CTA Frame is delivered with a 90P10 Temperature Probe that can
be used as the Reference Temperature source for temperature correction. Only relative slow
temperature fluctuations can be followed and corrected for with the system temperature
probe. It is important to know how fast the sensor reacts to ambient temperature fluc-
tuations and with what sampling rate the temperature data are acquired to optimize the tem-
perature correction. 

In any case it is important to mount the CTA probe and the temperature probe close to each
other in the flow, so that they are both exposed to the same temperature.

A correction due to a temperature change between the calibration and the measurements is
often required. One approach is to use the system temperature probe and measure the tem-
perature at the beginning of the calibration procedure e.g. in the first calibration point and
then assume that the temperature stays constant during the entire calibration. However, a
calibration procedure can take several minutes (for a velocity calibration with many calibration
points) and the temperature in e.g. a calibration jet can vary in time. The StreamLine Pro Auto-
matic Calibrator has an internal temperature sensor and the temperature can be logged for
each point and used for temperature correction of the calibration event.

4.8.3 Temperature Correction - when using the StreamLine Pro Automatic
Calibrator

Calibration of a probe creates a dependency between the probe voltage and the velocity at a
certain reference condition (temperature and pressure).The temperature (and pressure)
should preferably be logged (e.g. from the calibrator device) during the calibration or
entered via keyboard and stored in the calibration worksheet,The calibration software reads
velocities and voltages and performs a curve fit through the calibration points.The fit forms
basis for the transfer function used to convert probe voltages into velocities.

Temperature correction with Fixed Decade Resistance

You are advised to select “Apply temperature correction” as the calibration procedure can
take several minutes and the temperature in the calibration jet/flow can change in time. With
temperature correction selected the probe voltages (or calibration coefficients) will
then be corrected for temperature variations during calibration The voltage E1 (E2, E3
for multi wire probes) for each calibration point will be corrected dependant on the difference
in the temperature stored for the calibration point and the reference temperature (Ref.
temp.) from the (last) overheat adjustment. The temperature can be measured e.g. with the
System Temperature Probe if placed adjacent to the probe being calibrated in e.g. a wind tun-
nel used for calibration or logged from the calibrator device). Select Calibrator or Sys-
tem/Reference probe as the temperature source in the calibration setup dialog.

The Calibration Reference Temperature is Displayed in the Curve Fit Analysis Dialog

You can see the impact of the temperature correction on the calibration constants (if power
law is used) by selecting and deselecting the correction.(You have to select Sensor and per-
form a new Curve fit to see the change in the worksheet). For polynomial fit or table look-up
fit the calibration constants are not changed instead the CTA output voltages acquired at one
ambient temperature are corrected (Ecorr) to the Reference temperature.



Check the hardware reference temperature to make sure the value is correct and taken from the
Hardware Setup information

4.8.4 Data Conversion
Data Conversion is a number of actions in the Data Reduction process during which  the raw
CTA output voltages are rescaled, temperature corrected, linearized and decomposed into
velocity components. The required setup and conversion processes to include the tem-
perature correction are according to "Fixed decade setting".

l Temperature probe (selected for temperature correction)

l CTA probe

l Temperature correction.

l Linearization.
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The required setup and conversion processes to include the temperature correction according to
"Fixed decade setting" .

You can click on the Temp. correction button to see the present settings. Normally the
Temperature probe is selected as the temperature source described above.

To define Data Reductions

Select the wanted probe by choosing the Probe button in the Reduction map.

To Select Conversion Level (Options button)

This option allows you to select how the raw data are converted before the data reduction is
carried out.

1. Select the Options Button in the Probe Reduction Options dialog box.
A Conversion Level dialog box opens.



Here you can choose between the following:

Voltage only:

The reduction will be done directly on the acquired raw voltages.

Velocity from calibration:

The voltages are converted into velocities in accordance with the selected transfer function.

Temperature correction

If selected the probe voltages or velocities will be corrected for temperature variations in the
flow as described above.

Note
The voltages are only corrected, when a calibration event with polynomial curve fit or table
look-up has been selected. If power law fit was selected the calibration constants are cor-
rected instead and the corrected velocity is loaded.

2. Choose Ok.
The dialog box disappears.

3. Choose OK.
The Probe Conversion Options dialog box disappears.

You are now ready to add and define the processes corresponding to the selected con-
version.

To Define the Transfer Function

The raw data is converted into velocities by means of a transfer function from a calibration
event.

1. Choose the Transfer Function button in the toolbox.
The button is copied into the data reduction sequence of the selected probe.

2. Click on the button in the sequence map.
Transfer Function dialog box opens.

3. Select the Use default check box.
- or, if you want to use another calibration event instead:
Unselect the Use defaults.
Event Load button is enabled.

4. Choose the Load button.
Select Event dialog box opens.

5. Select  the wanted calibration event.

6. Choose OK.
The dialog box disappears.
The name of the event is displayed in the event box in the Transfer Function dialog
box.

7. Choose OK.
The Transfer function dialog box disappears.
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5 Operating the System
This section demonstrates how to operate the StreamWare Basic system by way of three
sample projects:

l 1-D measurement with default setup, calibration, data acquisition and data reduction.

l 1-D measurement  with temperature correction.

l 1-D measurement with traverse.

5.1 System Startup
At this point it is assumed that you have installed the system as described in "Hardware Install-
ation" (on page 13).

Starting StreamWare Basic

This section directs you to the working platform of StreamWare Basic software.

1. Create a folder for the database and project.

2. Double click on the StreamWare Basic Icon. 

StreamWare Basic opens, and the system is now ready for operation.

Note
It recommended to have only one database with only one project in each folder. This makes it
much easier to move the project to another PC for further manipulation.

Switching on the MiniCTA Box

Note
You should not connect the power adaptor to the MiniCTA Box, before the probe is con-
nected and the decade is adjusted to proper overheat ratio.

5.2 Sample Project I
1D Measurement in a Point 

This section describes a system with one probe. The anemometer output is connected to an
input channel of the A/D device in the PC.  See "A/D Devices" (on page 202).

5.2.1 Project Description
The project demonstrates:

l Default Setup

l Probe calibration

l Data acquisition

l Data reduction and display.

It is assumed that the ambient temperature remains constant or nearly constant during the
project. If temperature variations more than a few °C are expected, or you require high



accuracy,  please refer to Sample project II, where procedures for temperature correction is
outlined.

5.2.2 Hardware list for Sample Project I

l 55P11 Probe

l 55H20 Probe Support

l 9055A1863 Probe Cable, 4-m.

l 55T30 or 54T42 MiniCTA Box.

l Cable and Connector Box for the A/D converter board.

l PC with A/D device installed.

l A fan or blower to create an air flow.

5.2.3 Physical Configuration of a Single-sensor CTA
Physical configuration covers the interconnections of the PC , MiniCTA Unit and probe. It con-
sists of the following steps:

1. Connect the Analog Output bushing on the MiniCTA Unit to the A/D device input chan-
nel no. 0 on the connector box for the A/D device with a 50 ohms BNC cable (max. 50
m).

2. Connect Probe and Support with a  4 m Cable to the Probe BNC-connector on the Min-
iCTA Unit.

3. Place the probe in front of the fan.

4. Switch power on to both systems.

5.2.4 Open StreamWare Basic
Open StreamWare Basic software by double clicking on the StreamWare Basic Icon in the Pro-
gram Manager.

You are now prompted to create a new database.

5.2.5 Create a Database
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1. Choose Database/New from the File menu.
New Database dialog box opens.

2. Select the folder that you already have created for the purpose.

3. Type in the name of your new data base, e.g. 1-wire.sdb.

4. Choose OK.

5.2.6 Create a Project
You are now prompted to create a Project. Select Yes. A New Project dialog box opens. (You
can also create a new project by selecting Project/New in the File menu).

The project will contain information about all actions that you carry out from now on.

1. Enter the name of your project and your initials in the Created by field.

2. Add your comments in the Log entry, if wanted.

3. Choose OK.

5.2.7 Define Devices
You are now prompted to select an A/D device. Say Yes and the Select A/D driver dialog box
opens. (You can also define a A/D driver by selecting the Devices, A/D drivers from the Con-
figuration menu.)



1. Select the A/D device that is installed in the PC.

2. Choose OK.

A path is now made from the project to the translation driver.

5.2.8 System Configuration
You are now prompted to configure the system. Select Yes and the System Configuration dia-
log box opens.

Now select probe, cable/support and A/D input channel.

1. Click on the Single Wire sensor probe Icon.

2. Select Probe, Support and Cable dialog box from the Probe library opens.

66



67

3. Select 55P11 Wire, 55H20 Support and a 4 m (1863 BNC/BNC) Cable in the list boxes.

4. Choose OK.

5. The Probe, Support and Cable are now added to the  map. It is by default connected
to A/D input channel 0.

6. Choose OK.

The CTA configuration is now finished and saved into the project.

You are now prompted to define the Setup.

5.2.9 Define Hardware Setup
You are now prompted to define the setup of the CTA.

Reference temperature and overheat from the probe library are displayed.

1. Select MiniCTA unit type 54T30

2. Enter  the sensor cold resistance R20 at 20 °C from the label on the probe container.



3. Click Update and the probe operating data and the corresponding dip switch settings
in the MiniCTA unit are displayed.
Note! This setting is made manually by the user via the setting of Dip switches inside
the MiniCTA unit. Wrong setting can damage the probe!

4. Click on OK and you are now prompted to carry out a velocity calibration of the probe.

5.2.10 Velocity Calibration

It is assumed that you have some calibration means, e.g. a free jet or a wind-tunnel with e.g. a
pitotstatic tube as velocity reference.

1. The Velocity Range dialog box opens.

2. Enter min. and max. velocity and number of calibration points.

3. Leave the Log distribution, as it gives the best linearization accuracy over a wide velo-
city range.

4. Select OK.  The Calibration  dialog box opens.
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1. Select Point 1. Create the velocity displayed in the Velocity field. If you obtain a dif-
ferent, but acceptable, velocity, you can enter the actual value from the keyboard.

2. Enter the temperature into the Temperature field from the keyboard.

3. Click on the Parameters Read button.

4. Click on the Voltages Read button. The probe voltage from the CTA is now read via the
A/D device.

5. Click on the Update button. The velocity, temperature and probe voltage are now
placed in the data sheet.

6. Select next point and continue until all points are done.



Curve Fit Analysis dialog.

7. Click on the Fit button. The Curve fit analysis dialog box opens. It displays the curve fit
coefficients and the linearization errors. In this project please neglect the Tem-
perature correction check box.

8. If you accept the quality of the calibration click on the OK button. The completed cal-
ibration data sheet is now displayed.
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Close and save the calibration event

1. Double-click in the Menu Control box in the upper left corner of the data sheet win-
dow. A Save event dialog box opens.

2. Type in an identification and select OK. The dialog box closes and you are prompted to
create a Conversion event on basis of the probe calibration.

3. Say Yes. A Save event dialog box opens.

4. Type in an identification and select OK. The dialog box closes and you are prompted to
make the Conversion event default. Say Yes.

A Calibration event and a Conversion/reduction event (both with the default stars) are added
to the Project Manager.

You have now a complete Default Setup with a Hardware Setup and a Conversion/Reduction
setup that can be used to acquire, linearize and reduce probe voltages into first and second
order moments (mean and standard deviation).

Linearization on Basis of Previous Calibration Data (Voltage vs. Velocity)

If you have a set of calibration data for the probe created at earlier with the same overheat
ratio and ambient temperature, you can skip the input dialog and simply enter them into the
data sheet.

1. Select the Velocity calibration window in the Setup menu.
An empty Worksheet opens with columns for Voltage, Velocity, Ambient temperature
and Ambient pressure.

2. Type in your calibration data.

3. Select the Fit command in the Edit menu or the f(x) button in the toolbar. The best
curve fit is made and presented in the Curve fir dialog box.

From here on you can proceed and create the Calibration event like explained above.

5.2.11 Run Online
You can now check the performance of the system in Online.

1. Choose Online analysis from the Run menu.
Online dialog box opens.

2. Choose the Start button.

The Data display is now updated for each acquisition until you choose Stop or leave the dialog
box.



You can display velocity instead of voltage by selecting Velocity from calibration in the "Output
as" field.

The axis on the graph can be changed and you can Zoom out by clicking in the graph with the
right mouse button. You can stop the acquisition and print the graph after Zoom out. No data
are stored during Online.

5.2.12 Run Default
You can store acquired data in a file by running Default instead of Online, see "StreamWare
Basic Guide" (on page 85), To display probe default parameters if you want information about
the parameters.

1. Choose Run default setup from the Run menu or click on the Acquire data Icon in the
Main toolbar.

2. An Acquire data to disk event dialog box appears

3. Type in the identification for the Raw data event that will be the result of the default
run.

4. Close the dialog box by choosing OK.

When finished, a Raw data record is added to the Project Manager.
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5.2.13 Load  Raw Data

Raw data are stored in a file arranged with a database structure. In order to present the data,
they have to be unpacked.

1. Point at the Raw data event in the Project Manager and click with the right mouse but-
ton and select Load. Raw Data Selection dialog box appears.

Raw Data Selection dialog.

2. Choose Load.
A data sheet with the acquired data opens.

3. Choose Close. The dialog box closes and leaves the data sheet open.



Present Data in a Graph

1. Choose Graph from the Datasheet Tools - Options Tab.

2. Right-click in the Graph and select Properties for specifying the Data Series.

3. Select  U1cal in the Data columns box.

4. Click on the Y--> button.
U1cal is now moved to the Y-arguments box.

5. Choose OK.

A Graph is now created with voltages as function of acquisition time.
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See "Graphs" (on page 123) how you can change axes, labels etc.

5.2.14 To Reduce Data

Create Reduced Data Event

1. Point at the Raw data event in the Project Manager and click with the right mouse but-
ton and select Reduce data.
A Save event dialog box opens.

2. Type in an identification and choose OK.

The Data reduction process is now carried out and a Reduced data event is added to the Pro-
ject manager.

Note
The default Conversion event  automatically will be used to convert and reduce the data.

Load Reduced Data

1. Point at the Raw data event in the Project Manager and click with the right mouse but-
ton and select Load.

Double click on the Reduced data event with the left mouse button. A Data sheet showing the
positions (0,0,0), the Umean and URMS. opens. As you have only one set of data it makes no
sense at this point to make a graph of the reduced data, as they only represent one point.



5.3 Sample Project II
1D Measurements with Temperature Correction

This project demonstrates how to incorporate temperature correction into a project. For sim-
plicity a project with only one single-sensor hot-wire probe has been configured. The pro-
cedure, however, is identical for any number of probes and for dual -and triple-sensor probes
as well.

5.3.1 Project Description
If a high absolute accuracy on mean velocity is required it is always recommended to include
temperature correction in order to avoid systematic errors from even small fluid tem-
perature variations. If not compensated for a temperature change of 1 °C gives approx-
imately 2 % error in velocity for a wire probe operated at the default overheat ratio 0.8.

Temperature correction requires that temperature is acquired together with the anem-
ometer voltage. This is done by means of a temperature probe with an analog output con-
nected to the A/D device and assigned as a probe in the System configuration. The CTA probe
and the temperature probe should be mounted close to each other in the flow, so that they
are both exposed to the same temperature.

The basic procedure in the StreamWare Basic software is:

1. Assign the temperature probe in the System configuration.

2. Choose it as temperature probe.

3. Apply temperature correction to the Data conversion/reduction event.

Prior to that the temperature must be placed in the Probe library. For details see "Probe
Library" on page 100.

5.3.2 Hardware List for Sample Project II

l 55P11 Probe

l 55H20 Probe Support

l 54T30 MiniCTA Box.

l 55P32 Thermistor Probe

l 54T40 Thermistor Amplifier

l 2 pcs. 9055A1863 Probe Cable, 4-m.

l Cables and Connector Box for the A/D converter board.

l PC with A/D device installed.

5.3.3 Adding a Temperature Probe to the Probe Library
If you are not using the 90P10 Thermistor probe, which is in the Probe library, you have to
add your own temperature probe to the library. Open the miscellaneous probes and add the
temperature probe. Remember to enter the calibration constants that converts volts to °C in
the Coefficients dialog box.
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5.3.4 System Configuration

1. Configure the system with the hot-wire probe and the temperature probe. This is
done by clicking on the Single sensor probe icon in the Configuration dialog box and
select the 55P11 from the Single-sensor probe Icon and the 90P10 probes from the
T,P… Icon, respectively.

2. Choose OK. The dialog box closes.

System Configuration dialog.

5.3.5 Selection of Temperature Probe
When you close the Configuration dialog, you are prompted to select a temperature probe.
Say Yes. Select probes dialog box opens.

1. Click Enable and select probe 2: 90P10: 1D sensor.

2. Click Ok to close the dialog box.



Select Temperature Probe dialog.

5.3.6 Hardware Setup and Velocity Calibration
Perform hardware setup and velocity calibration as described in Sample Project I. Now it is
most important to enter the proper temperature. Make both events default.

The temperature can automatically be read as a Parameter during the calibration, if the tem-
perature probe is placed in the flow next to the hot-wire probe. In this case choose Para-
meter/Setup/Temperature/A/D/ ch1 in the Calibration dialog box. Type in the linearization
(polynomial constants from the keyboard). For more details see "Running the System" (on
page 172).

Important
Select Apply temperature correction in the Curve Fit dialog box, when you have finished the
velocity calibration.

Curve Analysis dialog with Temperature Correction enabled.

When you close the Calibration data sheet you are prompted create a data Con-
version/Reduction. Say Yes to that and say Yes to the “Make the event default”. You will now
have the two events marked with default stars listed in the Project Manager
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5.3.7 Data Conversion/Reduction with Temperature Correction
It contains all necessary information for performing temperature correction, linearization and
data reduction into mean and RMS values. You need not make any further manipulations in it.
To see what it looks like:

1. Open the Default Conversion/Reduction in the project manager (right mouse button).
The Data conversion/reduction setup dialog box opens.

2. Close the dialog boxes by clicking on Cancel.

Data Conversion/Reduction Setup dialog.

5.3.8 Run Default Setup
Run the default setup as described in Sample project I.

5.3.9 Run Data Conversion and Reduction
Run the data reduction as described in Sample project I.

5.4 Sample Project III
Mapping of a Velocity Profile with Probe Traversing

5.4.1 Project Description
This project demonstrates how  to measure the velocity profile in a free jet with a single
sensor wire probe. It expands Sample Project I project with a Traverse device and a Traverse
Grid. When you run the new Default Setup, the probe is traversed across the jet, data are
acquired in each position and saved in a file. The data are then converted on basis of the
probe calibration and reduced into Umean and URMS.



5.4.2 Hardware List for Sample Project III
In addition to the hardware in Sample Project I you will need the following:

l A free Serial Comport installed in the PC.

l 41T41-D Traversing Mechanism

l 41T72 1-D Traverse Controller

5.4.3 Getting Started
Start StreamWare Basic. If you have not made any new projects in the meantime StreamWare
Basic opens Sample Project I, where you have to load the Traverse driver, which gives you
access to the Traverse controller.

5.4.4 Load Traverse Driver

Traverse Driver

1. Choose Devices from the Configuration menu.

2. Choose Traversing from the Devices sub menu.
Select Traverse Driver dialog box opens.

3. Select the Lightweight Traverse  from the driver list.
Choose Setup. Select Traverse Properties dialog box opens.

Traverse Setup

1. Choose the Setup button.
A Traverse Properties dialog box appears where you select the following:
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General Traverse Properties dialog.

General

Reset mode at current position.

Rotation channel Disabled.

Connections

Comport 2

Axis assignment:

Assign X as Axis 1. (Disable Y, Z and Rot.)

Limits and Reference

Xpos Min: 0 mm

Xpos Max: 540 mm

Speed and Calibration

Speed: 25 mm/s

Cal. Fact.: 80 pulses/min



5.4.5 Define Traverse Grid

Grid Setup dialog.

1. Choose Traverse grid from the Setup menu or click on the Traverse Icon in the Main
toolbar.

2. A Grid Setup dialog box opens.

3. Enter Start position, Increment and Number of positions.

4. Choose Generate.

5. The dialog box disappears and the 21 positions from 0 to 20 are written into the X-
column.

6. Double click in the Menu-control box.

7. A Save event dialog appears.

8. Enter an identification.

9. Choose OK.

10. The Traverse Event is now added to the event list in the Project manager.

5.4.6 Load the Traverse grid into the Default Setup
In order to move the probe the Default Setup must include the Traverse grid.

1. Choose Default Setup from the Project menu.

2. A Default Setup dialog box appears.

3. Click on the Group Schedule Icon.
A Group Schedule dialog box appears.

4. Select the Grid dependent radio button and click on the Load button.
A Load event dialog box appears with the Traverse event in the event list.

5. Select the Traverse event and choose OK.
The event identification is now written into the Group Schedule dialog box.

6. Close it by choosing OK.
You are prompted to use the traverse. Select Yes and you will be back in the Default
Setup dialog box.

82



83

7. Click on the Position Input Icon.
A Position Input Setup dialog box opens. The "Move traverse directly to position spe-
cified in grid" option is automatically selected, when you have assigned the Traverse
system.

8. Choose OK.
The dialog box disappears and the Default has been updated.

Group Schedule Setup dialog.

5.4.7 To Traverse Manually
You can include a manual traverse in the Default Setup, if you do not have an automatic Tra-
verse system. First deselect any Traverse driver that may have been loaded earlier. This is
done in the Device menu. Then select the "Display prompt to move position from keyboard"
option in the Position Input Setup dialog box. You will then be able to move the probe manu-
ally before data are acquired.

5.4.8 Set Traverse to Starting Position
Place the probe in the Traversing System and move it to the starting point of the Traverse
grid (X = 0):

1. Choose Traverse Control from the Run menu or click on the Move Traverse icon in the

toolbar:

2. A Traverse Control dialog box appears.



3. Move the probe to the starting point by means of the X-position box and the Move
command

4. button.

5. Click on the Reset button.
The position is now defined as the Traverse grid starting point.

5.4.9 Run Default Setup

1. Choose Default Setup from the Run menu or click on the Acquire data to disk Icon in
the Main toolbar.

2. An Acquire data to disk dialog box appears.

3. Type in an identification and choose OK.

Data are acquired in the first traverse position. Then the Traversing system moves the probe

to the next point and acquires data in that and so on, until all points are done.

During execution the mean velocity in each point is plotted in an Acquisition status window.

When all points are done, the Raw data event is added to the Project Manager.

In case you move the probe manually, you are prompted to move the probe before data can
be acquired.

5.4.10 Reduce Data and Present them in a Data Sheet and in a Graph
You can now convert the Raw data and reduce them to Umean and URMS in each traverse pos-
ition.

5.4.11 To Reduce the Raw Data
Data are reduced as in Sample Project I.

5.4.12 To Present the Velocity Profile in a Graph
A Graph of the velocity profile is created as in Sample Project I.

See "Graphs" (on page 123) how you can change axes, labels etc.
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6 StreamWare Basic Guide
This guide describes the StreamWare Basic software and how to use it in fluid dynamics invest-
igations.

It is assumed that you have performed the system configuration as described in "Hardware
Installation" (on page 13) and in "Configuring" (on page 127).

The computer equipment and software environment that you need in order to run
StreamWare Basic are described in "Software Installation" (on page 35).

The StreamWare Basic Guide goes through all commands as they appear in the ribbon and dia-
logs and explains all actions that can be carried out and their functional meaning.

6.1 Basics about StreamWare Basic

6.1.1 What is StreamWare Basic?
The StreamWare Basic software offers a complete user interface for controlling the MiniCTA
Boxes and the MultiChannel CTA Frames for acquiring, processing and presenting data. It
guides you through the setup of the hardware and carry out automatic velocity and dir-
ectional calibrations.

A Default Setup procedure traverses probes and acquires and reduces data. Data are presen-
ted in worksheets and can be copied to other Windows applications, like for example Excel.

A Project Manager keeps track on all actions from configuration and setup to data acquisition
and data reduction, so that you always know what has happened and when, and how the dif-
ferent actions, or processes, are interrelated.

The MiniCTA and MultiChannel CTA Systems are basically analog instruments controlled by a
PC. The analog signals from the CTA Anemometers are acquired via an A/D device in the PC.
The System has an open structure, so that it can work together with other devices via Serial
Interfaces/USB/LAN. The StreamWare Basic software can acquire data from any instrument
or transducer with analog output through the A/D device connected to the PC.

6.1.2 The Workplace
A graphical user interface (GUI) where a Ribbon is the main interface in StreamWare Basic.



The StreamWare Basic workspace.

6.1.3 Structure of the StreamWare Basic
The software is centered around 4 databases:

l Project database (or User database) containing all projects created.

l Probe Library with configuration (or factory default) setup parameters for all Dantec
standard probes.

l Device Driver Database with a number of translation drivers for external devices, A/D
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device, Traverse Systems etc.

l Analysis Library with translation drivers for external data reduction software.

The StreamWare Basic structure.

6.1.4 The Project Concept

Organization

When you work with StreamWare Basic, you always work within a project. A project is a set of
records  organized in the project  database. It contains a System configuration with inform-
ation about CTA anemometersetup and a number of events and records: calibrations, tra-



verses, acquired raw and data conversion/ reduction procedures related to that con-
figuration.

System Configuration

The System Configuration is a list of the hardware used (A/D devices, Traverses, Probes etc.)
and how they are interconnected.

Events

Events are all actions that can be carried out in a project. They are:

l Traverse Grids (probe positions)

l Probe Arrays

l Calibration Events

l Conversion/Reduction Events

Records

Data are saved as records in separate databases accessible via the project: 

l Raw Data Records

l Reduced Data Records

l MultiChannel Reduced Data Records

Raw data are saved together with information about the Conversion/Reduction.

All events and data records are time stamped and listed in the Project Manager.

Default Setup

When you have defined a System Configuration,  the Configuration default parameters are
automatically loaded from the Probe library into the project and saved as Default Setup.  The
Default Setup consists of  a  CTA anemometersetup, an iteration loop  with a data acquisition
sequence followed by a conversion/reduction procedure. You  can overwrite the Con-
figuration defaults with your own parameters. If you stick to the Configuration default plus
your own CTA anemometersetup, however, the system can be brought to operate,  acquire
data,  write them to disk or present them Online on the PC screen without any further manip-
ulations.

Project Manager

The Project Manager contains all actions carried out in the project. They are listed as time
stamped events or records with your identification attached to it. The Project Manager gives
you full overview and allows you to sort, add or delete events. It provides traceability of all
actions carried out.
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Project structure.

6.1.5 Creating a Project
When you  create a new project, you are guided through a sequence of setups, before you
can start to acquire data from your MiniCTA or MultiChannel CTAsystem.  It is recommended
to follow these guidelines as they provide the minimum set of parameters needed to run the
system.

As a minimum you must select an A/D device and define the System configuration, which
includes MiniCTA Box(s) and/or MultiChannel CTA Frame(s)and  probe(s) and their connections
to modules and A/D Channels. You will then have to perform a CTA anemometerSetup,
where the overheat is adjusted based on measurement of the probe cold resistance.

You can then overwrite the Configuration default with your own parameters, calibrate
probes, define traverse grids and data reduction procedures.  Finally you can create graphs



on basis of the acquired data, and you can export the data to other Windows applications for
further manipulation and presentation.

Defining System Configuration

System Configuration is the selection and combination of the hardware items involved in the
total system.

Before you can configure the system, the Devices (A/D devices and Traverses) must be
installed and their translation drivers loaded  from the Device Drivers Library. MiniCTA Boxes,
MultiChannel CTA Frames and Probes are then be selected and their interconnections
defined.

Loading Device Drivers

In Device Configuration you select:

l A/D Device

l Calibrator Unit

l Traverse System

from the Device Drivers Library corresponding to what is installed in your PC. You can then do
a setup of switch settings for the A/D device and  calibration factors for the Traverse.

System Configuration with A/D Channel Assignment

In System Configuration you do the following:

l Select MiniCTA Boxes and MultiChannel CTA Frame(s)

l Select Probes, Supports and Cables

l Connect probe and sensors to boxes

l Assign the output from the sensors to A/D Channels

This information becomes an inherent part of the project. Once the System configuration is
defined, and a configuration dependent event has been created, the configuration cannot be
changed without creating a new project or deleting the event.

Once you have selected a probe and assigned it to either a MiniCTA Box or MultiChannel CTA
Frame module, the overheat ratio, gain and filter settings for the CTA,  the offset, gain and fil-
ter settings for the Signal Conditioner and the probe data conversion parameters are auto-
matically transferred from the Probe Library to the  Default Setup and used as such. You can
at any time overwrite them.
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System Configuration with MiniCTA Boxes.

System Configuration with MultiChannel CTA Frame.

Hardware Setup

The Hardware Setup defines the setup of all CTA Modules in the configuration. It allows you to
define how to set up the different MiniCTA Boxes. It will then be used in the Default Setup
instead of the Configuration default from the Probe Library. When you have a Hardware
Setup, you can Run Online and Default Setup.



Online Presentation of Data

The Online display dialog.

The Online menu acquires and presents the output from the probes (with the modules in
Default Setup) on the PC-screen like on an oscilloscope. Multi-sensor probes have the signals
from all  sensors displayed simultaneously. The outputs can be displayed as voltages or as velo-
cities, provided you have performed a calibration and made it default. You can also post-pro-
cess and present the data as a Power Spectrum or an Auto-Correlation function. To get full
use of this additional information, sampling times and number of samples should be selected
carefully in the Options.

Velocity Calibration

Velocity calibration gives you the possibility to perform automatic or manual calibration of
probes by exposing them to a set of known flow velocities.StreamWare Basic supports the
StreamLine Pro Automatic Calibrator. The velocities are defined in a worksheet and are auto-
matically established by the Calibrator.  The result is a curve fit that is used as transfer function
between voltage and calibration velocity. All sensors on multi-sensor probes are calibrated
simultaneously.
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Calibration result with curve fit and linearization error distribution.

Directional Calibration

Directional calibrations can be made for X-sensor and Triple-sensor probes, if you do not want
to use the Configuration defaults for the yaw- and pitch-factors. The calibrations can be car-
ried out using the Pitch-yaw Manipulator on the StreamLine Pro Automatic Calibrator. Here
the probe is exposed to a constant velocity and positioned at different angles with respect to
the flow. In each position the yaw- (and pitch-) factor is calculated. The result is an average
yaw- (and pitch-) factor for each sensor over the angular range. These values are then used,
when calibration velocities are transformed into velocity components in the sensor- or probe
coordinate system.

Traversing

Traversing is the process of moving a probe from one position to another and is defined as a
Traverse Event. The event contains a Traverse Grid with probe positions in up to 3 dimensions
and with a probe rotation in each point. The grid is created in a worksheet. When saved it can
then be called for use in connection with a set of  acquisitions in either a Default Setup.

The traversing can be carried out automatically by means of a Traversing System via the Tra-
verse Device driver loaded during System configuration, or it can be done manually.



Defining and Running Data Conversion/Reduction

Data Conversion/Reduction Setup dialog.

The Conversion/Reduction Setup defines how the raw voltages are converted into physical
units and reduced into statistical quantities. It is made for one probe at a time and uses the
Velocity- and Directional calibration events you may have created. If no calibration events
have been made the Configuration default values from the Probe Library will be used. The
raw data will be corrected for changes in ambient temperature between calibration and
acquisition.

The velocity can be decomposed into wire- or probe coordinate system or transformed into a
laboratory coordinate system before reduction. You finally select the statistical processes that
you want to carry out, being: means, standard deviations, turbulence intensity, 2nd and 3rd

order moments.

The Conversion/Reduction Setup is saved as an event.  This event is then used either as part
of the Default Setup.

You can only run the Conversion/Reduction on selected raw data. The process is automatically
carried out using the Conversion/Reduction event assigned to the Default Setup, that was
used for the data acquisition. After reduction the results are  saved as a Reduced Data event
together with the traverse positions.
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Setting and Running Defaults

The Define Default Setup dialog.

The Default Setup is the complete set of parameters needed to run the system in a simple
data acquisition loop, including a probe traverse,  with a fixed hardware setup.

It  contains Hardware Setup, Loop iteration, Probe positioning, Data acquisition and Con-
version/Reduction procedures. The points, where data are acquired, can be defined by a Tra-
verse Grid assigned to the Default Setup.

You can always change Default Setup by applying new events to it.

When you run Default Setup, the MiniCTA modules are set up according to the default Hard-
ware event and data are acquired and written to disk. If a Traverse is assigned the probe is
moved to the next position before a new set of data is acquired. This continues until all loop
iterations (points) have been made. 

The Default Setup is not noted as an event in the Project manager, but the data that are
acquired during run Default Setup are saved and noted as a Raw data record. You have to
activate and run the Conversion/Reduction after the data acquisition has stopped in order to
create the Reduced data records.

Acquiring Data

Data are acquired  via the A/D device, whose settings are defined either in the Default Setup
used.  Data can be acquired in  infinite loops, as multiple counts or as single loop in one or
more probe positions.

During Run DefaultSetup, data are written to disk and saved as Raw data records.

During Run Online data are presented on the PC screen as on an oscilloscope and not saved.

Processing and Presenting Data Records

You have to activate and run the Conversion/Reduction yourself, after the Run Default Setup
has stopped in order to create Reduced data records.



Data start their existence as Raw data records that are placed in separate files. They are as
such not part of the project database proper. You can load raw data from one point at a time
and present them directly as voltages or converted into velocities or velocity components.

You can reduce Raw data records into a number of statistical quantities, mean, standard devi-
ations, 2nd and 3rd order moment. The Conversion/Reduction setup used will be the one you
assigned to the Default Setup or  Experiment, during which the data were acquired. The
reduced data will be saved as Reduced data records.

Reduced data records can be loaded and presented directly without further manipulation. 

The data are presented in worksheets. Here you can manipulate data, copy and paste  them
and combine them at will. They can be plotted in graphs using the  Graphics generator build
into the StreamWare Basic software.

Importing/Exporting Data

Results in the form of worksheets or graphs can be printed on any printer supported by your
Windows software. They can be exported  or copied via Clipboard  to other Windows applic-
ations for further manipulation and/or report generation.

A Global Export option can be added to the StreamWare Basic that allows you to export all
data acquired in a Default run without opening worksheets and pointing at data. Data are
then written to a file together with a header that describes all setup-, calibration- and acquis-
ition parameters for the group.

6.1.6 Advanced Topics
In addition to the features described until now, the StreamWare Basic contains a number of
advanced topics. In this way the capability of the system increases with respect to combination
with other instruments, with respect to extended processing and to running on a net
together with more PC's.

Combination with External Instruments

The StreamWare Basic software can acquire data from other instruments than the MiniCTA
Box and MultiChannel CTA Frame (Anemometers) via an A/D Channel or a digital interface,
provided its translation driver is in the Device drivers Library.

Analog input from an external instrument can be converted to physical units the same way, as
anemometer signals are, by means of a transfer function. If a set of related values of voltage
and  physical quantity is available, a transfer function can be created by means of the curve fit
procedure in the calibration worksheet.

Analysis Library

The Data reduction possibilities in StreamWare Basic is focusing on the most common reduc-
tion schemes, with main emphasis on hardware control and data acquisition.

The Analysis Library compensates for that, as you can call more data reductions from here,
like basic statistical processing, power spectra and correlations. The Analysis Library can be
expanded by adding translation  drivers.
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6.2 Files

6.2.1 Definitions
In the File menu you can create or open databases, create or open projects, access libraries
and import or export data.

6.2.2 Handling Databases
All work in StreamWare Basic is done in a project  placed in a StreamWare Basic database.  First
time you start up StreamWare Basic, you must  therefore create a new database.  After that
the software always opens the Project and shows the Project Manager  that you worked in
latest.

To Create a New  Database

1. Choose Database and New from the File menu (or via New Database). You are also
guided to this location when you follow the Guide.
New Database dialog box opens.

2. Select drive and directory.

3. Type the name of new database in the File Name box. Extension is always  .sdb. If
another extension is typed in, it will automatically be overwritten with .sdb when
saved.

4. Choose "Create".
The dialog box closes.

To Open a Database

1. Choose the Open icon from the File menu (or via the Database Tools in File/Database).
Open Database dialog box opens.

2. Select drive and directory.

3. Select the database in the File box or type in the name in the File Name box.



4. Choose "Open".
The dialog box disappears and is replaced by the  Project Manager from the last
opened project.

To Delete a Database

1. Choose Delete in the Database Tools via File/Database .
Delete Database dialog box opens.

2. Select drive and directory.

3. Select the name of the database in the File box or type in the name in the File Name
box.

4. Choose OK.
The database is deleted and the dialog box closes.

6.2.3 Handling Projects
A Project is a list of records containing full information about configurations, setup, data
acquisitions, data reductions etc. This information is time stamped and listed in a Project man-
ager.

To Create a New Project

Before you make a new project make sure that you are in the right database.

Note
It is recommended to have only one project per database per directory. In this way the data
files from different projects will not be mixed up. This makes it much easier to move a project
from one PC to another.

1. Choose the New project icon from the Home menu (Projects). New Project dialog box
opens:
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2. Enter the name of the new project.

3. Enter your name or initials.

4. Enter any comments that you want to tie to the project in the Log entry.

5. Choose OK.
The dialog box closes and the Project manager opens in the left side of the screen.
The project name is displayed to the left in the Status bar at the bottom of the screen.

To Open a Project

1. Choose Open Project at the corner of the project field (in the Home menu).
Select Project dialog box opens with a list of the projects in the actual database.

2. Select the project that you want to delete.

3. Choose OK.
You are now prompted to confirm the command.
Confirm and the dialog box closes.

6.2.4 Handling Libraries



Libraries can be accessed from the File/Libraries menu. There are three libraries with inform-
ation about probes, A/D devices and  traverse systems and external functions for data reduc-
tion and a Two-point Library with typical calibration data to be used with the Dantec Two-point
Calibrator.

Libraries are arranged as databases from which relevant parameter are loaded into a project.
New items can be added and parameters can be changed.

Probe Library

The Probe Library contains parameters for all Dantec standard probes, supports and cables. It
has an additional group, Miscellaneous, where you can place other than CTA probes, e.g. tem-
perature or pressure probes.

A Probe library always has the extension *.pdb.

The parameters in the probe library is used as Configuration  defaults for the MiniCTA Boxes
assigned to the selected probe.

Note
You can only  assign  probes from a Probe Library to a MiniCTA Box or MultiChannel CTA
Frame module.

To Open the Probe Library

Click on Libraries in the File tab and then click on Probe Library.

Probe Properties

Mark the probe you want to investigate and click on Edit in the top of the window. (or right
click on the probe and select Edit).
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General

All fields can be edited except Type, as this  indicates the number of sensors on the probe.

Details

Shows typical sensor resistance, accepted resistance variation, temperature coefficient of res-
istance. Also recommended overheat ratio at room temperature, maximum sensor tem-
perature and maximum ambient temperature are shown.

Materials and Dimensions

Lists sensor material, plating, dimension and prongs/substrates.

Bridge and Signal Conditioner

Shows the default setup of the bridge and the signal conditioner:

Bridge

Bridge ratio (1:20 (20 ohms top resistance)) and Shape (wire/film)

Servo amplifier settings

Amplifier gain, Filter setting and Cable compensation.

Probe cooling interval

The time delay that allows the probe to adapt the ambient temperature, before a resistance
measurement is performed.



Signal conditioner

Defines the Offset, Gain and Lowpass filter.

Coefficients

Linearization coefficients for each sensor

The configuration defaults are 0,1,0,0,0 in a 5th order polynomial. This means that voltages
are not converted unless you enter the actual values for the probe. Linearization can be
either polynomial or power law. If you select power law, you can enter A, B and exponent n.

Note
If you change the default linearization constants, you are advised to copy and paste the probe
into a custom probe first in order to keep the original probe library intact.

Pitch and yaw coefficients for each sensor (only for X-sensor and Triple-sensor probes).

Sensor to Probe Coordinates

Angles between each sensor and the axis in the probe coordinate system.

Velocity Reference Probes

These are pre-calibrated probes, which can be used for calibration of other probes, for
example in a wind tunnel.

l Logarithmic power law (for velocity calibration reference)

The calibration data are loaded from a file delivered together the velocity reference probe,
see "To Add a Velocity Reference Probe" (on page 105). See "Algorithms" (on page 185) for
details about linearization functions.

Probe Supports and Cables

Probe Supports

1. Select  Supports. A Probe Support dialog box opens, where you can select the wanted
support.

2. Click OK and a Probe Support Properties dialog box opens.
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Cables

1. Select  Cables. A Cable dialog box opens, where you can select the wanted cable.

2. Click OK and a Cable Properties dialog box opens.

The dialog box contains information about cable length, resistance and impedance. It also
determines the cable compensation circuit that will be used in the bridge for that cable. It is
important to leave the default configuration unchanged (e.g. 4 m cable ® 5 meter com-
pensation (=1 m probe support + 4 m probe cable).



To Edit Parameters

You can edit in the probe, support or cable  parameters, if you use the Edit command in the
Probe Library dialog box and overwrite the existing parameters.

1. Choose the Sort button.
Sort dialog box opens.

2. Select the wanted Probe, Cable or Support.

3. Choose OK.
The dialog box closes and a sorted list appears in Probe Library dialog box.

4. Select the wanted item.

5. Choose the Edit button.
Parameter dialog box opens showing default parameters.

6. Overwrite the parameters that you want to change with your own values.

7. Choose OK.
The dialog box disappears.

You are advised never to change Configuration Default Setup parameters for an original
Dantec item. Create instead a Custom probe (support or cable) by coping and pasting (can be
done within the same Library), changing its name and modifying its parameters as described
above.

To Add or Delete a Probe, Probe Support or Probe Cable

Before you can add or delete an item , you must select the type it belongs to.

1. Choose the Sort button.
Sort dialog box opens.

2. Select Probe, Cable or Support.

3. Choose OK.
The dialog box disappears, and the Add button corresponding to the selected type is
enabled.

To Add from New

1. Chose the  Add button.
Probe dialog box opens with empty parameter boxes.

2. Type in the relevant parameters.
When you add a probe remember to fill in parameters for Bridge settings, Signal
Conditioner settings and Coefficients.
If you do not have values for all parameters, you can leave these boxes empty. The
software will then automatically fill in expected defaults, before the probe is added to
the database.
When you later on carry out processes requiring defaults that you have not entered
yourself, you will be warned that the results may be wrong.

3. Choose OK.
The dialog box closes and the new item is added to the list in the Probe Library dialog
box.
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To Add by Copying and Modifying an Old Item

You can also add an item by means of the Copy and Paste commands using the right mouse
button either in the same or in another Probe Library. If the new item has parameters dif-
ferent from the one it is copied from, you can correct them using the Edit command.

To Remove an Item

1. Select the item in the list box.

2. Choose the Remove button.
The item is removed from the list.

To Add a Velocity Reference Probe

Currently only the pre-calibrated velocity-reference probe T29 is supported by the software.
Please refer to the User’s Guide for 54T29 Reference Velocity Probe publication number
9040U4061.

Older versions of this probe included a dedicated Calibration File CD, containing the calibration
file for the given probe. Newer versions include a general calibration CD containing multiple
calibration files.

Installing Calibration Files

Newer systems are delivered with only one general calibration CD. This CD includes the cal-
ibration files for all reference probes.

1. To install the calibration files, search the online Dantec Dynamics calibration server, or
place the CD into a free drive.

4. Press Install, and type in the serial number of your first reference probe.



5. Repeat this for all your 54T29 reference probes.

Legacy Systems

A dedicated Calibration File CD is delivered for every probe specified by the serial number of
the probe. To install the Calibration File place each CD one at a time into a free CD drive and
follow the auto run instruction, or manual run the setup.exe file in the root of the CD.

The calibration files will automatically find your software and install the files for the reference
probes. The calibration files will be copied from the calibration CD onto your system, in the fol-
lowing location: “..\ProgramData\Dantec Dynamics\Libraries”, corresponding to the Windows
All Users profile.

Reference Probe Properties

The calibration data for each probe can be seen in the properties for the reference probe.

To Close a Probe Library

You leave the Probe Library by:

1. Choose Close in the Probe Library dialog box.
The dialog box disappears.

It is important to note that a change in Probe Library data is saved, as soon you have typed it
in. Therefore there is no Cancel button, which can undo your changes and save the library as it
was, before you started manipulating. If you regret, you have to go back and reconstruct the
data.
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Device Library

A Device Library contains a list of translation drivers for interface devices. The application soft-
ware is delivered with a number of standard Device drivers. The Device translation drivers
are independent software programs. This means, that  you can write and add your own
drivers, if you want.

A Device Library always has the filename *.ddv.

It can contain three driver types:

A/D drivers. Filename *.adv

Traverse drivers. Filename *.tdv

"A/D Devices" on page 202

To Open a Device Library

1. Choose Device Library from the File menu.
Device Library dialog box opens, where you can see the content of the last opened lib-
rary.

2. Select driver type radio button: A/D devices, Traverse or Misc.
The drivers list  shows the drivers available in the library.

Driver Properties

Select properties to see the file name of the selected driver. A Device Record dialog box
opens:

To Add and Remove Drivers

Same procedure as with probes in Probe Libraries.

To Create New or Open Another Device Library

Same procedure as with probes in Probe Libraries.

To Copy and Paste a Driver

Same procedure as for copying and pasting in Probe Library.

To Close a Device Library

1. Choose the Close button in the Device Library dialog box.
The dialog box closes.



Note
The last closed Device library will open, when you use the Device command in a project hard-
ware configuration. 

Note
Please refer to the Programmers Toolkit for CTA for writing and integrating custom OEM
device into StreamWare Basic.

Two-Point Library

The Two-point Library contains calibration data for families of probes (miniature wire probes,
gold-plated wire probes etc.). Based on the family calibration a transfer function for a specific
probe in the family can be made from a calibration in two points only.

To Add a Probe Family

1. Choose Two-point Library from the File menu.

2. The library opens displaying the list of probe families.

3. Click on the Add button. A Select probe dialog box opens.

4. Select a probe from the family that you want to add and click OK.

5. A Two-point coefficients dialog box opens.
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7. Now click Add to enter the calibration data for the family. A Calibration point dialog
opens.

8. Enter the velocity U and the voltage E, click OK and repeat Add until all points are
added.

Important
The algorithms used to create the family transfer function require 15 calibration points,
preferably with a log-square distribution.

Analysis Library

An Analysis Library contains translation drivers for different types of data reduction. The
StreamWare Basic software is delivered with a number of standard analysis drivers. The
drivers are independent software, and you can add new analysis anytime by writing a trans-
lation driver. Analysis Libraries always have the filename *.fdb. The individual analysis drivers
all have the filename *.fdv.

To Open a Analysis Library

1. Choose Analysis Library from the File menu.
Analysis Library dialog box opens, where you can see the content of the current



library.

6.2.5 Import/Export
The Import/Export commands allow you to exchange data with other Window software applic-
ations.

To Import Data

Before you can import data they must exist as tab -or comma-separated values in a file in the
project database or in a directory with a path to it, and  you must have created and opened a
Data sheet for the data to be imported into.

1. Choose User-defined Worksheet from the Windows menu.

2. Choose Import from the File menu.
An Import From File dialog box opens.

3. Select drive and directory in the Drives and Directories list boxes, if the data file is not
in the project database, and you do not have a path to it.
Note that the dialog box opens with only  tab -and comma-separated files listed. You
can get a list  of all files by selecting All files in the List Files of Type list box.

4. Select the file  you want to import in the File Name list.

5. Choose OK.
The dialog box closes, and the Data sheet is filled out with the wanted data.

To Export Data

Before you can export data they must be present in a Data sheet.

1. Choose the Data sheet by means of the Load Event button in the Main toolbar or from
the Project Manager.

2. Select the columns you want to export.

3. Choose the Export command from the File menu.
An Export To File dialog box opens.

4. Select drive and directory, where you want the data file to be placed, in the Drives and
Directories list boxes.

5. Type in a file name in the  File Name text box.

6. Select the  file type in the Save File as Type list box.
TXT saves the data with tab separation, while CSV saves them with comma separation
(or any other list separator that you may have selected in your Windows Control
Panel).

7. Choose OK.
The dialog box disappears, and the data are exported in the selected format.

Global Export

The Global Export routine facilitates the export of raw data for processing outside the
StreamWare Basic environment.

The Global Export function is placed in the Files menu. It works as part of the StreamWare
Basic software and is called in the project from which you want to export data.
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Raw data acquired in a StreamWare Basic project are saved in a file with a database structure.
The data are saved as records in a tree-like structure in the order Group – Position – Block.
The phrase group refers to a specific hardware setup, position is the traverse position where
the probe(s) was placed during data acquisition, while block refers to the raw data being
acquired in data blocks, each one with a specific A/D device setup.

The Global Export routine allows you to unpack the data base and export all data acquired in
one group at a time and write it to an export file. The unpacking is done by selecting group,
positions, blocks and probes. In this way you can export all data in a group or only data from a
range of selected probes, positions and blocks. Data can be exported to either a binary or a
text file. The exported file will contain headers with information about hardware setup,
probes, calibrations etc. that are needed for processing outside StreamWare Basic.

Data Position Structure

In order to perform proper selection of raw data you should know that raw data are arranged
into positions in StreamWare Basic datafiles. One datafile contains one or more traverse pos-
itions.

To Start and to Select Data

1. Choose Global Export from the File menu.
Global Export dialog box opens, where you can select raw data file, group, positions,
probes and conversion level:

2. Select Raw data:
The raw data list contains all the raw data events created in the project as appears in
the Project manager. The events are described by means of data, creation time,
description and filename. Select the wanted data event from the list.

3. Select Positions:
You have the following options:

All positions

Data from all the positions in the group are exported.

Only positions

Only data from points between the selected End and Start position are exported. The range
of positions is shown in the parenthesis. If you select invalid values for groups or positions,
you are warned by a beep.

To select Probes

1. Choose the Probes command button.

Global Export (Probes) dialog box opens with a list of all the probes configured in the project.
You have three options:

Export all

Data from all probes are exported.

Export active probe

Only data from the probe that was selected in the project, when you started the procedure,
are exported.



Only probes

Data from the probes selected in the probe list are exported.

2. Choose OK.
The dialog box closes and you are back in the Global Export dialog.

To Select Conversion Level and Corrections

The conversion level defines how data are converted into physical units (m/s or °C) prior to
export and defines their precision.

Conversion Level

1. Choose the Options command button in the Global Export dialog box.

Global Export (Conversion Level) dialog box opens.Here you can choose between the fol-
lowing options:

Raw voltage (integer)
Writes the data as voltages in integer format like they were acquired without further
manipulations.

Raw voltage (float)
Same as the above, but written in float format.

Velocity/Temperature from calibration
Data are converted to velocities (or temperatures in case of a temperature probe) by
entering the raw voltages into the transfer function for the selected probe. The trans-
fer function comes from the Conversion/Reduction setup associated with the selected
group. If no Conversion/Reduction setup event has been assigned, the calibration con-
stants are taken from the Configuration defaults in the Probe Library.

Velocity in sensor coordinate system
Velocities are decomposed into the sensor coordinate system. The yaw and pitch
factors used come from the Conversion/Reduction setup associated with the selected
group. If no Directional Calibration event has been assigned the values are taken
from the Configuration defaults in the Probe Library.

Velocity in probe coordinate system
Velocities are decomposed into the probe coordinate system using the wire to probe
angles from the Probe Library.

Velocity in laboratory coordinate system
Velocities are transformed into the laboratory coordinate system using the coordin-
ate transformation applied to the Conversion/Reduction setup associated with the
selected group. If no coordinate transformation has been applied, the laboratory
coordinates will be identical with the probe coordinates.

Temperature Correction

The raw data are corrected for temperature variations in the flow prior to conversion. The cor-
rection is based temperature measurements during acquisition. This selection will only work,
if temperature correction is included in the Conversion/Reduction attached to the group.
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Integer align:

Integer align adds filling zeros in the beginning of the integer values (if integer is selected in
the conversion). This gives a more readable output in the export file as all the columns have
the same width. If not selected the integer data will be right aligned in the columns.

Decimals:

Decimals determine the number of decimals with which the float values are presented in the
export file. The maximum number of decimals are 7.

Note
Conversions into velocity in sensor-, probe- and laboratory coordinate systems can only be
chosen for X-sensor probes and Triple-sensor probes. In other cases they are grayed out.
The conversion levels are the same for all probes selected. If you have selected a tem-
perature probe together with velocity probes, only conversion into velocity/temperature
from calibration is possible.

To Close the Conversion Dialog and Export the Selected Data

1. Choose OK in the Global Export dialog.

The Export File As dialog box opens. It asks for the exported filename, directory location and
export filter to be used. By default all text formatted export files have the extension 'txt' and
all the binary formatted export files have the extension 'bin'.

2. Enter filename.
Type in the wanted filename.

3. Select drive and directory. 

4. Select file format (Filter).
Choose one of the following options from the Save File as Type list:
Formatted Text (Space delimited)
Text (Tab delimited)
CSV (Comma delimited)
Binary Datafile (StreamWare Basic)

5. Choose OK.

The export starts. It is illustrated with a progress bar showing the path to the export file (note
the location of the exported file), the group and position currently exported. After successful
export the export dialog will close and return to the previous location in StreamWare Basic.

For a full description of the Global Export function and how data are arranged in the exported
file see "Global Export" on page 208.

6.2.6 Print
If you have connected and installed a printer, you can print the content of an active window,
for example Data sheets and Graphs.

1. Make sure the wanted window is displayed.

2. Choose print from the File menu.
The Print dialog box disappears.



3. Select the options that you want to use.

4. Choose OK.
- or -

5. Choose the Print button in the File Tab.
A dialog box appears informing  you that the window content is being printed.

6.2.7 Exit
You can leave StreamWare Basic while it is running in three ways:

1. Choose Exit from the File menu.
- or -

2. Choose Close from the Control menu.
- or -

3. Double-click the Control-menu box.

The software closes and returns you to Windows. All changes that you have made since you
last closed StreamWare Basic have been saved while you made them. You will therefore not
be prompted to save any files before the application closes.

6.3 The Home Tab

6.3.1 Definitions

The Home menu allows you to edit and comment events.You can also create a new project in
the database and edit project information. In the Windows group you arrange your desktop
that fits you. Some commands are duplicated and can be reached by selecting e.g. an event
and "right-click" on the mouse.

6.3.2 Clipboard Group - To Copy/Paste/Cut Events in the Project manager

Hardware Setup, traverse grids, velocity and directional calibrations can be copied and pasted
into another project. All other events are configuration specific and cannot be moved to
another project.

1. Select the event in the Project manager/Data base

2. Choose Copy data from the Home tab/Clipboard or via a right-click with the event
selected.
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3. Open the project, where you want to place the events and Choose Paste or click on
the Paste button in the main toolbar.

6.3.3 Events Group

Load Event

Mark the event you want to load in the project manger and click on the Load Event button in
the Events group. You can also double-click on the event to open the data sheet.

Rename Events

The event identification may be changed at any time in a Project.

Select the event and choose Rename in the Events group. You can also click on the event in
the Project manager with the right mouse button and choose Rename. A Rename dialog box
opens, where you can type in the new name.

To Delete an Event

1. Select the event(s) in the database (to select several events press down "ctrl" and
mark the events with right-click on the mouse).

2. Choose Delete from the Home tab/Events (or right-click and select Delete).
Confirm Event Deletion dialog box opens.

3. Choose the Yes button.
The first selected event is removed from the event list.
If there are more events to delete you are promoted once more.

- or, if you want to delete all events with one keystroke:

Choose the Yes to All button.

4. Dialog box closes.

5. All selected events are removed from the event list.

6. Here you can select records belonging either to specific probes, to specific events or
to a combination of both.

6.3.4 Projects Group



Create a new project within the Database, switch between created projects and read/add pro-
ject information.

6.3.5 Windows Group

With the Show/Hide button you can select which windows you want to have open in your work-
place. You can arrange the open windows as you please.

6.3.6 Editing Data in Data sheets
Data appears in cells in Data sheets, where each column  represents a variable.

All types of data, independent of event type and conversion level, are edited in the same way.

To Copy Data

1. Select the wanted data in rows or columns.

2. Choose Copy data from the Clipboard group or via a right-click on the mouse .

To Cut Data

1. Select the wanted data.

2. Choose the Cut button in the Clipboard group or via a right-click on the mouse. The
data are removed from the data sheet and placed in the Clipboard.

To Paste Data

1. Point at the cells, where data have to be pasted. This can be in the same or in another
Data sheet  window.

Choose the Paste button in the Clipboard group or choose Paste via a right-click on the
mouse. The new data appear in the selected cells.

To Insert between Cells

1. Select the insertion point.

Choose Insert via a right-click on the mouse. The cells are now shifted down.

Note
that you cannot insert between columns. If so, you would have to introduce a new variable.
This is not allowed, as the setup structure would then be violated.

To Delete Data

1. Select the data to be deleted.
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2. Choose Delete from the Events group or via a right-click on the mouse.
The cell contents are now deleted. The cells remain  active and new data can be filled
in.

To  Change the Content of a Cell

You can change the content of a cell in a calibration event and in a traverse grid.

Note
You cannot overwrite data in a database with raw or reduced data.

1. Select the cell by clicking in it.

2. Type in the new value.

3. Choose Carriage return, click in another cell or use the up/down arrows.
The cell is now updated. Its previous content can be restored by choosing Undo from
the Clipboard group.

To  Change the Content of a Cell Containing Date or Time

If the cell contains a date or a time, as in Data sheets with reduced data,  you can use the fol-
lowing shortcuts when typing new dates and times:

Date:If you type 20, the cell is updated with present year, e.g. 2011 (valid  1993 -
2079)

Time:If you type 11, the cell is updated with 11:00:00

If you type 11:37, the cell is updated with 11:37:00

The cells assumes AM, if you do not type PM.

You can use any separator. The date and time will appear as you have formatted them in the
Windows Control Panel.

To Close Datasheets

1. If the windows are arranged "cascade" -click on the "Close" [X] box in the top right
corner of the window. If the windows are "maximized" you click on the "Close Window"
[X] in the top right corner of the StreamWare Basicdesktop.

2. Save Event dialog box opens, which prompts you for a new Event Identification.

If  you accept, the event is now added to the event list in the Project Manager. The original
event, that formed basis for the editing, remains unchanged.

Note
You can only get rid of the original event by deleting it.

6.4 The Project manager and the Home Tab

6.4.1  Project Manager
The project manger keeps track of all Events created in the project: Calibration events, and
Conversion Setup. Acquired Raw data and Reduced data are also stored in chronological
order.



The Project manager window containing all the activities in the project.

6.4.2 The Home Tab - commands for the Project manger
The Buttons in the Events group in the Home Tab allows you to load the content of a database
(raw data, reduced data, traverse grids..) in the project manager. You can filter the events to
arrange the content for a better overview.

To Filter Events

The Filter event command allows you to display only a specific type of events in the Project
manager or to display events belonging to a specific probe, if more probes are assigned, or to
display a combination of both.

Click on the Filter button in the Events group/ Home tab or make a right-click with the mouse
on any event in the project manager and select Filter.

Database Filter dialog box opens.

Here you can select records belonging either to specific probes, to specific events or to a com-
bination of both. If you de-select any records this will be indicated at the header field of the
project manager -"Filter Applied".
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To Find References

This command allows you to find the events related to a specific event, for example the raw
data and the conversion/reduction that form basis for a reduced data event.

Select the event of interest in the Project manager.

Click on the Reference button in the Events group/ Home tab or make a right-click with the
mouse on the selected event in the project manager and select Reference.

The related events are listed in the Project manager.

To Refresh

This command recreates the full Project manager.

Click on the Refresh button in the Events group/ Home tab or make a right-click with the
mouse on the selected Filter and mark the box Select all.

All events are listed in the Project manager.

Project Info and Log

This command gives access to the Project log and to statistical information about the events.

Click on the Project information button in the Projects group/ Home tab.

A Project properties dialog box opens displaying the contents of the log. You can make log
entries at any time.



Select Project Information to get a list of event statistics:

To Load Raw Data

Raw data are placed in data blocks, each block representing one acquisition made during an
iteration in a group sequence.

As you can load only one probe, one group, one point and one block at a time you must make
a selection  prior to loading.

1. Double click on the record in the Project Manager.
(Or Click on the Load Event button in the Events group/ Home tab.)
Raw Data Selection dialog box opens.
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To Select Data

Select the Group, Point (Iteration) and Data block.

Note
The group selection is blanked, if data are acquired from Run Default , as there is only one
group in this mode.

To Select Conversion Level and Temperature Correction

Data can be loaded as voltages or velocities (if CTA data) with or without temperature cor-
rection.

1. Choose the Option button.
Conversion level dialog box opens. Data acquired in Default Setup always uses the
default Conversion.

Voltage only:

The Raw data are loaded as voltages.

Velocity from calibration:

The velocities are calculated using the transfer function from the assigned Conversion.

Velocity in sensor coordinates:

The calibration velocities are decomposed into the sensor coordinate system. They are cal-
culated using the transfer function and the Yaw and Pitch coefficients defined in the assigned



Conversion.

Velocity in probe coordinates:

The sensor velocities are decomposed into the probe coordinate system. They are calculated
on basis of the wire angles from the Probe Library.

Velocity in laboratory coordinates:

The probe coordinate velocities are transformed into the laboratory coordinate system as
defined in the assigned Conversion.

For details see "Setting Up the System" (on page 138).

2. Select OK.
The dialog box closes and you are back in the Raw Data Selection dialog box.

3. Select Load. 
A Data sheet with the data in converted form opens behind the dialog box.
You can now select a new data block and repeat the loading until all  data are loaded.

4. Close the Raw Data Selection box.
You now have a one or more Data sheets with the selected data.

Open data in Graph

When this option is checked both the datasheet and the corresponding graph will be opened.

To Load Reduced Data Events

The term Reduced data covers a file with a list of the Conversion/ Reduction events that are
assigned to each group in a Default Setup. The file does not contain any reduced data as such.
When you select Reduced data, you in fact point at the raw data via pointing at a group. They
are then reduced in accordance with the Conversion/ Reduction assigned to the group,
before they are loaded.

Datasheet Tools - To View and Format Datasheets

The Datasheet Tools including the Formatting Tab is only shown when you have opene-
d/loaded an Event Data sheet.In the Formatting tab you can e.g. choose the font type and
size, freely change the columns width and font size with the zoom bar. Rows can be inserted
or deleted if desired.

Data sheet Tools for Formatting your data sheet.

To Create Custom Data Sheets (Setup Tab)

Dataheets commands in the Setup Tab
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Click on the Custom Data Sheet button in the Setup Tab.

A Data Series dialog box opens, where you can select start and stop value, number of steps
and distribution.

The distribution may be selected with a view to the application. The Log distribution may be
used for calibration points, as they give a more points in the lower part of the range, where
hot-wire transfer functions change most rapidly. This is less pronounced for the Log-Square
distribution, as can be seen in the below example:

To Adjust the Column Width

Use the Zoom feature in the Formatting tab (Datasheet Tools) to customize the column width,
the font size is automatically adopted to fit the width.

6.5 Graphs
The Datasheet Tools including the Option Tab is only shown when you have opened/loaded an
Event Data sheet.

Each data sheet can have one graph attached to it showing up to five plots of data as function
of the same independent variable, all from the same Data sheet.



Graphs cannot be saved as independent events, but is saved together with the Data sheet
that it belongs to. This means that you can only work with graphs in connection with Data
sheet windows.

To Show a Graph

Opened/loaded an Event Data sheet that you want to produce a graph from.Click on the
Graph button in the Option tab (under Datasheet Tools).

To Select Data

Up to 5 sets of data , Y-arguments, can be plotted as function of one data set, X-argument.

Right-click in the Plotting area and select Data Series

A Graph properties dialog box opens.
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X-argument:

Select the X-argument from the Data columns list ( same as in the data sheet).

Y-argument(s):

Select Y-argument(s) in the Data columns list.

6.5.1 Customize the Graph
When you have opened a Graph a new header -Graph Tools including to Tabs appears in the
Ribbon bar. In the Formatting Tab you find useful commands to customize the graph.

You can also double click in the plotting are to reach other commands to customize the graph.



To Define Axes

1. Right click in the plotting area - select Data series and Graph Properties dialog box
opens. Select the axis you want to define. (Some tool are also found in the Axes group
in the Formatting tab.)

Grid:

Select the grid type in the Formatting tab

Tick marks:

Select number of Tick marks for Major and Minor Grids on  X-axis and on Y-axis.

Tick Labels:

Font for Label or Axes is changed by choosing Fonts in the Formatting tab.By scrolling in the
font list the graph is updated online.

Scaling of Axis:

Select  between  Linear/ Logarithmic  scales and between Auto scaling/Manual scaling.

Axis endpoint:

Type in values for Left  and Right endpoints, respectively.

Note that the X and Y-axis are edited separately.

2. Choose OK.
The dialog box disappears, and grid, axis and labels are drawn in accordance with the
selections.
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To Add Titles

Right click in the plotting area - select Data series and Graph Properties dialog box opens.
Select Titles. In the dialog you can now add a graph title and titles for the axes.

Graph Layout Options

You can edit the graph layout with respect size, fonts and colors with the tools in the For-
matting Tab.

6.6 Configuring

6.6.1 Definitions
Configuration covers the physical layout of the MiniCTA Systems, the A/D device and Traverse
systems employed.

System Configuration: Defines Probes, MiniCTA Boxes, MultiChannel CTA Frames, A/D input
channel connections (assignments) and if employed  External probes and their assignments.

l Devices: Defines  A/D devices and Traversing Systems

l Save Preferences: Saves the screen setup (toolbars etc.) for next start up.

l Local variables: Defines one or more A/D input channel(s) to acquired and saved as a
mean value together with acquired raw data.

l Select current probe: Select one probe for Online display, data reduction etc.

It is important to note that the project cannot be modified with respect to hardware con-
figuration, once an event that relates to the configuration, has been saved.

System Configuration

System Configuration involves the complete selection and connection of Probes, MiniCTA
Boxes, MultiChannel CTA Frames, Comports and  A/D input channels. It contains the following
actions:

l Selecting probes, supports and cables from the Probe library.

l Assigning  A/D Channels to the CTA outputs.

l Adding temperature probe, if temperature correction is required.

Note
An A/D device must have been selected and configured before a System configuration can be
created.

Before you define the System Configuration, it is also recommended that you establish  the
physical setup, i.e. mount the probes, connect them to the MiniCTA’s and make the con-
nection between their outputs and the A/D device inputs.



To Open the System Configuration Menu

1. Click on the Probe button in the toolbar or choose System configuration in the Con-
figuration menu.

System Configuration dialog opens. It contains a Configuration map and a  toolbox with icons
for probes and A/D Channel assignment.

To Select MiniCTA Box

MiniCTA Boxes cannot be selected separately. The MiniCTA Box is automatically added to the
configuration, when a probe is selected.
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To Select MultiChannel CTA Frames

1. Choose the Frame button in the toolbox. MultiChannel CTA Frames dialog box opens.

2. Select the actual frame. A frame with 6 or 8 CTA Modules are placed in the Con-
figuration map.



To Select a CTA Probe, Support and Cable

1. Choose the Probe button in the toolbox that corresponds to the actual probe type.
Probes dialog box opens.

2. Select the Probe Type, Next the Support Type and Next the Cable Type in the list
boxes. Choose Properties, if you want to see the technical data for the selected Types.
For further details about the data see "Files" (on page 97).

3. Choose OK.
The selected Probe, Support and Cable(s) are now placed in the Configuration map.
The outputs from the CTA Modules are by default connected to the first free A/D
input channels.

If  you want to use a non-standard probe, it must be added to the Probe Library, before you
perform the System Configuration. The same is the case for other supports and cables. For
details see "Handling Databases" (on page 97).

To Assign A/D Channels to CTA Anemometers

If the actual A/D to probe assignment differs from the default map, you can rearrange it.

1. Select the probe in the map by clicking with the left mouse button close to it.

2. Choose the Probe to A/D Channel Assignment button in the toolbox.
A Probe to A/D Channel Assignment dialog box opens.
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3. Select the actual A/D Channel number(s)  for Channel E-1 (E-2 and E-3).
Free channels are colored light blue, while occupied channels are red.

4. Choose OK.
The dialog box disappears.

Select next probe, and continue until all probes signals are properly assigned.

To Select Temperature Probe (only with 54N81 MultiChannel CTA Frame or with 54T40
Temperature Amplifier)

If you want to have one temperature sample for each CTA probe voltage sample for tem-
perature correction purposes, you must add a probe for that purpose and select it as Tem-
perature probe.

1.    Choose the Misc. probe button in the toolbox. The probe is attached to A/D input
channel no 6 by default (this corresponds to its fixed placement in the 54N81 MultiChannel
CTA Frame).

Note
Temperature correction requires that the temperature probe in the configuration is assigned
for this purpose. This is done by the Select temperature probe command in the System con-
figuration menu.

To Select Velocity Reference Probe (only with 54N81 MultiChannel CTA)

Choose the U,ref probe button   in the toolbox. The probe is attached to A/D input chan-
nel no 7 by default (this corresponds to its fixed placement in the 54N81 MultiChannel CTA
Frame).



To Delete Items in the Configurations Map

1. Select the wanted item in the Configuration map.
You do that by clicking  to the left of the item button in the map.

2. Choose the Delete command button.
The item now disappears from the map.

To Leave the System Configuration

1. Choose OK in the System Configuration dialog box.
The dialog box disappears.

The defined configuration now becomes an inherent part of the project. It will not be listed in
the project Manager.

Note
You can change the CTA configuration as long as you have not saved an event, that relates to 
the hardware configuration. After that no changes are possible any more, unless you delete
the events first.

6.6.2 Defining Devices

To Select an A/D Device

1. Choose Configuration/Devices/A/D drivers.

2. Select A/D Driver dialog box opens with a list of the supported A/D drivers.

3. Select the driver for the actual board.

To Change A/D Device Switch Setup

You can check the A/D device Settings by choosing the Setup button and change them if
needed.

4. Choose OK.

132



133

The A/D Driver is now applied as part of the project hardware configuration.

To Select and Setup a Traverse

1. Choose Configuration/Devices/Traverse.
Select Traverse Driver  dialog box opens with a list of traverse drivers.

2. Select the driver for to the Traverse System attached to the PC.

Traverse Setup

3. Choose the Setup button and define the following setup parameters:

Note
The following parameters are valid for the Dantec Lightweight traverse. 



General

In the present example the probe is traversed without being rotated. The Rotation channel is
therefore disabled.

Connections

Here the serial COM port to the traverse controller is specified. If using a USB to serial con-
nection the COM port number can be high. Please find the COM port number in the Windows
Device Manager.

Note
The ISEL iMC-S8 Traverse Controller requires a baud rate of 19200.

Note
The use of a Traverse requires an additional comport. In the present example COM1 has been
selected. It is important to check that there is no interrupt conflicts between the boards in the
PC.
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Axis assignment

The axis assignment defines which axis are used on the traverse controller. It is very import-
ant that only the axis in used and connected in enabled. This means that if you e.g. have a 2D
traverse you must disable the Z and the A axis for it to work correctly.

Speed and Calibration (Lightweight Traverse)

Thee calibration constant of the traverse defines how long the traverse moves pr. step. The
calibration factor value can often be read on the motor or axis.

The speed of the movements depends on the traverse controller and the load on the axes.

The ISEL iMC-S8 Traverse Controller supports acceleration ramps. The acceleration rate can
be specified as pulses/s2.

Limits and References

You can define software limits for the traverse movements. when specifying a range the axis
movement is restricted within that range. This can be used a s safety precautions.

4. Choose OK to finish the setup. You are now back in the Select Traverse Driver dialog.
Choose OK. The Traverse driver is now  part of the project hardware configuration.

Traverse Setup with Rotation



Select “Use extra controller” in Traverse Properties.

This requires an additional serial COM port for the Rotating Unit, as the Lightweight Controller
only supports 3 axis.

Important
If you change setup parameters specific to an A/D device or a Traverse, like for example base
address or single ended/differential, it will influence the setup of earlier projects using that
device. The reason is that these parameters are written into the device driver belonging to
the board and shared by all projects. If you return to an old project after having changed
board specific parameters remember to re-establish the original setup.

6.6.3 Save Preferences
If you want a window to maintain the toolbar selection, you have made with the Show/Hide
option, then choose the Save preferences from the Options menu, before you close the win-
dow. Next time the window opens it will be with the previously made selection.
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6.6.4 Selecting Current Probe
When you are going to run Online analysis, Velocity calibrations or Directional calibrations, you
must select the wanted probe first:

1. Choose Select current probe from the Ribbon menu.
Select Current Probe drop down box opens with a list of probes defined in the hard-
ware configuration.

2. Select the wanted probe.

The probe name and connection is shown in the probe drop down list.

6.6.5 Selecting Temperature Probe
If you want to carry out an analytical temperature correction of  the velocity data, you must
define a temperature probe to provide the necessary temperature information.

1. Choose Select temp. probe from the Configuration menu.
Select Probes dialog box opens with a list of possible temperature probes.

2. Select Enable in the Temperature probe field.

3. Select the probe that you want to use.

4. Choose OK.
The dialog box disappears.

See "Sample Project III Mapping of a Velocity Profile with Probe Traversing" (on page 79) for
more details.



6.7 Setting Up the System

6.7.1 Definitions
A complete Setup includes the following:

l Default Setup: Defines CTA reference temperature and overheat ratio. Also defines
probe traverse, data acquisition and data reduction schemes.

l Velocity Calibration: Defines the velocity transfer function of a probe through cal-
ibration in many points.

l Two-Point calibration: Defines the velocity transfer function of a probe through cal-
ibration in two points.

l Traverse Grid: Defines traverse positions.

l Probe Array: Defines the geometry of a probe array.

l Data Conversion/Reduction: Defines how raw data are converted (linearised) and
reduced to statistical quantities.

In addition the Setup menu includes:

l Traverse control: Gives access to move the Traverse equipment.

6.7.2 Define Default Setup

Definitions

With the Default Setup you can carry out measurements followed by data reductions.

The Default Setup contains 5 fixed processes that are carried out, when you run the Default
Setup. They are:

l Hardware Setup

l Traverse

l Data Acquisition

l Scheduling Setup

l Data Reduction

With the Default Setup you can perform a hardware setup, traverse a probe, acquire data in
each point, repeat the traverse and acquisition in a loop defined by the Scheduling Setup and
reduce the acquired data afterwards.

Each process is defined by means default parameters. You can replace the configuration
defaults from the Probe Library with you own choice of parameters or events and thus create
your own user Default Setup.  When you run Default Setup, the data conversion/reduction
are those marked with Bold in the Project manager.
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Default Setup is not listed as an event of its own in the Project manager. Data acquired with a
Default Setup, however, are saved as events as Raw data records.

To Open Default Setup

1. Choose the Default button in the main toolbar or choose Default Setup from the Pro-
ject menu.

Default Setup dialog box opens with a map with the processes in the Default Setup group. It
contains buttons for Hardware Setup, Position input setup, A/D conversion setup,  Scheduling
Setup  and Data reduction.

To Define CTA Reference Temperature and Overheat Ratio

The reference temperature Tref is the temperature at which the probe cold resistance
Rsensor is measured. Tref has to be defined together with the overheat ratio a in order carry
out accurate calibrations and temperature correction, if need be. Instead of measuring the
cold directly you can use the information from the label on the probe container and set the
decade in the CTA bridge accordingly:

Rdecade = ((1+a)·Rsensor+Rleads+Rsupport+Rcable)·Bridge ratio

In this case the reference temperature will be 20 °C.

First time you perform a Hardware Setup, the overheat ratio and the support, cable and leads
resistance are Configuration defaults taken from the Probe Library.

1. Click on the MiniCTA Box icon in the Default Setup dialog box.
Hardware Setup dialog box opens.



Depending on the MiniCTA selection two DIP switch setting will apear. For more information
please refer to the MiniCTA 54T30 Installation and User's Guide and the MiniCTA 54T42 Install-
ation and User's Guide.

2. Select the MiniCTA type 54T30 or 54T42.

3. Select the probe (and wire) number.

4. Insert the reference temperature at which the sensor cold resistance is measured.

5. Insert the sensor cold resistance in the R20 field.
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6. You can now choose fixed overheat ratio and adjust the decade switch settings accord-
ingly, or you can choose fixed decade resistance and accept the resulting overheat
ratio.

7. Fixed overheat ratio:
Enter the wanted overheat ratio.
Click on Update. The probe total resistance, decade resistance (bridge ratio 1:20) and
wire operating temperature are now calculated and displayed. The dip-switch settings
(SW1 and SW2 for 54T30) (SW1, SW2 and SW3 for 54T42) of the MiniCTA are data are
displayed. Note! This setting is made manually by the user via the setting of Dip
switches inside the MiniCTA box. Wrong setting can damage the probe!

Fixed decade resistance:
Enter the wanted decade resistance.
Click on Update. The overheat ratio and the wire operating temperature are now cal-
culated and displayed.

8. Continue with next probe.

9. Choose OK. The dialog box disappears and you are back in the Default Setup dialog.

Note
Reference temperature is only needed for CTA probes.

Position Input Setup

The Position Input Setup defines, how the probe is moved, before the next sequence is
executed.

1. Choose the Position Input button  in the sequence map.
Position Input dialog box opens.
Select one of the following options by means of the check boxes:

Do Nothing

The probe will stay fixed, and data acquisition will be performed immediately after start of the
group iteration.

Move traverse directly to position specified in grid

The probe is moved automatically in accordance with the selected Traverse grid. 



Display prompt to move traverse manually

The grid position is shown in a prompt. You must then move the probe manually and respond
to the prompt.

Display prompt to input position from keyboard

This option is always available. Before data acquisition is carried out you will be prompted to
enter a probe position.

Data Acquisition (A/D Device Setup)

Here you define the A/D device setup to be used for data acquisition in a loop iteration. You
can accept or overwrite the defaults for sampling frequency, number of samples, gain, clock
and trigger.

1. Choose the A/D button in the sequence map.
A/D Setup dialog box opens with the last defined settings.
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Sampling frequency and Number of samples

2. Select the sampling frequency by means of the up/down arrows in the Sampling fre-
quency select box.

3. Select the number of samples by means of the up/down arrows in the Number of
samples select box.

Note
The sampling frequency is shared by all active channels on the A/D device. This means, that if
you have e.g. a Triple-sensor probe, each wire will be sampled with 1/3 of the selected fre-
quency.

You can only define sampling frequency, when the sampling is triggered by the software
(internal trigger).

Gain

Select the gain by means of the high 5 V or normal 10 V radio buttons. It is recommended to
leave the gain on its default value.

Data storage

In Default Setup the acquired data will always be written to file and noted as raw data records
in the project manager..

Trigger

Select the trigger to be used for starting the acquisition by choosing one of the following:

Internal trigger

Select the Internal radio button, if you want the acquisition to start as defined by the software
in the Scheduling Setup.

External trigger

Select the External radio button, if you want to use an external voltage signal to start the data
acquisition.

The Options button is enabled.

1. Choose the Options button.
External Trigger Options dialog box opens.



2. Select the trigger level in the Trigger level select box.

Scheduling Setup

In Scheduling Setup you can define the number of iterations, i.e. the number of times the pro-
cesses in the group are repeated, the interval between iterations, and when the group iter-
ation starts.

You can also make the iteration dependent on a Traverse grid, so that a traverse position is
attached to each iteration.

It is used in Default Setup.

1. Choose the Group schedule button in the sequence map.
Group Schedule Setup dialog box opens.
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You can select the following options:

Number of iterations

Indefinite: The iteration is repeated infinitely.

Single loop: Only one iteration is carried out.

Multiple counts: Enter the number of iterations in the text field.

Grid dependent

The iterations are related to a traverse grid. Select the Traverse event by means of the Load
button.

Interval

In days, In hours, In minutes, In seconds: The wanted interval is entered into the text fields.

Start

Immediately: The iteration starts as soon as the Hardware Setup  assigned to the group has
been established.

Start on Date/time: Enter the wanted date/time in the text field. When the dialog box opens,
the actual date/time is displayed.

2. Choose OK. The dialog box disappears.

Data Reduction

The Data reduction defines how the raw data are reduced into statistical quantities.

1. Choose the Data Reduction button in the sequence map.
Data Reduction dialog box opens, where Use default setup or Event can be selected.



2. Select the Use default setup.
- or if you want to use your another setup:
Unselect the Use default setup check box.
A Load Event dialog box opens

3. Select the event.

4. Choose OK.
The dialog box closes.

5. Choose OK.
The dialog box closes. Data will now be converted and reduced in accordance with the
Data Reduction selected.

To Change Default Setup

1. Select the wanted Setup event in the Project manager, click on it with the right mouse
button and choose Set as default.

For details see "Define Default Setup" (on page 138).
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To Leave the Default Setup

When default parameters for the processes selected have been redefined, the Default Setup
is left by choosing OK. The dialog box closes, and the factory defaults are now overwritten
with the new user defaults in the project database.

Note
The Default Setup is not saved as an event. 

6.7.3 Calibration in General

Definitions

When you calibrate a probe, you create a dependency between the probe voltage and the
velocity at a certain reference condition (temperature and pressure). The calibration software
reads velocities and voltages and performs a curve fit through the calibration points. The fit
forms basis for the transfer function used to convert probe voltages into velocities.

The calibration procedure in the StreamWare Basic software is primarily designed for CTA
probes, but you can establish transfer functions for other than CTA probes with the curve fit
function in the calibration sheet.

The StreamWare Basic software allows you to perform calibration of one probe or more
probes at a time and accepts probes with 1, 2 or 3 sensors.

Selecting Calibration Equipment

Two-Point calibrator

This represents the easiest and fastest way to calibrate a single standard wire probe. The
Dantec Two-Point calibrator type 55H02 establishes two known velocities. The transfer func-
tion is then created on the basis of the probe voltages in these two points in combination with
a “family” transfer function for the probe type in question.

Wind tunnel with velocity reference

You can use any laminar air flow equipped with a velocity reference as for example the 54T29
Velocity reference probe (only in connection with the 54N81 MultiChannel CTA) or a Pitot tube
connected to a micro manometer with or without electrical output. Or you can simply enter
the velocity via the keyboard. This requires a suitable number of calibration points, e.g. 10 or
more.

A wind tunnel also allows MultiChannel Calibration, where more probes are calibrated sim-
ultaneously.

Orientation of the Probe during Calibration

Place the probe with the X-axis of the probe coordinate system in the flow direction. The
probe coordinate system is defined in "Probe Coordinates" (on page 197).

Selecting Probe

The probe to be calibrated is selected in the Probe list in the main toolbar. This must be done,
before you start the calibration procedure.

6.7.4 Two-Point Velocity Calibration
Probes belonging a family in the Two-point Library Calibrations can be calibrated on the basis
of two points only. This is done by means of the Dantec Two-point Calibrator, which is a free jet

http://en.wikipedia.org/wiki/Special:Search?search=Pitot_tube


device. It has two fixed velocity settings: approximately 1.5 m/s and 50 m/s. When the baro-
metric pressure and the temperature in the stagnation chamber are known, the actual velo-
cities are calculated in StreamWare Basic. The family transfer function is then modified, so that
it matches the probe voltages acquired at the two velocities. The modified transfer function
can then be saved as a calibration event and used for data conversion.

Installing the Two-Point Calibrator

Connect the calibrator to the air supply line, preferably with a proper oil separator and filter in
front. Mount the probe with the prongs parallel to the jet axis with the wire flush with the
upper surface of the nozzle. Set the handle to low. The stagnation chamber temperature can
be measured via the thermistor permanently mounted in the chamber. It is accessible via the
BNC connector marked “Temperature”.

To Run the Two-Point Calibration

Running the two-point calibrator requires measurement of the air temperature in the stag-
nation chamber and of the barometric pressure. An ohm-meter is used to measure the res-
istance of the thermistor in the stagnation chamber, while a barometer is used to measure
the ambient pressure, which is very close to the static pressure in the jet.

1. Choose Two-point calibration in the Setup menu.

2. The Two-point calibration dialog box opens.
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If it is the first time that the calibrator is used with your version of StreamWare Basic, you
must enter the Calibrator constants now.

3. Click on the Calibrator button. The Calibrator info. dialog box opens.

4. Enter the serial number and the values for the low and high velocity from the cal-
ibrator documentation.

Note
The calibrator info only needs to be entered once, as the constants will be saved as global vari-
ables in StreamWare Basic and used for all future calibrations.

Enter probe model

1. Select the probe model to be calibrated. The family calibration points from the Two-
Point Library will now be used as basis for the transfer function.

Enter calibration points

1. Set the handle bar on the calibrator in position ‘LOW’.

2. Click on the Read button in the ‘Voltage, low” field.

3. You are now prompted to wait until the flow has stabilized.

4. Click OK and the probe voltage is acquired and displayed. At the same time the first
modification of the family transfer function is performed based on the low point alone



and displayed. Note that the 15 family calibration points from the Two-point library is
also modified and displayed.

5. Set the bar handle bar in position ‘HIGH’.

6. Click on the Read button in the ‘Voltage, high” field.

7. You are now prompted to wait until the flow has stabilized.

8. Click OK and the probe voltage is acquired and displayed. The final transfer function
based on both points is calculated and displayed. Note that the two measured points
are indicated with red symbols. The remaining points are all modified family calibration
points from the Two-point library.

Error Analysis and Curve Fitting Options

The curve fitting errors, which represents the difference between the

transfer function and the modified family calibration points, may now be analyzed using the Fit
button. From here you can follow the outline in "Curve Fit Setup" on page 157.

6.7.5 Velocity Calibration

1. Choose the Velocity Calibration command in the Setup menu or click on the Calibrate

icon in the main toolbar.

First thing to do is to enter a set of velocities into the Calibration worksheet. It is important to
select both minimum and maximum velocity well outside the expected velocity to be meas-
ured in the flow, as the transfer function will not extrapolate if the calibration velocity is
exceeded.

Note
X-sensor and Triple-sensor probes should be calibrated down to approximately 10% of the
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expected minimum velocity and up to 50% above the expected maximum velocity in order to
linearize the two extremes, where the flow attacks parallel with and perpendicular to the
sensors, respectively.

Velocity Range dialog box opens where you define velocity range and number of calibration
points.

2. Select Linear or Log distribution in the Distribution field. The Log distribution is recom-
mended, as is provides most points, where the transfer function varies the most.

3. Select MultiChannel Calibration, if you want to calibrate more than one probe at a
time.

4. Click OK and the Calibration dialog opens.



To Run the Calibration

Dialog box for single probe calibration.
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Dialog box for MultiChannel Calibration (after completed calibration).

Parameters

Calibration parameters are velocity, ambient temperature and pressure.

1. Choose the Setup button in the Parameters field.
Parameter Input Setup dialog box opens, where you can select the input sources for
velocity and temperature:

Select velocity and temperature input:

l Keyboard input:

The parameter is updated from the keyboard.

l Reference probe, velocity:

Choose the Probes button and select probe from the Velocity reference library.

Reference, temperature:

The temperature is acquired from the Reference temperature probe selected during Con-
figuration setup.

l A/D Channel:

The parameter is acquired via the selected A/D Channel.

l Other:



The velocity is acquired via a device defined by a user-defined I/O Device driver in the
External device driver library.

Select algorithm (only when A/D Channel input is selected):

Defines the transfer function that converts the acquired voltage to m/s or °C.

l Polynomial or power law:

2. Enter the calibration constants C0 to C5 or A, B and n depending on the choice of
algorithm.

3. Choose OK.
The Parameter Input Setup dialog box disappears, and you are now back in the Cal-
ibration dialog box.

Pressure input:

The barometric pressure input can only be done from keyboard.

Probe Voltages

This selection allows you to do the following Define the averaging time for probe signal by
combining sample frequency and number of samples:

1. Choose the Setup button in the Voltages field.
Voltage Setup Input dialog box opens.
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Acquiring Calibration Points

1. Make sure that you are in Point 1.

Type in the velocity and temperature, if they are not acquired via the A/D device, and
press the Read button in the Parameters field.

2. Press the Read button in the Voltages field.

3. Press the Update button. The values for velocity, temperature and voltage are now
stored and written into the calibration data sheet. The point is also plotted into the
graph.

4. Repeat 2 through 4 until all points are done.

5. Curve fitting

To Analyze the Curve Fit

When all calibration points have been acquired, you can see the result of the curve fit and per-
form an error analysis of the fit.

1. Choose Fit in the Probe Calibrate dialog box.
Curve Fit Analysis dialog box opens.



It shows Sensor number, transfer function coefficients, curve fit errors (linearisation errors)
and graphs with calibration curve fit and error distribution, respectively.

Linearization Errors

2. Select Sensor in Wire list box.
Linearization results for this sensor will be shown.

3. Select point in Point list box.
Voltage, Measured velocity, Calculated velocity and Error in the selected point are
shown.

Temperature Correction

Temperature correction is indicated by a Selection box. The reference temperature from the
Default Setup is used. You can see the impact of the temperature correction on the cal-
ibration constants and error distribution by selecting and deselecting the correction.

Copying the Calibration Coefficients to Windows Clipboard

Choose the Copy coefficients command button and they will be written into the clipboard.

4. Choose OK when the curve fit is accepted.

To Select another Curve Fit

You may select another curve fit than the default polynomial fit:

1. Choose the Curve Fit button.

Curve Fit Setup dialog box opens, where you can choose:
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l Polynomial:

l Power law:

l Lookup table:

Select the one you want.

2. Choose OK.
The dialog box disappears.

The new fit is carried out and the new coefficients and new error distribution replace the old
ones in the Curve Fit Analysis dialog box.

When you are satisfied with the coefficients for one sensor then select the next and continue
from 2, until all sensor fits are analyzed. 

3. Choose the OK button.
The dialog box disappears, and you are back in the Calibration dialog box.

Curve Fit Setup

The default curve fit algorithm is a 4th order polynomial. It can be changed to another order
or another type.

1. Choose the Fit button in the Calibration or in the Curve Fit Errors dialog box.
Curve Fit Setup dialog box opens. Here you can choose between following four types
of curve fits:

Polynomial

1. Select Polynomial.
The Polynomial order list box is enabled.

2. Select the wanted order in the Polynomial order list box.
For an j-order polynomial the curve fit function now becomes:



Ei = C0 + C1·U + C2·U2 + C3·U3 + . . . +Cj·Uj

where U is velocity, Ei is probe voltage from sensor i and C0 to Cj are the polynomial coef-
ficients.

Power Law

1. Select Power law.
The curve fit function now becomes:

Ei2 = A + B·Un (King's law)

where Ei is the probe voltage from sensor i, A and B calibration constants, U velocity and n the
selected power.

The More button is enabled.

2. Select start value of n, if you do not want to use the default value.

3. Choose the More button, if you want to redefine the variation range of n and the
acceptance level of the iteration.

A Calibration Iteration Control dialog box opens with the following options:

Minimum range value.

Maximum range value.

Maximum iterations.

Acceptance level (defines the maximum accepted squared error).

Initial step size.

4. Choose OK.
The dialog box closes and you are back in the Curve Fit Setup dialog.,

Lookup Table

1. Select  Lookup table.
Lookup list box is enabled.

Note
A Lookup table requires many more calibration points than polynomials or power law to
provide same accuracy, as it is based on linear interpolation between the points.
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2. Select size in the Lookup table size list box.

Note
The size of the lookup table should match the resolution of the A/D device, i.e. ideal size is
(Emax-Emin)/Resolution.

3. Choose OK.
The dialog box closes and the Curve fit and errors are updated in accordance with the
new selection.

Editing Calibration Points

When all points have been entered, you can edit by adding, updating or deleting points.

To Add a Point

A new point can be added either by means of the Calibration Equipment or simply by entering
a new set of calibration values from the keyboard.

1. Select a point.

2. Enter and read the new set of velocity, temperature and voltage values.

3. Choose the Add button.

The new point is plotted in the E-U diagram, and the curve fit is updated.

To delete a Point

1. Select a point in the E-U diagram or by means of the up/down arrows in the Point field.

2. Choose the Delete button.

The point is removed from the E-U diagram.

To Update a Point

1. Select the point in the E-U diagram or by means of the up/down arrows in the Point
field.

2. Enter and read the new set of velocity, temperature and voltage values.

3. Choose the Update button.

4. The point is re-plotted in the E-U diagram, and the curve fit is updated.

To Clear All

1. Choose the Clear all button in the Point field.
You are prompted to accept the Delete all command.

2. Choose the OK button, if you are sure.
The calibration points are removed from the E-U diagram, and the values in the Para-
meter and Voltages fields disappear.

Calibration of Other Probes

External probes are transducers and related electronics whose output are acquired by the
StreamWare Basic software via the A/D device. To a start any customer's probe must as a min-



imum have a library calibration, which is a simple 1:1 transformation of voltage to physical
unit. (C1=1, all other C’s =0 in Library Coefficients)

The calibration is a best curve fit through a set of calibration points filled into the cells of the
Calibration data sheet from the keyboard. The voltage signal from the External probe can also
be acquired directly, if it is possible to expose the probe to the full range of calibration con-
ditions.

Calibration

1. Select the probe in the Probe list in the top toolbar.

2. Open the Probe Calibration Window and fill in the calibration data in the calibration
parameter and probe voltage columns from the keyboard. The calibration parameter
can be edited as a data series as described in the section: New Calibration, Definition
of calibration velocities.

When all calibration points are filled in, the calibration process is in fact finished. The curve fit is

done, when you select the curve fit button in the Tools toolbar.

Editing points, Error analysis, Curve fit optimization and Graphical presentation

Follow the outlines in section: New Calibration.

Leaving the calibration

1. Choose OK.
The dialog box disappears.

2. Leave the Calibration window as described in the section: New Calibration and save
the recalibration as its own event.

To Leave the Calibration and Save the Calibration Event

1. Click in the Control-menu box of the Calibration Window and select Close or double
click in the Control-menu box.
- or -
Choose Close from the Window menu.
Save Event dialog box opens.

2. Type in the Associated Identification (event name)

3. Choose Yes.
The Save Event dialog box closes. The event is time stamped and added to the event
list in the Project Manager.

Before the event is saved you are prompted if you want to make the Calibration event
default. It is recommended to answer Yes to this.
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Saving MultiChannel Calibration

Select “Keep Events Open”, if you want the calibration data sheets open, after the calibration
events are saved.

Note
A Conversion Setup is written into the Project Manager after each Velocity Calibration. The
last Conversion Setup one is automatically made default and will be used in raw data con-
version and reduction. Is is advised to delete all the non-default conversions.

6.7.6 Probe Array
The Probe Array defines the positions (X,Y,Z) of the individual probes in the Traverse system
coordinate system. It supports the traverse of probe arrays.



Probe Array data sheet opens with a default array, where all configured probes are aligned
along the X-axis at 1-mm intervals.

2. Type in the geometry of the actual array.

3. Close and save the Probe Array.

6.7.7 Traverse Grid
A Traverse Grid is needed in order to traverse the probe.

Note
You do not need to have an automatic Traversing System in order to create and use a Tra-
verse Grid.

To Generate the Grid

4. Choose the Traverse Grid command from the Setup menu or click on the Traverse but-

ton in the Project toolbar.

Traverse data sheet opens with Grid Setup dialog box on top of it, where X,Y,Z - positions and
probe rotation angle can be defined..

5. Type in Start position, Increment and Number of grid points on each axes. If the
probe has to be rotated type in the Angles.

Traverse Grid to be used with a Probe Array

Start position:

Equal to the position of probe no. 1 in the array.

Increment:
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Equal to the position of the last probe in the array plus the distance between the probes in the
array.

To set Grid Options

Grid coordinate system in relation to laboratory system

1. Choose the Options button in Grid Setup dialog box.
Grid Options dialog box opens.

2. Select proper system: Cartesian, Cylindrical or Spherical by means of the radio buttons
in the Coordinate system frame.

3. Type in the Coordinate transformation matrix and the grid system Origo offset in the
Transform frame.

4. Choose the Identity button if Grid axis are parallel with Laboratory system axis.
The matrix is filled in accordingly.

Or, if the traverse grid is tilted with respect to the laboratory coordinate system:

1. Choose the Plane button.
Plane Setup dialog box opens.

2. Select the actual plane and type in the rotation angle with respect to the cor-
responding plane in the Laboratory system.

3. Choose OK.
The dialog box closes and the transformation matrix is automatically updated.



4. Choose the Generate button.
The dialog box closes, and the cells in the Traverse window is filled in with the positions
defined in the Grid Setup generator.

5. Close the Traverse Window by double clicking on the Menu Control box.
Save Event dialog box opens, where you can type in an Event Identification. The Grid is
now saved as a Traverse Event in the Project database.

6.7.8 Define Data Conversion/Reduction Setup

Definitions

Data conversion and reduction is the process of linearizing data and reducing them into stat-
istical quantities.  In this way large number of samples stored during a data acquisition are
reduced to a limited number of statistical quantities, like mean values or standard deviations.
The data may be either raw data or data converted into physical units referring to a specific
coordinate system. The Data conversion/reduction setup also contains information on how
the conversion is performed prior to reduction.

A Data conversion/reduction setup is an event and can be assigned to Default Setup.

Note
The Data conversion/reduction setup only allows you to reduce the raw data into first, second
and third order moments or correlations between one, two or three probe signals. For fur-
ther reduction into e.g. spectra etc. you must use the Analysis from the Run menu.

Note
Only raw and reduced data are stored in files. You will have no files with converted data alone.
If you want to see complete set of raw data in converted form, you must load the raw data
record and choose the wanted conversion in the Option. The conversion will be based on the
Data conversion/reduction event assigned to the setup used to acquire the data.

To Open the Data Reduction Setup Menu

1. Choose the Data conversion/reduction setup from the Project menu.
Data conversion/reduction setup dialog box opens with a map of all probes defined in
the project and a data conversion toolbox.
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Now add the required conversion processes and define them. They are:

l Temperature correction.

l Linearization.

l Decomposition into sensor/probe coordinate system.

l Transformation into laboratory coordinate system.

l Probe array.

To Define Data Reductions

1. Select the wanted probe by choosing the Probe button in the Reduction map.

Probe Reduction Options dialog box opens, where you can select the following:



l Data conversion level before reduction.

l Type of data reduction.

l Auxiliary data and custom defined moments.

To Select Conversion Level (Options)

This option allows you to select how the raw data are converted before the data reduction is
carried out.

1. Select the Options Button in the Probe conversion dialog box.
A Conversion Level dialog box opens.

Here you can choose between the following:

Voltage only

The reduction will be done directly on the acquired raw voltages. If temperature com-
pensation is selected, the voltages are corrected before reduction.

Velocity from calibration

The voltages are converted into velocities in accordance with the selected transfer function.

Velocity in Sensor coordinate system

The voltages are converted into velocities in the sensor oriented coordinate system using
yaw-pitch corrections.

Velocity in Probe coordinate system

The voltages are converted into velocities in the probe oriented coordinate system using yaw-
pitch corrections.

Velocity in Laboratory coordinate system

The voltages are transformed into velocities in a laboratory defined coordinate system.

Temperature compensation

If selected the probe voltages or velocities will be corrected for temperature variations in the
flow.

Note
The voltages are only corrected, when a calibration event with polynomial curve fit or table
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look-up has been selected. If power law fit was selected the calibration constants are cor-
rected instead and the corrected velocity is loaded.

2. Choose Ok.
The dialog box disappears.

3. Choose OK.
The Probe Conversion Options dialog box disappears.

You are now ready to add and define the processes corresponding to the selected con-
version.

To select moments

Select one or more of the U, u' or u'/U check boxes.

This defines the moments: mean, standard deviation (RMS) and turbulence intensity, that will
be calculated from the raw data.

To select auxiliary data and user defined moments

Auxiliary data are data acquired in connection with raw data, like date and time. They can also
be user defined moments between data in the selected file or between data from the file and
data from other probes or sensors.

You can add up to 5 sets of auxiliary data to each data file by the check boxes connected to the
Aux.1 to Aux.5 command buttons.



1. Select one or more of the Aux. check box.
The Aux. command buttons are enabled.

2. Choose the Aux. button.
Auxiliary data dialog box opens.

Here you can select one of the following data types:

Position creation date

This shows the date when the probe was moved to the position.

Position creation time

This shows the time, when the probe was moved to the position.

User-defined moment

Select the User-defined moments radio button.

The Moment type radio buttons are enabled.

1. Select the wanted Moment type radio button: 1st, 2nd or 3rd order.
The arguments select lists are enabled.

2. Select the probe and the components that you want to use as arguments in the
moment by means of the up/down arrows.

To Define the Transfer Function

The raw data is converted into velocities by means of a transfer function from a calibration
event.

1. Choose the Transfer Function button in the toolbox.
The button is copied into the data reduction sequence of the selected probe.

2. Click on the button in the sequence map.
Transfer Function dialog box opens.

3. Select the Use default check box.

- or, if you want to use another calibration event instead:

Unselect the Use defaults.
Event Load button is enabled.

4. Choose the Load button.
Select Event dialog box opens.

5. Select  the wanted calibration event.

6. Choose OK.
The dialog box disappears.
The name of the event is displayed in the event box in the Transfer Function dialog
box.

7. Choose OK.
The Transfer function dialog box disappears.
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To Define Temperature Correction

The Temperature Correction is a process that corrects the acquired raw voltages and/or the
velocities for the influence of ambient temperature variations. For details on the tem-
perature correction algorithms see "Software Reference" (on page 185).

Temperature Correction requires that a temperature probe is selected.

As the output from the temperature probe is connected to an A/D input channel, each
voltage/velocity sample is corrected with a simultaneously sampled temperature

1. Choose the Temp. comp. button in the toolbox.
The button is copied into the probe frame.

2. Click on the button in the probe frame.
Temperature Correction Setup dialog box opens, which confirms your choice of tem-
perature probe.

To Define Velocity Decomposition into Sensor/Probe Coordinate System

This process decomposes the velocities calculated from the transfer functions into the sensor
or probe coordinate system using the sensor geometry from the Probe Library and the yaw
and pitch corrections either from the Probe Library or from Directional Calibration Events.

1. Choose the Velocity decomposition Button in the toolbox.
The button is copied into the frame of the previously selected probe.

2. Click the Decomposition Button in the probe frame.

Yaw/Pitch Correction dialog box opens with the pitch- and yaw-coefficients from the Probe
Library. You can enter other values from the keyboard.



To Define Coordinate Transformation

Coordinate Transformation is the process of transforming the decomposed velocities from
the probe coordinate system into a laboratory coordinate system.

1. Choose the Coordinate Transformation Button in the toolbox.
The button is copied into the frame of the previously selected probe.

2. Click the Coordinate Transformation Button in  the probe frame.
Applied Coordinate Transformation dialog box opens.

X-sensor probe

1. Enter the z-axis rotation. This is the angle that the laboratory coordinate system is
rotated on the z-axis with respect to the probe coordinate system.

A transformation matrix is filled out with the directional cosines to be used during the trans-
formation.

Triple-sensor  probe

1. Enter the Applied roll angle. This is the angle that the laboratory coordinate system is
rotated on the x-axis with respect to the probe coordinate system.

Two transformation matrices are filled out with the directional cosines to be used during the
transformation.

2. Enter the Applied pitch angle. This is the angle that the laboratory coordinate system
is rotated on the z-axis with respect to the probe coordinate system.
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3. Choose OK. The Applied Coordinate Transformation dialog box closes.

To Add a Probe Array (requires MultiChannel CTA Add-on)

The Probe Array defines the positions of probes in an X,Y,Z-coordinate system oriented in par-
allel with the Traverse coordinate system.

1. Select a probe.

2. Choose the Probe Array Button  in the toolbox.

The button is added the frame of the selected probe.

3. Click the Probe Array button in the probe frame.

Probe Array dialog box opens, where you can load the array from the Select Event box.

To Save the Data Reduction Setup

1. Choose OK.
The Data Reduction Setup dialog box disappears.
A Save Event dialog box opens.



2. Enter a name in the Associated ID text box, if you want to add a further identification
to the event.

3. Choose the Yes command button.
The dialog box closes.

The event is saved and added to the Project Manager.

6.8 Running the System

6.8.1 Definitions
You can enable the Hardware and run Online analysis, Default Setup. You can also carry out
Data reduction. In the Edit group you can edit Hardware Setup an calibration events or
change the curve fit in the calibration event. You also can control a connected traverse or the
automatic calibrator.

6.9 The Measurements Group

6.9.1 Run Online Analysis
In Online Analysis you can analyze the output signals from one probe at a time. It is recom-
mended that you run the Online analysis in a known flow after defining the Default Setup
including Data conversion/Reduction. In this way you can check the entire measuring chain
from probe to A/D device and you can get an impression of how the Data conversion works.

The the CTA-outputs can be displayed either as voltages, velocities from calibration or as velo-
cities in wire- , probe- or laboratory coordinate systems.

In Online analysis no data are saved. If you want to acquire and save data you must run either
the Default Setup.

To Open the Online Analysis Display

1.Select the wanted probe in the Probe selection box in the main toolbar.

2. Choose Online analysis in the Run menu. Or click on the Online icon in the main tool-
bar:

Online dialog box opens where you can select conversion level for the acquired data, define
acquisition setup (sample frequency and numbers of samples) and start and stop the acquis-
ition.
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To Select Output Format (Conversion Level)

Voltage

Raw data in the form of voltages are displayed.

Velocity from Calibration

The velocity is calculated by inserting the raw voltages directly into the transfer function and
displayed.

Velocity in Sensor Coordinates

The calibration velocities are decomposed by means of the pitch -and yaw constants defined in
the Default Data Conversion event and displayed.

Velocity in Probe Coordinates

The sensor velocities are decomposed by means of the wire to probe angles defined in the
Probe Library and displayed.

Velocity in Laboratory Coordinates

The probe velocities are transformed into the laboratory fixed coordinate system (as defined
in a Grid setup assigned to the Default Setup) and displayed. If you have not defined a labor-
atory coordinate system, the probe- and laboratory systems are by default identical.



To Define the Data Acquisition Setup

The default values for the number of samples, the sampling frequency and the sampling inter-
val are shown. You can select other values: 

Number of Samples

1. Select the wanted number per channel in the list box.

The corresponding total number of samples for the channels connected is shown.

Sampling Frequency

2. Select the wanted frequency per channel in the list box.

The corresponding total frequency for all channels is shown.

Interval

Sampling interval will now be displayed in the third list box.

The X-axis on the display is scaled to match sampling interval. You can select another interval if
wanted. This will change the sampling frequency accordingly but leaves the number of
samples unchanged.

To Run the Online Analysis

Online analysis can be performed continuously or in one shot.

Continuous Analysis

1.Click on the Run button.

The Input Signal is now acquired, and the Output is displayed in the selected format. The dis-
play is updated for each new sampling.

2.Click on the Stop button.

The sampling stops and the display is left with last sample frozen.

One Shot

1.Click on Step.

Only one sample is performed and the result is displayed.

Graphical Display Options

You can change scaling of the axis, and you can enlarge the graphical displays by clicking on
the graph with the right mouse button. This opens a selection menu with 3 selections.
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To Define axis (Options)

1. Click on Options.
A Graph Options dialog box opens where you can select between Device limits and
User set.

Device Limit

If selected, the X-axis is scaled according to the data acquisition setup. The Y-axis is scaled in
volts or m/s in accordance with the Output selection. The maximum Y-value corresponds to
the A/D Channel input range (normally 0 - 10V) or to the maximum velocity from calibration.

User Set

If selected, you can type in minimum and maximum values for X and Y respectively in the
Xmin, Xmax, Ymin and Ymax text fields.

Colors

Click on the Color command button, if you want to change the color of the graph. A Color dia-
log box opens where you can select a new background color.

2. Select OK and the graph is appears in its new form.

Auto Scaling

1. Click on Auto-scale.
The X-axis is scaled  according to the data acquisition setup. The Y-axis is scaled in volts
or m/s in accordance with the Output selection. Ymin and Ymax corresponds to min-
imum and maximum value acquired.

Zoom Out

1. Click on Zoom out.
An Online zoom dialog box opens with an enlarged graph. From here you can copy the
graph to clipboard and paste it into a document in another Windows application. 

A/D Device Setup Options

You can temporarily change the basic setup (Range, Clock and Trigger) of the A/D device if
you choose the Options command button.

1. Choose the Options button.
A Online Options dialog box opens, where you can do the following selections:



Range

Select between 0 - 5 Volts and 0 - 10 Volts.

Clock

Select the clock to be used for timing of the data sampling:

1. Select the Internal radio button, if you want to use the clock on the A/D device.
- or if you want to use an external clock -

2. Select the External radio button.

Trigger

Select the trigger to be used for starting the acquisition by choosing one of the following:

Internal Trigger

Select the Internal radio button, if you want the acquisition to start as defined by the software
in the Scheduling Setup.

External Trigger

Select the External radio button, if you want to use an external voltage signal to start the data
acquisition.

The More button is enabled.

1. Choose the More button.
External Trigger Options dialog box opens.

2. Select the trigger level by means of the up/down arrows in the Trigger level select
box.

Note
These are the only options active in this dialog. The remaining selections (Trigger channel,
Polarity and Sensitivity) are not implemented in the StreamWare Basic translation drivers.
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To Leave Online Analysis

1. Choose OK or double click on the control menu box.
The dialog box closes. No settings or data will be saved.

6.9.2 Move Traverse Home
This command is used to move the Traverse (if connected and defined in the Configuration) to
its starting position.

6.9.3 Run Default Setup
Default Setup performs a group iteration, which acquires data and saves them as an event.
The data acquisition is performed as defined by the default parameters.

If a traverse system is included in the configuration, the probe will be moved in accordance
with the selected traverse grid before each acquisition.

To Start Run Default

1. Choose the Default Setup command from the Run menu or the Run button in the
Main toolbar. Acquire Data to Disk dialog box opens.

To Name the Event

Type in the identification of the raw data to be acquired in the Event ID text box.

To Select Number of Points

The number of positions in the Traverse grid (if defined) are displayed in the No of positions
configured text field . If you have no Traverse assigned, only one data acquisition in one point
is carried out.

You can select the points in the grid where you want acquisition to performed:

1. Choose the Include all points radio button.
Data are acquired in all grid points.
- or -

2. Choose the Only points radio button.
Type in the wanted start and end points in the Only points boxes.



To Fill in the Log

1. Choose the Log button.
Log dialog box opens with a text field, where text can be entered.
Write in your comments and:

2. Choose OK.
The dialog box closes.

To Acquire Data

1. Choose Run.

The Acquisition status window opens, where you can follow the acquisition point by point. The
status window also shows the Local variables and the traverse positions. The system starts
acquiring data as specified. The Status bar shows Mode: RUNNING.

In the Set Defaults you have selected either Infinite loops, Single Count or Multiple counts.

Infinite Loops

The acquisition continues infinitely. You are, however, prompted for continuation between
each loop.

1. Choose the STOP button to stop data acquisition.
Data are saved as a Raw Data record and added to the event list in the Project Man-
ager.

2. Choose the STEP  button to continue with one more loop.
Data are saved after each loop.
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Single Count

The acquisition stops automatically after one loop. This is indicated by a beep.

Data are saved as a Raw Data record, which is added to the event list in the Project Manager.

The Status bar shows Mode: INACTIVE.

Multiple Counts

The acquisition stops automatically, when the last loop is finished. This is indicated by a beep.

Data are saved as a Raw Data record, which is added to the event list in the Project Manager.
The

Status bar shows Mode: INACTIVE.

6.9.4 Data Reduction
Data Reduction converts raw data to physical units (velocities) and reduces them into statistical
quantities as defined in the default Conversion/Reduction event.

To Start Data Reduction

1. Select a probe in the Probe list in the upper toolbar.

2. Choose the Data Reduction button in the main toolbar or the Data reduction com-
mand from the Run menu. You can also click with the right mouse button on the Raw
data that you want to reduce.

A Data Reduction dialog box opens:



To Name the Event

Type in the identification in the Event ID box.  After completion the reduced data will be saved
as a Reduced Data record, which is added to the Project Manager.

To Select Raw Data Event

If you have not double-clicked on the Raw data record, you must now load the wanted data.

1. Choose the Load button.
Select Event dialog box opens.

2. Double click on wanted Raw data event  in the Event list.
The dialog box closes, and the selected event is now displayed in the Raw data field.

To Fill in Log

Comments can be written into the project log.

1. Choose the Log button.
Log dialog box opens with a text field, where text can be entered.
Write in your comments and:

2. Choose OK.
The dialog box disappears.

MultiChannel Data Reduction (requires MultiChannel CTA Add-On)

When selected, raw data from all the probes in the configuration are reduced in the same
run. The reduced data are saved in individual Reduced Data events, one for each probe, and
in a MultiChannel Reduced data event containing all array and traverse positions.

To Perform the Data Reduction

1. Choose the OK button.

The data reduction is carried out.

The Status bar shows Mode: RUNNING.

When finished it is automatically saved as a Reduced Data record, which is added to the event
list in the Project Manager.
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To Leave Data Reduction

When the reduction is finished, it is recorded as an event. The Run Data reduction sequence is
over and needs no separate action to be finished or closed down.

6.9.5 To Merge Reduced Data (requires MultiChannel CTA Add-on)
This function re-arranges reduced data from the individual probes in a probe array into one
MultiChannel Reduced Data event containing all array and traverse positions.

1. Select the Reduced Data events related to a specific set of Raw data in the Project Man-
ager.

2. Click with the right mouse button and choose Merge reduced data.                                                                

3. MultiChannel Data Reduction dialog box opens, where you can enter an event iden-
tification.

4. Choose OK and the event is saved and added to the Project Manager.

6.9.6 Pause/Resume
These commands to stop and start a program execution temporarily.



To Stop

1. Choose Pause from the Run menu.

All program execution is stopped.

The Task Queue Console shows Task Status: Disabled

The sub menu command Pause changes to Resume.

To Start Again

1. Choose Resume from the Run menu.

The program continues from where it was stopped.

The sub menu command Resume changes to Pause.

6.9.7 Halt All Processes
This command stops a program execution at any point during execution.

To Stop

1. Choose Halt all processes from the Run menu.

The program execution is stopped. The Task Queue Console, if open, shows Task Status: Dis-
abled. The sub menu command Halt all processes are grayed out.

No data are saved after a Halt all processes command. To run the same Default Setup once
more requires that you start from the beginning with a new Run ....  selection. 

6.9.8 Graph
This command creates a graph on basis of a Data sheet. See "Graphs" (on page 123).

To Present a Graph of MultiChannel Reduced Data

1. Double-click on the MultiChannel Reduced Data  Project Manager.

2. A worksheet with the data opens. The positions, e.g. X-positions, represent the pos-
itions of each probe in turn. For a traverse with N positions, the first N points contains
positions and reduced data from probe 1, the next N positions represent probe 2 and
so forth.

3. Click on the Graph icon on the Datasheet Tools - Options Tab. The Select Data dialog
box opens.

4. Select the data. See "Graphs" (on page 123).

Note
Choose “No line” in Style in order to avoid lines between “non-neighboring” points.
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Graph of velocity profile measured by traversing a probe array of 6 probes in 3 positions.

6.9.9 Analysis
You can use command to perform data reduction in a software applications placed outside
StreamWare Basic. They are called via function drivers in the Analysis Library.

Before you can process data they must be selected from a Data sheet.



To Open and Select Data

1. Open the Raw data event by double-clicking with the left mouse on the event in the
Project Manager and select the traverse point (if applied).
A Data sheet with time stamped data appears.

2. Select the wanted data from the Data sheet.

To Run Analysis

1. Choose the Analysis in the Datasheet Tools - Options Tab.
An Analysis dialog box opens which shows the content of the Analysis Library.

2. Double click on the wanted function.
A Data sheet with the processed data appears.

The Analysis Library dialog box contains a Setup command.

To Save Processed Data

1. Double-click in the Menu-control box in the left top corner.
A Save event dialog box opens, where you can type in an event identification and
make comments in an event log.

2. Choose OK.
The processed data are saved as a record and listed in the Project Manager.
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7 Software Reference
The reference for StreamWare Basic contains definitions of probe coordinate systems
algorithms that are used for correcting and converting probe signals into velocities and
decompose them into wire or probe coordinate systems. An Error Message list explains the
error messages that may occur during execution of StreamWare Basic.

7.1 Algorithms
This section describes the algorithms that are used in the StreamWare Basic software for
creating  Hardware Setup, acquiring and correcting CTA voltages, converting them into velo-
city components and reducing these into statistical quantities.

7.1.1 Hardware Setup
Hardware Setup is the setup of a MiniCTA Box or MultiChannel CTA Frame module.

Overheat Adjustment

In DC balance the decade resistance is adjusted, so that the probe will operate at a preselec-
ted sensor over temperature.

Sensor Cold Resistance

The total probe resistance is measured and the sensor cold resistance is calculated by sub-
tracting probe leads, support and cable resistances:

Rs,cold = Rtot - (Rleads + Rsupport + Rcable)

Overheat Ratio

The overheat ratio is defined as:

a = (Rs,hot - Rs,cold)/Rs,cold

It is related to the sensor temperature by the relation:

a = aref·(Tw - Tref)

where aref = a20/(1+a20· (Tref - T20))

Sensor Hot Resistance

The hot resistance of the sensor is defined as:

Rs,hot =  (1 + a)·Rs,cold

or:

Rs,hot = (1 + aref·(Tw - T0))·Rs,cold

Overheat Resistance

The overheat resistance is the value that is maintained constant by the servo loop in the CTA:



Roverh. = Rs,hot +(Rleads + Rsupport + Rcable)

Decade Resistance

The decade resistance is the value that is established in the bridge and determines the sensor
over-temperature:

Rdec = BR·Roverh.

Nomenclature

Rs,cold = Sensor cold resistance

Rtot = Probe total resistance

Rsupport = Support resistance

Rcable= Cable resistance

Tover = Over temperature = (Tw-T0)

Tw = Sensor hot temperature (average)

T0 = Ambient reference temperature

a = Overheat ratio

a0 = Sensor temperature coefficient at ambient reference temperature

Rs,hot = Sensor hot resistance at Tsensor

Rs,cold = Sensor cold resistance at ambient temperature

BR = bridge ratio (1:20 for MiniCTA and MultiChannel CTA)

Roverh = Overheat resistance

Rdec = Decade resistance

7.1.2 Probe Calibration
Probe calibration creates a set of related values of CTA output voltage. The raw calibration
data are stored in a Datasheet and form basis for the curve fitting.

Curve Fitting

Creates relation between CTA output signal and fluid velocity for a specific CTA Hardware
Setup and probe orientation. The curve fitting is based on voltages that are corrected to the
Hardware Setup reference temperature.

In StreamWare Basic you can select between 4 different curve fitting algorithms.

Polynomial

The polynomial curve fit defines velocity as function of voltage:

U = C0 + C1·E + C2·E2 + C3·E3 + C4·E4 + C5·E5 + C6·E6

where:

U = Velocity

E = CTA output volts

Coefficients C0 to C6 are calculated from a standard least square fit. (Polynomial order can be
selected from 1 to 6).
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Power Law (Kings Law)

The power law defines the voltage as function of velocity:

E2 = A + B·Un

where:

U = Velocity

E = CTA output volts

A, B and n= Calibration constants

A, B and n are calculated from a standard least square fit.

Look-up Table

The Look-up table linearizes the bridge voltage by means of a table in E and U (max size 120 k).
Table values are created through linear interpolation between calibration points. Note that
the lookup table requires many calibration points (normally between 20 and 40 points) and
that the size should match the resolution of the A/D converter (size = (Emax-Emin)/Resolution)).

7.1.3 Data Conversion
Data Conversion is a number of actions in the Data Reduction process during which  the raw
CTA output voltages are rescaled, temperature corrected, linearized and decomposed into
velocity components:

Temperature Correction:
If  polynomial fit or table look-up is selected: Ebridge --> Ecorr 
If power law is selected: Ebridge is not corrected but A, B and n are corrected to
match acquisition temperature.

Linearization:
If polynomial fit or table look-up is selected:
Ecorr --> Ueff
If power law is selected:
Ebridge -->Ueff

Velocity Decomposition (Ueff --> >Uwire coord. --> > Uprobe coord.)

Velocity Transformation (Uprobe coord.--> U lab. coord.)

Temperature Correction

Temperature correction is done in two different ways depending on the transfer function
(curve fitting algorithm) selected in the Calibration event assigned to the actual Con-
version/reduction.

Polynomial Curve Fit and Table Look-up Correction

CTA output voltages acquired at one ambient temperature are corrected to the reference
temperature by means of the formula:

Ecorr = ((Tw - T0)/(Tw - T1))0.5·(1±m) ·E1

The over temperature Tw - T0 can be calculated as:



Tw - T0 = (a/α0 ) + T0

Nomenclature

Ecorr = Voltage corrected to reference temperature

E1 = Voltage acquired at ambient temperature T1

Tw = Sensor hot temperature

T0 = Reference temperature related to last overheat setup before calibration (from Hard-
ware Setup(from Hardware Setup)

T1 =  Ambient temperature during data acquisition

m = temperature loading factor (from Physical Properties Library)

±  m is added or subtracted for increasing temperatures and decreasing temperatures,
respectively.

Note
The influence from variations in heat conductivity, Prandtl number, density and dynamic vis-
cosity is not corrected for.

Power Law Curve Fit Correction

In this case the calibration constants A and B are corrected for ambient temperature changes
and for variations in all the property values relevant for the heat transfer process.

Acorr = ((Tw-T0)/(Tw-T1))(1±m)·(kf0/kf1)·(Prf0/Prf1)0.2·A0

Bcorr = ((Tw-T0)/(Tw-T1))(1±m) ·(kf0/kf1)·(Prf0/Prf1)0.2·(mf1/mf0)n·(rf0/rf1)n·B0

where

A0, B0 and n  = Calibration constants at reference temperature T

T0=reference temperature (from Hardware Setup)

T1=ambient temperature during data acquisition

Pr = Prandtl number

m = dynamic viscosity

r = density

f1 refers to film temperature (Tw + T1)/2

f0 refers to film temperature (Tw + T0)/2

m = temperature loading factor (from Physical Properties Library)
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The fluid property values are all from the Physical Properties Library.

Linearization

Linearization is the process of converting a CTA voltage to velocity by means of the transfer
function selected in the Calibration Event that is assigned to the Conversion/Reduction event.

Transfer Functions

Polynomium

Transfer function ( = curve fit):

U = C0 + C1·E + C2·E2 + C3·E3 + C4·E4 + C5·E5 + C6·E6

U = Calibration velocity

E = CTA output volts (rescaled)

C0 to C6 = Coefficients

The degree is in accordance with the selected Calibration Event.

Power Law (Kings Law)

Transfer function:

U = ((E2 - A)/B) 1/n

U= Calibration velocity

E = CTA output volts

A, B and n= Calibration constants

Look-up Table

U from table with E input.

7.1.4 Velocity Decomposition
Velocity decomposition is the process of converting effective cooling velocities into velocity
components the sensor coordinate system and into in the probe coordinate system. 



Sensor Coordinate System

Definitions

The sensor coordinate system is a right-hand ruled Cartesian Coordinate System defined rel-
ative to the axis of  the sensor(s). The hot wires defines the axis of the coordinate system.
Sensor 1 is aligned with sensor coordinate axis 1, sensor 2 is aligned with axis 2  and  sensor 3
is aligned with  axis 3.

General Velocity Decomposition in Sensor Coordinate System

A fluid vector U decomposed into sensor coordinates is described by:

U = U1i1 + U2i2 + U3i3

where U1, U2 and U3 are components of Uin the directions i1, i2 and  i3 respectively.

The general equations between the effective cooling velocity Ueff and the velocity com-
ponents U1, U2 and U3 in the wire system which takes tangential cooling and prong inter-
ference into account yields:

U1eff
2 = k1·U1

2 + U2
2 + k2·U3

2

U2eff
2 =  k2·U1

2 + k1·U2
2 + U3

2

U3eff
2 =   U1

2+ k2·U2
2 + k1·U3

2

Where k1 and k2 are the yaw and pitch factors, respectively.

Probe Coordinate System
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Definition

The probe coordinate system is a right-hand ruled Cartesian Coordinate System defined by
the orthogonal unit vectors (ix,iy,iz).

Each Dantec standard probe has has a fixed orientation between probe coordinate system
and wire coordinate system given by the orientation of sensor(s), sensor planes and probe
stem.

These orientations are fixed for each probe type and can only be changed, if you overwrite
the default sensor/probe angles in the Probe Library.

General Velocity Decomposition in Probe Coordinate System

A fluid vector U decomposed into probe coordinates is described by:

U = Uix + Viy + Wiz

where U,V and W are components ofUin the directions ix, iy and iz, respectively.

It is recommended to place the probe, so that the probe coordinate system coincides with the
laboratory coordinate system.

Single-sensor Probes

Single sensor probes have the  x-axis of the probe coordinate system coinciding with axis 2 of
the wire coordinate system.

Velocity Decomposition

For single-sensor probes in a 1-dimensional flow,  where  the probe  x-axis is in the direction of
the flow vector U we obtain:

Ueff
2= (U1

2) + U2
2 +(U3

2 ) or U =  U2 = Ueff

where Ueff is the effective cooling velocity obtained from linearization of the anemometer
output voltage.



X-sensor Probes

X-sensor probes have the sensor plane in the xy-plane of the probe coordinate system. The
angle between the x-axis and sensor 1 is denoted a(x/1) and between the x-axis a(x/2).  

Velocity Decomposition

The following equations are used for calculation the velocity components (W is zero or neg-
lected) on the basis of the calibration velocities and the yaw-factors k1, k2 for the wires. The fol-
lowing steps are carried out:

Calibration velocity (U1cal,U2cal) to Sensor coordinate system (U1,U2):

U1cal
2·(1+k1

2)·cos(90-α(x/1)) = k1
2·U1

2 + U2
2

U2cal
2·(1+k2

2)·cos(90-α(x/2))2 = U1
2 + k2

2·U2
2

These two equations are solved with respect to U1 and U2 and inserted in the Sensor (U1,U2)
to Probe (U,V)  coordinate equations:

U = U1·cosα1 + U2·cosα2

V = U·1sinα1 -U2·sinα2
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Triple-sensor Probes

The probe is placed in a three-dimensional flow with the probe axis aligned with the main flow
vector.

The velocity components U, V and W in the  probe coordinate system (x,y,z) are given by:

U = U1·cos54.736° + U2·cos54.°736° + U3·cos54.736°

V = -U1·cos45° - U2·cos135° + U3·cos90°

W = -U1·cos114.094° - U2·cos114.094° - U3·cos35.264°

where U1, U2 and U3 are calculated from the general set of equations:

U1eff
2 = k1

2·U1
2 + U2

2 + h1
2·U3

2

U2eff
2 =  h2

2·U1
2 + k2

2·U2
2 + U3

2

U3eff
2 =  U1

2 + h3
2·U2

2 + k3
2·U3

2

where U1eff , U2eff and  U3eff are the effective cooling velocities acting on the three sensors
and ki and hi are the yaw and pitch factors, respectively.

As Triple-sensor probes are calibrated with the velocity in direction of the probe axis Ueff is
replaced by Ucal·(1+ki2+hi2)0.5·cos54.736°, where 54.736° is the angle between the velocity
and the normal to the wires:

U1cal
2·(1+k1

2+h1
2) ·cos254.736°= k1

2·U1
2 + U2

2 + h1
2·U3

2

U2cal
2·(1+k2

2+h2
2)·cos254.736° =  h2

2·U1
2 + k2

2·U2
2 + U3

2



U3cal
2·(1+k3

2+h3
2)·cos254.736° =  U1

2 + h3
2·U2

2 + k3
2·U3

2

With the default values k2 = 0.0225 and h2 = 1.04 the solution for U1, U2 and U3 becomes:

U1=(-0.3477·U1cal
2+0.3544·U2cal

2+0.3266·U3cal
2 )0.5

U2=(0.3266·U2cal
2-0.3477·U2cal

2+0.3544·U3cal
2 )0.5

U3=(0.3544·U1cal
2+0.3266·U2cal

2-0.3477·U3cal
2 )0.5

7.1.5 Transformation into Laboratory Coordinate System

Coordinate transformation can only be done for X- and Triple-sensor probes.

2D Transformation

The velocity components U and V in the probe coordinate system X,Y are transformed into
Ul,Vl in the laboratory coordinate system Xl,Yl. The transformation is a rotation of the XY-
plane in itself.

The transformed velocities then becomes:

where the rotation matrix M is defined as:

3D Transformation

Transforms the velocity components (U,V,W) in the probe coordinate system (X,Y,Z) into
(Ul,Vl,Wl) in the laboratory coordinate system. The transformation represents an inclination of
the XY plane (rotated around the Y-axis) with the angle and a following rotation around the Xl-
axis, roll w.
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The transformed velocities then becomes:

where the matrix C = PxR is defined by the pitch matrix P and the roll matrix R:

Pitch matrix P:

Roll matrix R:

7.1.6 Data Reduction
Data reduction can be performed on any set of data, both in raw and converted form. In the
following it is assumed that the reduction is done on velocity components in the Probe coordin-
ate system.

Moments

1st order

Average

2nd order

Standard deviation

Cross moments

3rd order



7.1.7 Analysis

Basic Statistics

Auto-correlation

Calculated using Fourier-Stieltjes integrals.

Power Spectrum

In the spectrum calculation, StreamWare Basic calculates the one-sided power spectral dens-
ity (PSD, per unit time). First, the time signal is divided into a number of blocks for averaging.
Each block contains 2n samples for easier FFT calculation. Second, windowing and zero pad-
ding are performed in order to reduce end effects and to increase the frequency resolution.
Third, an overlapping scheme is performed to increase the number of blocks and thereby
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reduce the uncertainty level for the calculation: A window function reduces the power of the
signal at both ends of each block, so without overlapping the useful signal at the ends is lost.
By overlapping the blocks, this signal can be used for calculation and useful in reducing the
uncertainty level.

For each block the following equation is used in the PSD calculation:

where Wss is the window squared summed.

In addition to this, Parseval’s check is performed on each block for verification of the results.
Parseval’s Theorem states that the power of a signal in time and frequency domains should be
the same.

7.2 Probe Coordinates

7.2.1 Probe Coordinate Systems

Definition

The probe coordinate system is a right-hand ruled Cartesian Coordinate System defined by
the orthogonal unit vectors (ix,iy,iz).

Each Dantec standard probe has a fixed orientation between probe coordinate system and
sensor coordinate system given by the orientation of sensor(s), sensor planes and probe
stem.

These orientations are fixed for each probe type and can only be changed by the user by over-
writing the default values in the Probe Library.

7.2.2 Single-sensor Probes, Coordinate Systems

Single-sensor probes have the  y-axis of the probe coordinate system coinciding with the 1st

axis of the wire coordinate system.



Straight and Boundary-Layer Types

Single sensor probes have the probe stem aligned with x-axis of the probe coordinate system,
while the sensor is parallel with the y-axis. The plane of the prongs is in the xy-plane.

This orientation is valid for the following probe types:

55A52, 52A53 Subminiature wire probes

55A75              High-temperature probe

55P01, 55P11  Gold-plated/miniature wire probe 

55P05, 55P15  Gold-plated/miniature boundary-layer probes

55P76          Temperature-comp. gold-plated wire probe for 1:5 bridge

55P81 Temperature-comp. miniature wire probe for 1:1 bridge

55P86 Temperature-comp. miniature wire probe for 1:5 bridge

55R01, 55R11 Fiber probe, air/water applications

55R05, 55R15 Fiber probe, air/water appl., boundary-layer  probes

55R31, 55R32 Wedge-shaped film probe, air/water appl.

55R76, 55R86 Temperature-comp. fiber probe, air/water applications

Single-sensor Probes, 45° Slanting-sensor Types

Probe stem is aligned with x-axis of probe coordinate system with the sensor in the xy-plane.
The long prong is in the 1st quadrant so that the sensor forms an angle of -45° with the x-axis.

This orientation is valid for the following probe types:

55A54, Subminiature wire probe

55P02, 55P12  Gold-plated/miniature wire probe 

55R02, 55R12 Fiber probe, air/water applications

Single-sensor Probes, 90°-bent Types, Sensor Parallel to Probe System

Probe stem is aligned with y-axis of probe coordinate system with the sensor-prong plane in
the  xy-plane. The sensor is perpendicular to the x-axis.
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This orientation is valid for the following probe types:

55A55, Subminiature wire probe

55P03, 55P13  Gold-plated/miniature wire probe 

55R03, 55R13 Fiber probe, air/water applications

55R33, 55R34 Wedge-shaped film probe, air/water appl.

Single-sensor Probes, 90°-bent  Types, Sensor Perpendicular to Probe System

Probe stem is aligned with z-axis of probe coordinate system with the sensor-prong plane in
the  xy-plane. The sensor is perpendicular to the x-axis.

This orientation is valid for the following probe types:

55P04, 55P14  Gold-plated/miniature wire probe 

55R04, 55R14 Fiber probe, air/water applications

55R35, 55R36 Wedge-shaped film probe, air/water appl.

7.2.3 X-sensor Probes, Probe Coordinates

X-sensor probes have the sensor plane in the xy-plane of the probe coordinate system. The
angle between the x-axis and sensor 1 is denoted (x/1) and between the x-axis (x/2). For the
ideal probe they are both 45°. 



X-sensor Probes, Straight Types

The probe stem is aligned with x-axis of the probe coordinate system, while the sensors are
parallel with the xy-plane. Sensor 1 forms +45° and sensor 2 forms -45° with the x-axis.The
planes of the prongs are in the xy-plane.

This orientation is valid for the following probe types:

55P51, 55P61  Gold-plated/miniature X-wire probe 

55R51, 55R61 Fiber probe, air/water applications

X-sensor Probes, Cross-flow Types

The probe stem is aligned with z-axis of the probe coordinate system.The sensors are in the
xy-plane. Sensor 1 forms +45° and sensor 2 forms -45° with the x-axis.

This orientation is valid for the following probe types:

55P52, 55P62 Gold-plated/miniature X-wire probe 

55R52, 55R62 Fiber probe, air/water applications

X-sensor Probes, 90° Sensor Plane Parallel to Probe Axis

The probe stem is aligned with y-axis of the probe coordinate system. The sensors are in the
xy-plane. Sensor 1 forms +45° and sensor 2 forms -45° with the x-axis.

This orientation is valid for the following probe types:

55P53, 55P63 Gold-plated/miniature X-wire probe 
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55R53, 55R63 Fiber probe, air/water applications

X-sensor Probes, 90° Sensor Plane Parallel to Probe Axis

The probe stem is aligned with z-axis of the probe coordinate system. The sensors are in the
xy-plane. Sensor 1 forms +45° and sensor 2 forms -45° with the x-axis.

This orientation is valid for the following probe types:

55P54, 55P64 Gold-plated/miniature X-sensor probe 

55R54, 55R64 Fiber probe, air/water applications

7.2.4 Triple-sensor Probes, Probe Coordinates

The probe stem is aligned with the x-axis and sensor 3 is in the xz-plane in the z-direction.

Triple-sensor Probes, Straight Types

The angles between the sensor coordinate system (1,2,3) and probe coordinate system
(x,y,z):

1/x = 54.736° 2/x = 54.736° 3/x = 54.736°

1/y = 135° _2/y = 45° 3/y = 90°

1/z = 65.906° 2/z = 65.906° 3/z = 35.264°

Note that the angles in the Probe Library are defined differently to get right sign:



1/x = 54.736° 2/x = 54.736° 3/x = 54.736°

1/y = 45° _2/y = 135° 3/y = 90°

1/z = 114.094° 2/z = 114.094° 3/z = 35.264°

This difference in definitions, however, is not reflected in the decomposition of the velocity
components.

These angles are valid for:

55P91 Triple wire probe

55P91 Triple fiber probe, air applications

7.3 A/D Devices

7.3.1 Introduction
StreamWare Basic contains drivers for more than 20 A/D devices (from National Instru-
ments® and from United Electronic Industries®). The complete list of supported devices
appears in the Device Library dialog box.

Dantec Dynamics is continuously updating the drivers to keep up with the latest relevant A/D
devices on the market. Since this development normally is much faster that the release fre-
quency of StreamWare Basic, we keep you updated with the latest drivers on http://-
download.dantecdynamics.com/cta_adsupport.shtm .

Note
Access to this site requires a password from Dantec Dynamics, which you can get from:
http://www.dantecdynamics.com/Registration/access/Index.html

To download the latest driver for your A/D device, identify the device by its name and model
in the list and click on the driver name. Please note that one driver can contain support for
multiple A/D device.

Please read the Driver Update Information on the download site for more information about
installing the drivers.
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Since we are not able to support all A/D devices on the market, we turn your attention to our
Programmers Toolkit, which provide you with the ability to program and integrate your own
special A/D device intoStreamWare Basic, if needed.

This section describes in general terms the interfacing between StreamWare Basic and A/D
devices.

7.3.2 General Considerations

Communication with A/D Devices

StreamWare Basic communicates through to an A/D device in the following fashion: A man-
ufacturer (third-party) supplied Dynamic Link Library (DLL) controls all the essential oper-
ations of the A/D device. The calls made by this library are rerouted by a translation driver,
supplied by Dantec Dynamics or other party (with an .adv extension), that converts the
StreamWare Basic software calls to the third-party driver.

The Software signal generator may be used as a dummy input, when you want to test
StreamWare Basic without a real A/D device installed on your PC. If you select this as device,
you will get a sine wave as input, when you run data acquisitions.

Installation of A/D Devices

You are advised to install the device and its driver as recommended by the A/D device man-
ufacturer. Note that the DLL from the A/D driver should be installed in the Windows dir-
ectory. Configuration of the device is done according to the type of measurement. It is
recommended, however, to select Single Ended, Unipolar, if possible.

Note
The installation of the A/D driver should be done before StreamWare Basic is opened.

7.3.3 National Instruments DAQmx Devices
The software supports the National Instruments DAQmx Device Driver standard. In principle
this means that all current and future devices supported by DAQmx is supported by the soft-
ware. The software is however limited to only support devices holding A/D input channels,
and require at least v7.3 of DAQmx driver installed (DAQmx Base is not supported).

Installing a DAQmx Device

When installing a DAQmx device it is recommended to have the latest DAQmx driver installed
(v7.3 or later is required). Please refer to the www.ni.com homepage and the manual for the
specific device for more information, and for the latest version of DAQmx. The software and
device CD will contain a compatible version of the DAQmx driver.

Test Without the Device

The DAQmx device driver standard enables you to run most devices as a “Simulated” (non
physical) device. This means, that you can test a device in the software without have the phys-
ical device. The data will be simulated and most features will be available though the software,
except external hardware clock and triggering.

Test the Device

The recommended order of installation is:

http://www.ni.com/


1. Install DAQmx v7.3 or later (please check supported operating systems)

2. Turn off the PC

3. Install internal bus device or connect the device using USB etc.

4. Turn on the PC and follow the plug-and-play instructions

If something goes wrong during the plug and play installation it is recommended to look in the
Windows Device Manager for information and troubleshooting, and please refer to the
device manual.

When the device is properly installed, it is displayed in the National Instruments Measurement
& Automation Explorer (MAX) under the NI-DAQmx Devices. Please note that other devices
can occur in the NI-DAQmx Devices list, and also in the Traditional DAQ section. A device can
be tested and verified from within MAX using the Test Panels.

Using a DAQmx Device in StreamWare Basic

Since DAQmx is a standard platform all DAQmx devices are run using the same driver. In the
software this driver is named “NI DAQmx Supported Devices”, and should be used for all
DAQmx supported devices. If you during program start up choose to always use DAQmx, this
will be selected as the default option in the Select Analog Device Driver dialog.
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A number of legacy A/D drivers are maintained for backward compatibility including United
Electronics Power DAQ systems and National Instruments Traditional DAQ systems. Please
note that these drivers will not be developed.

DAQmx Device Configuration

The DAQmx Device Configuration let you select between the installed DAQmx devices (pre-
viously found and identified by MAX). By selecting between the different devices the device
capabilities are automatically detected and shown.

The primary capabilities used in the software are the Signal Source, and the Signal Range. The
descriptions of the different modes can be seen directly in the dialog. Normally you would
select between differential or referenced single ended sources. However some devices only
supports differential as source and the wirering must be made accordingly using the correct
connector box. The signal range defines direction of the input signal. You get the best results
if you match the range with the range of you actual signal. Most CTA probes works in the 0 – 5
Volts or 0 – 10 Volts positive range, but some special and user defined probes will require
both positive and negative polarity.



As additional options you can launch MAX from within this dialog along with performing an
internal calibration of the DAQmx device. For legacy SC-2040 T/H owners and option is
included to support this device. However it is recommended to use a native simultaneous
sample and hold DAQmx device compared to the costly and slow external track and hold solu-
tion.

The selected device configuration; device, signal source and range will be used in you current
and future databases and projects when specifying the setup of you measurement. The Ana-
log Device Setup dialog will use the configuration selected and restrict the setup to be within
the selected device capabilities.
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Based on the DAQmx device, sampling mode and number of used analog input channels the
maximum available sampling frequency will be determined. The gain can be selected to match
your input signal, ensuring the best possible resolution of your data.

External Trigger

Dependent on the device capabilities both analog and digital external triggering is available.
The analog trigger can be defined using a trigger analog threshold voltage, and the slope dir-
ection of the signal. For digital triggers the direction of the edge can be defined. Both analog
and digital trigger uses the PFI0 port as trigger source by default (see advanced setting for
specifying an alternative port).

External Clock

If capable the DAQmx device can be set to use an external sample clock, instead of using the
build-in. The sample frequency specified in the dialog must correspond to the maximum
expected external clock frequency. The external clock signal must use the PFI2 port by
default (see advanced setting for specifying an alternative port).



Advanced Settings

The DAQmx driver will by default use the most common settings recommended by National
Instruments. However in some situations it will be necessary to change the default setting for
some parameters to suite the device to a specific CTA application.

The following settings can be changed in the Windows Registry using the ”regedit.exe” tool in
the following location: ”HKEY_CURRENT_USER\Software\Dantec Dynamics\CTA\IniSettings\NI-
DAQmx”

External trigger source port
PFI0 is the default external trigger source port
specified by National Instruments and is used as
label on e.g. timer boxes etc.

TrigPortEx: TrigPort = PFI1
(default = PFI0)

External clock source port
PFI2 is the default external clock source port spe-
cified by National Instruments and is used as label
on e.g. timer boxes etc.

ExtClkPortEx: ExtClkPort = PFI3
(default = PFI2)

Digital output port
The digital output port is used for triggering of
other equipment by setting the signal high during
a CTA measurement. The default port will be the
first available on the device.

DigLineEx: DigLine = port1/line0
(default = first available digital output
port)

Task
If you use MAX to create a NI-DAQmx Task and
name it "CTATask" by default, the software will
find this. It will run the Task instead of a specific
DAQmx device. Please refer to the MAX doc-
umentation on how to create and use NI-DAQmx
Tasks.

DAQmxTaskEx: DAQmxTask = MyTask
(default = CTATask)

7.4 Global Export

7.4.1 Data Extraction from Binary Data Files

Binary Export Format

The structure of the binary export file depends of the selections made during the export. The
total length of the file depends by the number of samples and number of selected positions in
the current group. Also the data conversion format can change the size of the file: it will be
smaller when selecting raw integer formats, and larger when selecting converted float
formats. Finally the file length depends on the number of selected probes. The probe inform-
ation is added to the file in order to allow the user to perform additional calculations on the
data if necessary.

The structure of the file can be illustrated as follows:
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The file and user headers are placed in the beginning of the file, followed by one or more
probe information headers. Before each data block representing one position there is a data
header describing the size and format of the data.

Again, the number of probe information headers and the number of positions will depend on
the selections made during the export.

Because of the flexible structure of the export file the offsets to the different data values will
change. The table below explains how to extract the different data values and the data itself
from the file.

erw ere

ere er

Data Extraction, Table 1



Name Offset Length Description

File Header

Version 0 2 (unsigned short) Version number of the file
header; starting at 1000.

NumProbes 2 1 (unsigned char) Number of probes included in
the export.

NumTravPositions 4 4 (unsigned long) Number of traverse positions.

GroupIndex 8 2 (unsigned short) Group index.

DatabaseName 10 128 (128 x char) Name of the StreamWare data-
base and the project.

ProjectName 138 16 (16 x char)

RawIdDate 154 20 (20 x char) Date, time, and name of the
raw data event.

RawIdTime 174 20 (20 x char)

RawIdName 194 50 (50 x char)

SizeFileHeader 244 2 (unsigned short) Size in bytes of the file header
372, user header 290, probe
information header 550 and
data header 78.

SizeUserHeader 246 2 (unsigned short)

SizeProbeInfoHeader 248 2 (unsigned short)

SizeDataHeader 250 2 (unsigned short)

DeviceDescription 252 40 (40 x char) Name of the A/D device device
used for the data acquisition.

LocalVarNameA 292 10 (10 x char) Name and unit declaration for
the five extra user definable
local variables.

LocalVarNameB 302 10 (10 x char)

LocalVarNameC 312 10 (10 x char)

LocalVarNameD 322 10 (10 x char)

LocalVarNameE 332 10 (10 x char)

LocalVarUnitA 342 6 (6 x char)

LocalVarUnitB 348 6 (6 x char)

LocalVarUnitC 354 6 (6 x char)
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LocalVarUnitD 360 6 (6 x char)

LocalVarUnitE 366 6 (6 x char)

User Information Header

User 372 30 (30 x char) (Optional) Name of the user or
creator; default name
“StreamWare (tm)”.

AccountNumber 402 4 (unsigned long) (Optional) Project id number.

Information 406 256 (256 x char) (Optional) Extra user com-
ments.

Probe Information Header

Version 662* 2 (unsigned short) Version number of the probe
information header; starting at
1000.

ProbeName 664 10 (10 x char) Name of the probe.

ProbeType 674 2 (unsigned short) Type of the probe.
1, 2 and 3 = Wire/Fiber probe,
4 and 5 = Film probe,
7 = Miscellaneous probe, or
8 = Temperature probe.

NumChannels 676 1 (unsigned char) Number of channels used by
the probe.

BridgeConnected#1 677 1 (unsigned char) Flag indicating if the bridges
are connected.
0 = No, or
1 = Yes.

BridgeConnected#2 678 1 (unsigned char)

BridgeConnected#3 679 1 (unsigned char)

Shape 680 1 (unsigned char) Shape of the probe.
0 = Film, or
1 = Wire.

BridgeRatio 681 1 (unsigned char) Bridge ratio.
0 = 1:20 (20 Ohms),
1 = 1:20 (10 Ohms), or
2 = 1:1.

CTAFilter 682 1 (unsigned char) Filter

CTAGain 683 1 (unsigned char) Gain

CableComp 684 1 (unsigned char) Cable compensation



OverHeat#1 686 4 (float) Overheat ratio.

OverHeat#2 690 4 (float)

OverHeat#3 694 4 (float)

ProbeResistance#1 698 4 (float) Probe resistance in Ohms.

ProbeResistance#2 702 4 (float)

ProbeResistance#3 706 4 (float)

CableResistance#1 710 4 (float) Cable + support resistance in
Ohms.

CableResistance#2 714 4 (float)

CableResistance#3 718 4 (float)

SensorColdResistance#1 722 4 (float) Sensor cold resistance in
Ohms.

SensorColdResistance#2 726 4 (float)

SensorColdResistance#3 730 4 (float)

DecadeResistance#1 734 4 (float) Decade resistance in Ohms.

DecadeResistance#2 738 4 (float)

DecadeResistance#3 742 4 (float)

CableLength 746 4 (float) Length of the cable.

RefTempR#1 750 4 (float) Reference temperature in °C
when probe resistance was
measured.

RefTempR#2 754 4 (float)

RefTempR#3 758 4 (float)

BridgeVolt#1 762 4 (float) Bridge top voltage.

BridgeVolt#2 766 4 (float)

BridgeVolt#3 770 4 (float)

RefTempV#1 774 4 (float) Reference temperature in °C
when bridge top voltage was
measured.

RefTempV#2 778 4 (float)

RefTempV#3 782 4 (float)

SensorTempCoeff#1 786 4 (float) Corrected sensor tem-
perature coefficients.
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SensorTempCoeff#2 790 4 (float)

SensorTempCoeff#3 794 4 (float)

ConversionLevel 798 1 (unsigned char) Conversion level description.
0 = Raw voltage (2 bytes
short),
1 = Raw voltage (4 bytes float),
2 = Velocity/temp. from cal-
ibration,
3 = Velocity in wire coordin-
ates,
4 = Velocity in probe coordin-
ates, or
5 = Velocity in laboratory
coordinates.

TempCorrection 800 2 (unsigned short) Flag indication if temperature
correction was used.
0 = No, or
1 = Yes.

Algorithm 802 1 (unsigned char) 0 = Polynomium
1 = Power Law
2 = Lookup Table
3 = Logarithmic-Square
4 = Steinhart-Hart
5 = Logarithmic-Polynomial

Case: Algorithm = 0 Polynomial:
T=C0 + C1*E + C2*E^2 +
C3*E^3 + C4*E^4 + C5*E^5

Order#1 804 2 (short) Order of the polynomial.

MinU#1 806 4 (float) Minimum, maximum, and next
maximum.

MinE#1 810 4 (float)

MaxU#1 814 4 (float)

MaxE#1 818 4 (float)

Max_1U#1 822 4 (float)

Max_1E#1 826 4 (float)

C0#1 830 4 (float)

C1#1 834 4 (float)

C2#1 838 4 (float)



C3#1 842 4 (float)

C4#1 846 4 (float)

C5#1 850 4 (float)

Order#2 854 2 (short)

MinU#2 856 4 (float)

MinE#2 860 4 (float)

MaxU#2 864 4 (float)

MaxE#2 868 4 (float)

Max_1U#2 872 4 (float)

Max_1E#2 876 4 (float)

C0#2 880 4 (float)

C1#2 884 4 (float)

C2#2 888 4 (float)

C3#2 892 4 (float)

C4#2 896 4 (float)

C5#2 900 4 (float)

Order#3 904 2 (short)

MinU#3 906 4 (float)

MinE#3 910 4 (float)

MaxU#3 914 4 (float)

MaxE#3 918 4 (float)

Max_1U#3 922 4 (float)

Max_1E#3 926 4 (float)

C0#3 930 4 (float)

C1#3 934 4 (float)

C2#3 938 4 (float)

C3#3 942 4 (float)

C4#3 946 4 (float)

C5#3 950 4 (float)

Order#4 954 2 (short) Not used.
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MinU#4 956 4 (float)

MinE#4 960 4 (float)

MaxU#4 964 4 (float)

MaxE#4 968 4 (float)

Max_1U#4 972 4 (float)

Max_1E#4 976 4 (float)

C0#4 980 4 (float)

C1#4 984 4 (float)

C2#4 988 4 (float)

C3#4 992 4 (float)

C4#4 996 4 (float)

C5#4 1000 4 (float)

Case: Algorithm = 1 Power law:
T=(E^2 - A)/B)^(1/n)

A#1 804 4 (float)

B#1 808 4 (float)

N#1 812 4 (float)

MinU#1 816 4 (float) Minimum and maximum cal-
ibration points.

MinE#1 820 4 (float)

MaxU#1 824 4 (float)

MaxE#1 828 4 (float)

A#2 832 4 (float)

B#2 836 4 (float)

N#2 840 4 (float)

MinU#2 844 4 (float)

MinE#2 848 4 (float)

MaxU#2 852 4 (float)

MaxE#2 856 4 (float)

A#3 860 4 (float)

B#3 864 4 (float)



N#3 868 4 (float)

MinU#3 872 4 (float)

MinE#3 876 4 (float)

MaxU#3 880 4 (float)

MaxE#3 884 4 (float)

A#4 888 4 (float) Not used

B#4 892 4 (float)

N#4 896 4 (float)

MinU#4 900 4 (float)

MinE#4 904 4 (float)

MaxU#4 908 4 (float)

MaxE#4 912 4 (float)

Case: Algorithm = 2 Lookup table.

Size#1 804 2 (short) Size of lookup table (largest
4096 elements - 12 bit ADC)

MinU#1 806 4 (float) Minimum and maximum cal-
ibration points (entries in
table)

MinE#1 810 4 (float)

MaxU#1 814 4 (float)

MaxE#1 818 4 (float)

Delta#1 822 4 (float) Step between consecutive
entries (equals (MaxE - MinE) /
Size)

Size#2 826 2 (short)

MinU#2 828 4 (float)

MinE#2 832 4 (float)

MaxU#2 836 4 (float)

MaxE#2 840 4 (float)

Delta#2 844 4 (float)

Size#3 848 2 (short)

MinU#3 850 4 (float)

216



217

MinE#3 854 4 (float)

MaxU#3 858 4 (float)

MaxE#3 862 4 (float)

Delta#3 866 4 (float)

Size#4 870 2 (short)

MinU#4 872 4 (float) Not used

MinE#4 876 4 (float)

MaxU#4 880 4 (float)

MaxE#4 884 4 (float)

Delta#4 888 4 (float)

Case: Algorithm = 3 Logarithmic-Square:
T = (exp(sqrt(A + B*E)) - 1)/G

A#1 804 4 (float)

B#1 808 4 (float)

G#1 812 4 (float)

A#2 816 4 (float)

B#2 820 4 (float)

G#2 824 4 (float)

A#3 828 4 (float)

B#3 832 4 (float)

G#3 836 4 (float)

A#4 840 4 (float) Not used

B#4 844 4 (float)

G#4 848 4 (float)

Case: Algorithm = 4 Steinhart-Hart:
T = 1/(Ash + Bsh*log(E) + Csh*-
log^3(E)) - 273.15

Ash#1 804 4 (float)

Bsh#1 808 4 (float)

Csh#1 812 4 (float)

Ash#2 816 4 (float)



Bsh#2 820 4 (float)

Csh#2 824 4 (float)

Ash#3 828 4 (float)

Bsh#3 832 4 (float)

Csh#3 836 4 (float)

Ash#4 840 4 (float) Not used

Bsh#5 844 4 (float)

Csh#5 848 4 (float)

Case: Algorithm = 5 Logarithmic-polynomial:
T = C0 + C1*log(E) + C2*log^2
(E) + C3*log^3(E)

C0#1 804 4 (float)

C1#1 808 4 (float)

C2#1 812 4 (float)

C3#1 816 4 (float)

C0#2 820 4 (float)

C1#2 824 4 (float)

C2#2 828 4 (float)

C3#2 832 4 (float)

C0#3 836 4 (float)

C1#3 840 4 (float)

C2#3 844 4 (float)

C3#3 848 4 (float)

C0#4 852 4 (float) Not used

C1#4 856 4 (float)

C2#4 860 4 (float)

C3#4 864 4 (float)

Probe Information Header (continued)

CalTemp 1004 4 (float)

AngCalAK#1 1008 4 (float) Angular calibration coef-
ficient's. Used for constructing
decomposition matrix. Depend-
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ing on whether the probe is
2D or 3D these coefficients
might denote pitch or yaw
factors.

AngCalAK#2 1012 4 (float)

AngCalAK#3 1016 4 (float)

AngCalBK#1 1020 4 (float)

AngCalBK#2 1024 4 (float)

AngCalBK#3 1028 4 (float)

CoordTransform11 1032 4 (float) Coordinate matrix. Trans-
formation matrix, from wire to
probe coordinates.

CoordTransform12 1036 4 (float)

CoordTransform13 1040 4 (float)

CoordTransform14 1044 4 (float)

CoordTransform21 1048 4 (float)

CoordTransform22 1052 4 (float)

CoordTransform23 1056 4 (float)

CoordTransform24 1060 4 (float)

CoordTransform31 1064 4 (float)

CoordTransform32 1068 4 (float)

CoordTransform33 1072 4 (float)

CoordTransform34 1076 4 (float)

CoordTransform41 1080 4 (float)

CoordTransform42 1084 4 (float)

CoordTransform43 1088 4 (float)

CoordTransform44 1092 4 (float)

ProbeTransformRoll 1096 4 (float)

ProbeTransformPitch 1100 4 (float)

ProbeTransformR11 1104 4 (float) Roll and pitch coefficients.
Applied roll and pitch angles
and matrices formed by them.
For conversion from probe to
laboratory coordinates.



ProbeTransformR12 1108 4 (float)

ProbeTransformR13 1112 4 (float)

ProbeTransformR21 1116 4 (float)

ProbeTransformR22 1120 4 (float)

ProbeTransformR23 1124 4 (float)

ProbeTransformR31 1128 4 (float)

ProbeTransformR32 1132 4 (float)

ProbeTransformR33 1136 4 (float)

ProbeTransformP11 1140 4 (float)

ProbeTransformP12 1144 4 (float)

ProbeTransformP13 1148 4 (float)

ProbeTransformP21 1152 4 (float)

ProbeTransformP22 1156 4 (float)

ProbeTransformP23 1160 4 (float)

ProbeTransformP31 1164 4 (float)

ProbeTransformP32 1168 4 (float)

ProbeTransformP33 1172 4 (float)

SignalCondGain#1 1176 4 (float) Amplification of the input sig-
nal.

SignalCondGain#2 1180 4 (float)

SignalCondGain#3 1184 4 (float)

SignalCondOffset#1 1188 4 (float) Offset of the input signal.

SignalCondOffset#2 1192 4 (float)

SignalCondOffset#3 1196 4 (float)

SignalCondHighPass#1 1200 1 (unsigned char) Bandwidth of high-pass filter.
0 = bypassed,
1 = 10 Hz, or
2 = 100 Hz.

SignalCondHighPass#2 1201 1 (unsigned char)

SignalCondHighPass#3 1202 1 (unsigned char)

SignalCondLowPass#1 1203 1 (unsigned char) Bandwidth of low-pass filter.
0 = 300 Hz,
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1 = 1 kHz,
2 = 3 kHz,
3 = 10 kHz,
4 = 30 kHz,
5 = 100 kHz, or
6 = 300 kHz.

SignalCondLowPass#2 1204 1 (unsigned char)

SignalCondLowPass#3 1205 1 (unsigned char)

ACorDC#1 1206 2 (unsigned short) true (1) = AC, or
false (0) = DC.

ACorDC#2 1208 2 (unsigned short)

ACorDC#3 1210 2 (unsigned short)

Data Header

Version 1212** 2 (unsigned short) Version number of the data
header; starting at 1000.

Date 1214 10 (10 x char) Date when the data was
acquired.

Time 1224 10 (10 x char) Time when the data was
acquired.

SampleFrequency 1234 4 (float) Sample frequency used when
the data was acquired.

NumSamples 1238 4 (unsigned long) Number of data samples for
each column.

NumColumns 1242 2 (unsigned short) Number of data columns cor-
responding to number of act-
ive channels.

PositionIndex 1244 4 (unsigned long) Traverse position index.

BlockIndex 1248 2 (unsigned short) Data block index.

PositionX 1250 4 (float) Traverse position in three
dimensions and angle.

PositionY 1254 4 (float)

PositionZ 1258 4 (float)

PositionA 1262 4 (float)

LocalVarA 1266 4 (float) Values of user variables.

LocalVarB 1270 4 (float)



LocalVarC 1274 4 (float)

LocalVarD 1278 4 (float)

LocalVarE 1282 4 (float)

DataFormat 1286 1 (unsigned char) 0 = integer format (2 bytes
short), or 1 = floating point
format (4 bytes float)

DataType 1287 1 (unsigned char) 0 = application raw data type
(default), or 1 = auxiliary data
type (not yet supported)

DataStatus 1288 1 (unsigned char) 0 = no data errors, or >0 =
error

* Offset for one probe.
** Offset for first data header for one probe .

The offset positions in this table only apply to one probe header and the first data header.
When more that one probe is included in the export the offset values in the probe header can
be described as: 662 bytes + NumProbes*550 bytes. E.g. if two probes are included the start
offset value for the first data block will be 1762 bytes instead of 1212 bytes, see next section.

7.4.2 Accessing the Data
Before accessing the data it is necessary to read the information in the corresponding data
header. From the data header we find the number of samples, the number of columns of
data, and the format in which the data is stored. Data is stored in either short 2 bytes or float
4 bytes format dependent on the conversion level selected.

In the following examples we uses five variables for reading data:

NumProbes Number of probes selected in the export equal
to the number of probe information headers in
the file.

NumTravPositions Number of traverse positions saved in the
export file, this equals the number of data
blocks in the export file.

NumSamples Number of data samples for each position.

NumColumns Number of data columns for each position.

DataFormat The format in which the data is saved.

Using the defined variables the total size of each data block can be determined by the equa-
tion:
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Eq. 1

If DataFormat equals 0 (short integer format): NumSamples*NumColumns*2
bytes,
or if DataFormat equals 1 (floating point format):
NumSamples*NumColumns*4 bytes

For accessing data we must bypass the file and user headers and the probe information
header(s). The number of probes is read in the NumProbes variable in the file header, and
the total size of each probe information header is 550 bytes; therefor the first data header
begins at position:

Eq. 2a

662 bytes + NumProbes*550 bytes

The size of each data header is 77 bytes, therefor the first actual data block can be accessed at
the position:

Eq. 2b

662 bytes + 77 bytes + NumProbes*550 bytes

The number of consecutive data blocks is equal to the variable NumTravPositions. Each data
header must be read and the size of the corresponding data block determined. The next data
immediately follows the data header and the data block.

7.4.3 Examples

Example 1

This example describes how to find the two important variables; the number of probes
NumProbes, and the number of positions NumTravPositions. Both these variables are placed
in the file header in the beginning of the export file. From "Global Export" on page 208 we
find, that the number of probes can be read as an “unsigned char” at the offset position 2
bytes from the beginning of the file, and the number of positions saved in the export file can
be read as a unsigned long at the offset position 4 bytes from the beginning of the file.

Pseudo code:

unsigned char numProbes;
unsigned long numTravPositions;
file.Open(“exportfile.bin”);
file.Seek(2,from_beginning);
file.Read(&numProbes);
file.Seek(4,from_beginning);
file.Read(&numTravPositions);
file.Close();

Example 2

This example describes how to access data in the data blocks. Each data block begins with a
data header describing the data. Using the information about the number of traverse pos-
itions, see example 1, we know the number of data blocks. To read down the data blocks each
data header must be read. Reading the number of samples, number of columns and the data
format for the first data header is described by this pseudo code example:



Pseudo code:

unsigned char numProbes;
file.Open(“exportfile.bin”);
file.Seek(2,from_beginning);
file.Read(&numProbes);
file.Seek(662+numProbes*550,from_beginning);

see next*

see next**

file.Close();

The start position of the first data header by bypassing the file and user headers plus one or
more probe information header, see Eq. 2a. The values in the data header can then be found
as:

Pseudo code*:

unsigned long numSamples;
unsigned short numColumns;
unsigned char dataFormat;
file.Seek(662+numProbes*550+26,from_beginning);
file.Read(&numSamples);
file.Seek(662+numProbes*550+30,from_beginning);
file.Read(&numColumns);
file.Seek(662+numProbes*550+74,from_beginning);
file.Read(&dataFormat);

Now we can determine the size dataSize of the first data block as in Eq. 1. Then we need to
read through all data blocks if numTravPositions is larger than one.

Pseudo code**:

unsigned long numSamples;
unsigned short numColumns;
unsigned char dataFormat;
file.Seek(662+numProbes*550,from_beginning);
for (travPos=1 to numTravPositions)
do

// find dataSize
file.Seek(77,from_lastpos);
// read data
file.Seek(dataSize[travPos],from_lastpos);

end

Remember when data is saved in integer format (raw velocities in integers) no time stamp is
included, which means, that the first column is the first channel from the first probe in con-
trast to all the float formats where the first column always is the time stamps.

Sometimes the access to the data blocks can be simplified by assuming that the number of
data columns, number of data samples, and data format are the same for all data blocks. This
means, that only the first data header needs to be accessed.
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